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CinePlex®

Behavioral Research System

CAUTION
Camera Damage
Never connect or disconnect the camera
while the power is on. The camera can be
permanently damaged.

This Guide is for use in conjunction with 

a CinePlex System integrated with an 

OmniPlex® System

 



NOTE TO CINEPLEX V1 AND V2 USERS
The V3 version of CinePlex software is not compatible with 
hardware, software, or licensing for prior versions. DO NOT 
ATTEMPT TO INSTALL V3 ON SYSTEMS RUNNING 
PRIOR VERSIONS. It will not operate correctly, or possibly, 
not at all.

Caution
Electrostatic Discharge
Some devices can be damaged by improper handling. Use 
appropriate electrostatic discharge (ESD) procedures when handling 
these devices. See http://www.esda.org/ for additional information on 
ESD procedures.

CAUTION
Camera Damage
Never connect or disconnect the camera while the power is on. 
The camera can be permanently damaged.

Caution
USB Security Key Damage

Before installing SafeNet® SentinelTM security key drivers remove 
all Sentinel USB keys from the PC. If a system driver is installed 
with a USB key in the port, the key may become unusable.

http://www.esda.org/
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Publication History
September 2014

This document release provides a substantial update for Version 3 of the Plexon® 
CinePlex® Behavioral Research System, including CinePlex Studio, Editor, 
Tracking Option, Basic Behavior Option and 3D Option. It is based on Version 
3.5 of the CinePlex software and is applicable to configurations in which a 
CinePlex System is integrated with one of the Plexon OmniPlex® Neural Data 
Acquisition Systems (referred to as the CinePlex/OmniPlex System).

The list below highlights some of the recent enhancements to the CinePlex 
System.

Studio, Tracking and Basic Behavior

• The system can read a wider range of MJPEG files in offline mode, including 
[1] files with either mjpg or ffds signatures and [2] files of varying resolutions 
if both the frame width and frame height are multiples of 16. See Section 1.6, 
“CinePlex Studio Features” on page 5.

• The system allows you to connect up to four cameras and record four videos 
simultaneously during an experiment. The image for each camera can be 
calibrated independently (inch/pixel or cm/pixel). See Section 3.1, “Setting 
Up Cameras and the User Interface” on page 26.

• The user-specified path to the Recording folder is now saved in the Settings 
file. See Section 3.4.1, “Recording Procedure” on page 42.

• The Extractor function in CinePlex Editor creates data files in comma-

separated-values (CSV) format, which open directly in Microsoft® Excel® or 
Notepad. See Section 3.9, “Using the Extractor” on page 70.

• The configuration pane previously labeled Areas is now labeled Scenes. See 
Section 5.5, “Defining the Arenas” on page 152 and Section 6.6, “Adding 
Zones (Static and Dynamic)” on page 211.

• The behavioral events conditions Entering Zone and Exiting Zone have been 
replaced with the conditions Present in Zone and Absent from Zone. See 
Section 6.8.1, “Events Based on a Zone” on page 220.

• Speed measurements and events are supported for up to four cameras. See 
Section 6.8.4, “Events Based on Speed” on page 225.
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Editor

• The Editor feature has been updated to include the detection of animal 
freezing behavior. See Section 4.6.1, “Using the Freezing Detector” on 
page 119.

• The Editor graphical user interface (GUI) has been enhanced for ease of use.

Important—Scope of this document

This document covers CinePlex Systems that are integrated and synchronized 
with a Plexon OmniPlex System. This integrated configuration is referred to as 
the CinePlex/OmniPlex System. Other CinePlex System configurations are 
available from Plexon (see Section 1.1, “Scope of this User Guide” on page 2), 
but those configurations are not in the scope of this user guide.

April 2013
This document is a substantial update for Version 3.4 of CinePlex Studio and the 
CinePlex Tracking Option.

Note: The preliminary version of this document is intended for use during the Plexon 
Workshop conducted in Dallas, Texas, in April/May 2013.

February 2010
Document Version 3.0 is a complete rewrite for versions 3.0 of CinePlex Studio 
and CinePlex Editor.

February 2008
Document Version 2.0 is a complete rewrite for software versions 2.0 of CinePlex 
Studio and CinePlex Editor.

March 2007
Document Version 1.4 adds new user interface features, menu items, screenshots, 
and updates for CinePlex Studio text and CinePlex Editor text as well as additions 
and modifications to the appendices.

August 2006
Document Version 1.3 adds new features, menu items, screenshots, and minor 
updates to text.

December 2005
Document Version 1.2 adds new menu items, new snap-to capability, a control for 
continuous channel loading, and other minor changes.

May 2005
Document Version 1.1 adds Recorder functionality.

March 2005
Version 1.0 is the first release of CinePlex.
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2 CinePlex Behavioral Research System 

1 CinePlex System Applications and Features 

1.1 Scope of this User Guide

The scope of this user guide is the Plexon® CinePlex® Behavioral Research 
System (CinePlex System) integrated and synchronized with any Plexon 
OmniPlex® Neural Data Acquisition System (OmniPlex System). This integrated 
configuration is referred to as the CinePlex/OmniPlex System in this user guide.

Summary of Additional CinePlex System Configuration Options

Other CinePlex System configurations are available from Plexon, but these 
configurations are not in the scope of this user guide:

• CinePlex System supplied with the Plexon Multichannel Acquisition 
Processor (MAP) System.

• CinePlex System supplied with a third-party neural data acquisition (NDAQ) 
system.

• CinePlex System supplied in the standalone configuration (without an NDAQ 
system).

Note: The OmniPlex System and the MAP System are both examples of NDAQ 
systems.

The capabilities of the CinePlex System are the same, regardless of the specific 
integrated NDAQ system, but some details of installation, data flow, usage and 
file management vary with different NDAQ models.

1.2 Description and Capabilities of the CinePlex System

The CinePlex System is a video capture (recording), tracking, behavioral, and 
editing system. Using the CinePlex System and one or more cameras, you can 
capture and record video in Microsoft® standard Audio Video Interleaved (AVI) 
format. These files are compatible with Windows® Media Player® and many 
other media players.

In addition to capturing and recording video, you can also

• Track the location (2D or 3D coordinates) of the animal in each video frame

• Synchronize the captured video frames with simultaneously recorded neural 
data files

• Play the synchronized video and neural data recordings

• Add behavioral event markers and signals

• Add time-interval variables

• Export the marked-up data from the CinePlex System for further analyses by 
other programs
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The CinePlex System allows rapid repositioning of cameras to suit the specific 
needs of each experiment. After mounting the cameras, you can enter new 
settings for the repositioned cameras, calibrate the new arenas (if necessary) and 
proceed with the experiment. In many cases, this repositioning process and 
resetting of parameters can be accomplished in a few minutes per camera.

1.3  Experiment Design Requirements

The CinePlex System features and options described in this chapter meet the 
requirements of a wide range of experiment designs. If assistance is needed in 
determining whether the CinePlex System is applicable to a particular 
experimental design, please contact Plexon at +1-214-369-4957 or 
support@plexon.com.

Examples of special experiment design requirements include the following. 
Contact Plexon for available options.

• The experiment requires tracking an animal in the dark. 

• Multiple animals of the same color must be tracked.

• The experiment requires tracking objects that move faster than can be 
resolved at 200 frames per second.

• Tracking multiple spots on an animal is desired, but there is no way to apply 
colors (as with a fish, for example).

• The camera cannot be positioned to record the animal in the region of interest 
(in a tunnel maze, for example).

• The ratio of the size of the trackable arena to the size of the animal is such 
that the animal’s image is too small or too large to be tracked.

mailto:support@plexon.com
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1.4 Overview of CinePlex System Features and Functions

This section describes the video capture, recording and file processing features of 
the CinePlex System core components (CinePlex Studio and CinePlex Editor) 
and options (CinePlex Tracking, CinePlex Basic Behavior and CinePlex 3D). 
This information assists the experimenter in selecting the components and 
options to use for his or her experiments. The figure below provides an overview 
of the CinePlex System functions.

The CinePlex System options can be deployed in any of the combinations listed 
below. The experimenter may select and purchase the combination that meets the 
needs of the experiments to be performed. Note that the Tracking Option is an 
extension built on top of the core functions (Studio and Editor). The Basic 
Behavior Option and 3D Option are extensions built on top of the Tracking 
Option.

• Video recording and editing - 
Studio + Editor

• Video recording, editing and tracking - 
Studio + Editor + Tracking Option

• Video recording, editing, tracking and behavior monitoring - 
Studio + Editor + Tracking Option + Basic Behavior Option

• Video recording, editing and tracking in 3 dimensions - 
Studio + Editor + Tracking Option + 3D Option

• Video recording, editing, tracking in 3 dimensions and behavior monitoring - 
Studio + Editor + Tracking Option + 3D Option + Basic Behavior Option

Studio

         CinePlex

Camera Mode (Online) File Mode (Offline)

Video recording

Tracking Option
(LEDs, color markers 

or whole body)

Video playback/re-record

Tracking Option
(LEDs, color markers

or  whole body) –
retrack or use original data

Basic Behavior Option 
(Automated behavioral events 

analysis)

Data extraction

Offline

Browsing of synchronously
recorded neural and/or 

video files

Manual events
creation

Basic Behavior Option 
(Automated behavioral 

events analysis)

Editor

3D Option
for calibrated files

3D Option –
calibration and tracking

Marking up neural data 
files
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Note: The 3D Option is described in this chapter, but detailed procedures are not 
within the scope of this document. Information about the 3D Option is available 
directly from Plexon.

1.5 CinePlex Licensing Options

The table below shows the CinePlex System licenses and how they can be 
combined. You can view the list of licenses installed on your system by selecting 
About from the Help dropdown list then clicking on the Licensing button.  

It is acceptable to have some CinePlex System options installed but not used in a 
particular experiment. The screen will display all of the optional functions, but 
they will not affect the performance of the other options.

Each CinePlex System license can be configured (optionally) to handle up to four 
cameras.

1.6 CinePlex Studio Features

CinePlex Studio consists of hardware and software that support capturing, digital 
video recording (DVR) and playing back the video. CinePlex Studio software, 
along with the specified hardware and at least one FireWire camera and lens, 
provides the features and functions described in this section.

• General features and functions

— CinePlex Studio is a normal Windows application (Windows 7 and 
Windows XP)

CinePlex Applications 
Required

License(s) 
Required

Label on 
USB Key

Studio and Editor CPX V3 CPX v3

Studio and Editor
+ Tracking Option

CPX V3
CPT V3

CPX-T v3

Studio and Editor
+ Tracking Option
+ Basic Behavior Option

CPX V3
CPT V3
CPB V3

CPX-T-B v3

Studio and Editor
+ Tracking Option
+ 3D Option

CPX V3
CPT V3
3D

CPX-T-3D v3

Studio and Editor
+ Tracking Option
+ 3D Option 
+ Basic Behavior Option

CPX V3
CPT V3
3D
CPB V3

CPX-T-B-3D v3
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— CinePlex Studio runs in online mode on the computer supplied by 
Plexon as part of the CinePlex/OmniPlex System

— CinePlex Studio can run on many standalone Windows computers in 
“File” (offline) mode (i.e., analyzing files originally produced by the 
PC to which cameras are connected)

Note: The standalone computer must have minimum memory, processor 
and instruction set to run CinePlex Studio efficiently. The 
requirements for the computer are summarized in Section 1.13.2, 
“Processing and Analyzing Data” on page 14.

— In combination with the Plexon OmniPlex System, the CinePlex 
System functions can be synchronized with neural data recording

— CinePlex Studio hardware, when supplied as part of a CinePlex/
OmniPlex System, consists of 

– A host PC, which runs the CinePlex Studio software and the 
associated Plexon OmniPlex System software

– One or two monitors to display the CinePlex Studio and OmniPlex 
System user interfaces 

– A keyboard to allow user input such as file names

– A mouse, to control the CinePlex Studio and OmniPlex System 
software

– Associated cables and special CinePlex System hardware items

• Video

— Provides a video capture capability, which can be synchronized with 
neural recordings from the OmniPlex System

— Produces standard video AVI files in MPEG format

— Allows an essentially unlimited AVI file size (Microsoft extension to 
NTFS format eliminates the 4 GB file size limit)

— Timestamps frames with the corresponding OmniPlex System times. 

— Generates video file names that correspond to names given to 
synchronized neural data files

— Allows user-specified prefixes for filenames when recording non-
synchronized files

— Enables you to select image quality and file sizes in recordings by 
changing the nominal bit rate

— Records directly to an internal hard drive
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— Supports digital imaging with up to four AVT Stingray cameras (640 x 
480 and 320 x 240 customer-selectable resolution) at up to 80 frames 
per second on each camera

— Supports digital imaging with one or two AVT Pike cameras (640 x 480 
and 320 x 240 customer-selectable resolution) at up to 200 frames per 
second on each camera

— Supports digital imaging with one AVT Pike high-resolution camera 
(960 x 960, 640 x 640 and 320 x 320 customer-selectable resolution) at 
up to 60 frames per second

— Supports near IR (infrared) recording and tracking (optionally 
available)

• Offline computation and/or extraction of selected static and dynamic data 
from CinePlex System video files

— Reads MPEG files created by CinePlex System Version 3

— Reads MJPEG files created by CinePlex System Version 1 or 2

— Reads certain MJPEG files that were originally created by tools not 
supplied by Plexon, for example, files with either “mjpg” or “ffds” 
signatures

— Reads MJPEG files of varying resolution if both the frame width and 
frame height are multiples of 16

— Allows re-recording of MJPEG files in the more efficient MPEG 
format resulting in file size reductions of up to 90%

— Allows selection of a time range or all of the file to be extracted

— Generates output files with user-selected content and format (for 
example, tab or comma delimited format or text)

1.7 CinePlex Editor Features

CinePlex Editor provides a software tool set with which you can view and edit 
video and neural data files together. You can view time-correlated video, neural, 
and positional data, add and edit annotations, and perform other operations on the 
data, such as artifact removal. CinePlex Editor records user actions to its own 
separate CinePlex project file, so you can continue annotation and editing work 
over several sessions. When the markup process is completed, you can save the 
results and export the data for further analysis. 

CinePlex Editor includes the features and functions described below.

• Viewing of Plexon MPEG or MJPEG files

— Provides digital video playback capabilities

— Allows integrated viewing of neural data files (Plexon PLX files, NEX 
files) and AVI files
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— Visualizes tracking position data (if any) overlaid on video

— Seeks and searches files based on neural data and manual event 
markers

• Editing

— Allows you to insert video-aided event markers and intervals

— Allows you to remove temporal segments of neural data during artifact-
generating behaviors (chewing, grooming, etc.)

— Allows you to enter position coordinate data

— Allows you to edit position coordinate data created by CinePlex Editor 
or Studio

— Provides the ability to play a sound (standard or user-selected) when 
event markers or neural spikes occur during playback

— Supports the Microsoft extension to NTFS file format to be able to 
utilize AVI files larger than 4GB

— Provides the ability to save neural data to Plexon PLX files and 

NeuroExplorer® NEX files, or export to text or comma-separated-
values (CSV) file. Text and CSV files can be opened in applications 

such as Excel® or MATLAB® for additional analysis.

1.8 CinePlex Tracking Option Features

CinePlex Tracking Option extends the capabilities of CinePlex Studio. It provides 
arena definition and automated tracking of an animal’s movement and position 
over time. This option supports both real-time and offline tracking capability. 

• Provides the option of calibrating the video and tracking data in inches or 
centimeters

• Features Smart Tracking that uses robust algorithms for LED tracking, object 
contour tracking, and reflective color tracking

• Allows tracking of up to 12 markers of different colors from up to four video 
streams

• Uses strobed word format to deliver tracking coordinates directly to the data 
buffer used by the OmniPlex System

• Analyzes each frame of video data to determine the positions of the objects 
being tracked, and timestamps and saves the data to files on the host PC. One 
or both of the following file types can be chosen:

— Video format (AVI)

— Digital video tracking (DVT) text format
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• Analyzes contour motion across adjacent video frames, and generates data 
that experimenters can use to detect “freezing” in an animal’s movements, as 
might be used in fear-conditioning experiments.

1.9 CinePlex Basic Behavior Option Features

CinePlex Basic Behavior Option extends the capabilities of the Tracking Option 
and includes the following features for behavioral analysis and digital events 
marking:

• Allows user to define static and dynamic zones of interest within an 
experimental arena

• Allows you to define zone sequences

• Monitors objects traversing zones and sequences to generate logical and 
digital events

• Allows user to define behavioral events from one or multiple cameras to 
generate logical and digital events

• Provides real-time and offline information about behavioral events and 
tracked objects, including such attributes as speed, direction (vector), limb 
angles, presence in particular zones in the arena, proximity to other objects, 
sequence of zones visited, and many similar metrics.

• Monitors vectors between objects to create behavioral events when within/
outside of a customer-defined angle and tolerance

• Monitors animal head direction based on markers or LEDs on a headstage.

• Monitors animal speeds to create digital events when over/under a user-
specified threshold

• Accumulates and displays behavioral event statistics

• Allows you to specify up to 24 digital outputs to be generated when specific 
behavioral events occur in the arena

Note: Digital outputs are available for external devices when the digital output (DO) 
unit (included with the Basic Behavior Option) is attached to a USB port on the 
CinePlex System PC. The digital outputs can be pulsed, high, or low when the 
event occurs (that is, when the event becomes TRUE).

1.10 CinePlex 3D Option Features

CinePlex 3D Option extends the capabilities of the Tracking Option and includes 
the following features for three-dimensional tracking and analysis:

• Allows tracking of up to 12 markers of different colors from up to four video 
streams in three dimensions

• Allows tracking of LEDs in three dimensions
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• Permits three-dimensional reconstructions both online and from files

• Includes an embedded calibration function that does not require complex 
measuring between cameras and points in the experimental area

• Allows cameras to be moved and then recalibrated in a few minutes

Note: The 3D Option is described in this chapter, but detailed procedures are not 
within the scope of this document. Information about the 3D Option is available 
directly from Plexon.

1.11 CinePlex Combined Basic Behavior Option and 3D Option

The CinePlex Basic Behavior Option and CinePlex 3D Option can both be 
installed and operating simultaneously along with the required CinePlex Tracking 
Option.
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1.12 System Architecture and Components

This section describes the architecture and components of the CinePlex/
OmniPlex System.

1.12.1 CinePlex System in Synchronous Operation with OmniPlex System

The following illustration shows the basic system architecture. The OmniPlex 
System provides a 1 MHz clock signal that enables CinePlex Studio to timestamp 
each video frame with a synchronized time.

CinePlex Studio resides on the host PC. CinePlex Studio receives the raw video 
from the camera, compresses it, and stores it as an AVI file on an internal hard 
drive of the host PC. 

A timing cable connects the OmniPlex System timing interface with the CinePlex 
System digital input/output (DIO) interface. Through this cable, the OmniPlex 
System signals the CinePlex Studio computer to start, stop, pause, and resume 
recording video to AVI files.

The digital output (DO) unit, included with the Basic Behavior Option, connects 
to a USB port on the host PC and permits the Basic Behavior Option (if installed) 
to transmit digital outputs to external devices.

The optional analog/digital (A/D) card receives field potential inputs. 
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1.12.2 Hardware and Software Components

The following illustration shows the major hardware and software components of 
the CinePlex/OmniPlex System.

The components function as follows:

• OmniPlex System controls CinePlex Studio.

• CinePlex Studio controls the camera(s) and receives video from the 
camera(s). 

• CinePlex Studio writes AVI files (and, optionally, DVT or DV3 files) to file 
storage and sends coordinate data to the circular buffer where the data is read 
by PlexControl (the OmniPlex System control application). The CinePlex 
System can also send coordinate data directly to the OmniPlex System via a 
software interface (controlled by an option in the Studio user interface).

• The circular buffer receives coordinate data from Studio and neural data from 
the OmniPlex System server. 

• PlexControl writes PL2 (default) or PLX files, which contain both neural data 
and coordinate data, to file storage.

• CinePlex Editor reads/writes PLX and AVI files from/to file storage. 

• NeuroExplorer reads PL2 or PLX files from file storage and writes NEX files. 
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Note: Coordinate data is generated and transmitted only if the Tracking Option is 
installed on the CinePlex System.

Note: Digital outputs (referred to in the above drawing) are associated with behavioral 
events, and are generated only if the Basic Behavior Option is installed.

1.13 Data Flow, File Processing and Analysis

This section describes the flow of data in the system, and discusses methods that 
can be used for file processing and data analysis.

1.13.1 System Data Flow

The following illustration shows the data flow in a CinePlex/OmniPlex System.

The data flow proceeds as follows:

• If you have selected the AVI checkbox in the digital video recording (DVR) 
area of the Camera 1 Sources pane, CinePlex Studio writes AVI files directly 
to file storage. These AVI files have static headers, time-stamped video 
frames, and dynamic coordinate and event data. 

Note: Coordinate and event data are generated and transmitted only if the Tracking 
Option and Basic Behavior Option, respectively, are installed on the CinePlex 
System.

• If you have selected the digital video tracking (DVT) checkbox in the DVR 
area of the Camera 1 Sources pane, CinePlex Studio writes DVT files 
containing dynamic coordinate data directly to file storage. If the CinePlex 
3D Option is installed and active, DV3 coordinate data files are also written 
to file storage.

• CinePlex Studio sends selected event data and coordinate data to the circular 
buffer which, in turn, sends the data to PlexControl. PlexControl writes PL2 
(default) or PLX files containing neural and CinePlex data to file storage.
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1.13.2 Processing and Analyzing Data

After a recording session, you may perform data analysis on the host PC or 
transfer the files to a different computer (on which CinePlex Studio and/or 
CinePlexEditor are installed) for analysis.

Note: The standalone computer must have minimum memory, processor and 
instruction set to run CinePlex Studio efficiently. These requirements for offline 
operation are CinePlex System Version 3 software and a license key that 
enables the desired capability. However, it is important to determine that the 
computer on which the installation will be done meets the minimum system 
requirements. In general, this means a computer has a dual core Intel 

processor operating at better than 3 GHz with 3 GB of memory, and a NVIDIA® 

GeForce® 9600 GT or better video card. Requirements that are more current 
are available from Plexon support (support@plexon.com).

With all files and software accessible on a single computer, you can process and 
analyze the data as follows:

• Use CinePlex Studio in “Files” (offline) mode to rerecord and retrack the 
original video data.

If the CinePlex Tracking Option, Basic Behavior Option and/or 3D Option 
are also installed, additional data manipulation can be performed, depending 
on the Option(s) installed. Examples of data manipulation include new or 
changed positional coordinate options, new or changed arenas, zones, and 
logical events.

• Use CinePlex Editor for simultaneously viewing, annotating, and processing 
the video, neural data, and position data. 

CinePlex Editor enables you to add and edit annotations and perform other 
operations on the data, such as artifact removal. When you complete the 
markup process, the results can be saved back into PLX files, or exported into 
text or CSV files. Text and CSV files can be opened in applications such as 
Excel or MATLAB for additional analysis.

• You can spike sort the data with Offline Sorter™, or analyze it with 
NeuroExplorer for place cell analysis, and save the results of this processing 
to another PLX file or to a NEX file. For more information on Offline Sorter 
and NeuroExplorer, go to www.plexon.com.

http://www.plexon.com
mailto:support@plexon.com
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2.1 Installing the CinePlex System

If the CinePlex® System hardware has not yet been cabled, perform the necessary 
procedures. See Appendix A‚ Cabling Guide.

In most cases, the CinePlex System software has already been installed by 
Plexon®.

If assistance is needed, contact Plexon support at +1-214-369-4957 or 
support@plexon.com.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.

mailto:support@plexon.com
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2.2  Startup and Operational Testing

The starting sequence for a synchronized CinePlex/OmniPlex® System is 
important for correct operation of CinePlex. If the correct sequence is not 
followed, video might not be visible or it might not be possible to control and 
synchronize the CinePlex System with OmniPlex System.

Follow these steps to start the system and perform an operational test.

1 Power up the computer (Host PC) and log in.

2 Plug in the SafeNet® SentinelTM license (USB key drive) into any USB port on 
the computer. 

Note: Both the OmniPlex and CinePlex licenses must be present.

3 Turn on power to the OmniPlex System chassis.

4 Start the OmniPlex Server program and verify that there are no errors. The 
easiest way is to double-click the OmniPlex Server desktop icon.

If there are no problems, the OmniPlex Server main window appears.

Startup
The startup sequence is extremely important. OmniPlex must be 
started before Studio is started so that the client registration process 
works properly. Otherwise, when a recording is eventually started by 
OmniPlex, neither the file name string nor the recording time 0 mes-
sages are received.

If the OmniPlex System exits or is closed for any reason, it should be 
brought back up, then Studio should be closed and restarted, as well.
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5 Start the PlexControl program and verify that there are no errors. The easiest 
way is to double-click the PlexControl desktop icon.

The PlexControl window displays.
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6 Press the Start Data button on PlexControl toolbar. (This starts the OmniPlex 
System 1 MHz clock.)

7 Wait to ensure that the system is attempting to collect neural data. (Typically, 
at this stage, there is no neural data input, but the system Messages pane 
should report that it is collecting data - “Data Starting.”) If the Message pane 
does not have the “Data Starting” message, refer to the OmniPlex System 
instructions.

8 Start CinePlex Studio program. The easiest way is to double-click the 
CinePlex Studio desktop icon.

9 View the monitor to see if the CinePlex Studio main window displays. If 
Camera 1 is active, the video should be displayed in the Video 1 window. (It is 
acceptable if multiple cameras are active. For example, in the image below, 
Camera 1 and Camera 2 are both active.)
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10 If the CinePlex Studio main window displays with video, as shown in the 
example in Step 9 (and Camera 1 is active), skip to Step 12. Otherwise, 
perform Step 11.

11 If the error window is displayed as shown below, it means that one of the 
following problems has occurred:

• The Timing cable is not connected correctly from the OmniPlex System to 
the Host PC.

• The Start Data button has not been pressed. 

• The Trigger or FireWire cables are not connected between the host PC 
and the camera.
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• The camera is in an error state.

Take the necessary action: 

• Connect the Timing cable.

• If the Start Data button has not been pressed, press it now. 

• If the Trigger or FireWire cables are not connected, shut down the com-
puter and connect those cables now. Then restart the computer.

• If the camera is in an error state, cycle the power: Use the Windows® 
function to restart the host PC. Then perform Step 4 through Step 10 
again.

12 Select Cameras mode (from the dropdown menu shown below), if not already 
selected. Video should now be displayed on the Video 1 window.

13 If proper video is observed at the monitor, it is reasonable to assume the 
camera, computer, and monitor are working correctly.

14 If there is no video, perform the following steps:

• If the Camera 1 icon background (to the right of the Cameras dropdown) 
is not orange, it is not selected. Click on this icon now to select it. Ensure 
that the background changes to orange.

• Check the cabling, connections, AC power, on/off switches, lighting, and 
the iris, zoom, and focus of the camera.

The cables might not be connected properly, one or more cables might be 
broken internally, a pin or pins on a cable could be bent or broken, the iris 
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on the camera could be shut, the zoom on the camera could be set 
improperly, or the focus could be set so that everything is a blur.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.

TIP
Video Test Mode
Video Test Mode enables the experimenter to verify operation of the 
video portion of the experimental setup without having to activate 
and connect the OmniPlex System. The license keys normally 
required must be present on the computer. For the detailed procedure, 
see Video Test Mode on page 2-23.
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2.3 Video Test Mode

Video test mode is provided to enable the experimenter to verify operation of the 
video portion of their experimental setup without having to activate and connect 
the OmniPlex System, prepare animals for recording, connect preamplifiers, etc. 
The license keys normally required must be present on the computer.

When CinePlex Studio starts, it checks for the presence of the Access IO board. 
If the AccessIO board is present, Studio checks for the clock signal from the 
OmniPlex System.

If the AccessIO board is not present or if there is no clock signal from the 
OmniPlex System, the following message displays if one or more cameras are 
detected. Otherwise Studio opens in File mode without showing the message. 

Note: The dialog box text refers to the OmniPlex System as the Plexon Neural Data 
Acquisition (NDAQ) system.

After the OK button is pressed, the following window is displayed:
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Click Yes to enter Test mode or No to enter File mode.

Test mode has several restrictions compared to the normal mode:

• The CinePlex System switches cameras to free-running mode (using their 
internal trigger), since there is no external trigger available.

• The Arm button (the red circular button with the letter “A” in the main 
toolbar) is disabled, since it is impossible to sync with the OmniPlex System.

• Recording can be done only by pressing the Record button on the toolbar.

• The duration of each recording is restricted to 1 min.
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3.1 Setting Up Cameras and the User Interface

3.1.1 Positioning the Cameras and Verifying Video Quality

1 Ensure that Cameras is selected in the video source dropdown list on the 
main toolbar. Camera setting options do not display in the main window 
unless Cameras is set in the main toolbar. If only two cameras are installed, 
the toolbar would display two camera icons, as shown in the image below.

If it is not possible to select Cameras, Studio has not detected any attached 
cameras. See Appendix F‚ Troubleshooting for troubleshooting this problem.

Note: If there are two or more cameras, the system will automatically assign 
the camera with the lowest serial number to be Camera 1. If there is 
only one camera, it is Camera 1.

2 Select the icon(s) for the camera(s) to be used in the experiment (up to four 
cameras). A camera is active only if the corresponding icon is selected. The 
orange color in the icon indicates a camera is selected. 

In the image in Step 1 above, the orange color on the Camera 1 icon shows 
that Camera 1 is active, and it can also be seen that Camera 2 is inactive. 
Clicking on the Camera 2 icon will make it active also, as shown in the image 
below.

3 Read Appendix B‚ Optimizing Camera and Lens Usage for the Experiment, to 
understand the detailed requirements for camera mounting, cabling and 

TIP
Consider calibration requirements
Plan the mounting of cameras with calibration in mind. Calibration of 
linear dimensions (in inches or centimeters) only works accurately when 
the camera is orthogonal to the arena.

Each of the arenas (that is, the arenas for Cameras 1, 2, 3 and/or 4) can be 
calibrated independently.

The calibration procedure is explained in Section 3.3, “Calibrating the 
Arena Dimensions” on page 30.
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removal. This information is essential for positioning the camera(s) and 

obtaining the best results from the CinePlex® System.

4 Set up one of the cameras as described in Appendix B. It is typical to set up 
Camera 1 first and mount it orthogonally to the arena.

5 Obtain an initial video image from the camera using the default CinePlex 
Studio settings and changing only the physical adjustments (iris, focus and 
zoom) on the camera lens.

Note: The settings that are available on a particular lens depend on the lens 
make and model. Not all settings are available on all models.

6 If any attached camera experiences either of the following problems, take the 
action recommended here:

a If there is no Source window pane corresponding to the camera, go to the 
Window/Layout pulldown menu and select Reset to Default Layout.

a If there is a Source window pane corresponding to the camera, but no 
video is displayed there, select the camera icon in the toolbar to make the 
camera active. (For example, see the camera icons in the image below. In 
that image, the icon for Camera 2 has not been selected, and therefore 
Camera 2 is not yet active.)

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.

TIP
Ensure that cameras are set up for optimum imaging
In general, it is best to position the camera as far from the experiment 
as possible, then zoom as much as possible in order to fill the field of 
view with the area of interest without distortion. Appendix B, 
explains how to compute the distance from the camera to the arena so 
that the whole arena is visible.
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1 If the previous steps do not result in a good image on the camera, manually 
change camera settings in CinePlex Studio. The available settings depend on 
the camera model Typically, the settings should be adjusted in this order: 
Contrast, Brightness, Sharpness, and Saturation.

2 If the above steps do not cause the video to appear, refer to Appendix F-
Troubleshooting.

3 Repeat Step 4 through Step 2 for each additional camera that will be used in 
the experiment.)

4 Calibrate the dimensions in the video field. (Calibration is accurate only when 
the camera is positioned orthogonally to the arena.)

Note: In many experiments, it is useful to calibrate the video image 
dimensions so that the ratio of centimeters to pixels (or inches to 
pixels) is known. The calibration ratio can be useful even if the 
Tracking Option is not currently installed, because the tracking data 
can be processed with the calibration data at a later time (if the 
Tracking Option is purchased). For the procedure, see Section 3.3, 
“Calibrating the Arena Dimensions” on page 30.

3.1.2 Arranging CinePlex Studio Windows

The default window layout will be sufficient for many experiments. However, to 
change the window layout, see Appendix E‚ Navigating the Plexon User 
Interface. 

To load or save a layout configuration, see "Window Menu"  in Appendix E.

TIP
Make the Video Image Larger
If the default video image is not large enough to make your desired 
adjustments, drag the video window out of its frame to another area 
on the monitor. Then adjust the window size in the normal way.

TIP
Video Test Mode
Video Test Mode enables the experimenter to verify operation of the 
video portion of the experimental setup without having to activate 

and connect the OmniPlex® System. The license keys normally 
required must be present on the computer. For the detailed procedure, 
see Video Test Mode on page 23.
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3.2 Navigating the Studio Main Window

This section describes the CinePlex Studio main window, where you can view 
and modify Studio settings before starting the recording session.

This drawing shows the location of the panes in the CinePlex Studio main 
window. In this example, there are two cameras connected; up to four cameras 
can be licensed (optional).

TIP
Verify “Cameras” Is Selected
Camera settings do not display in the main window unless 
Cameras is set in the main toolbar.
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3.2.1 Main Toolbar Icons

The image below shows a close-up view of the CinePlex Studio main toolbar. In 
this example, there are four cameras connected and three of them are active.

3.2.2 Global Configuration Pane Settings

This pane (see the image above) is the first an experimenter will normally use 
when setting up CinePlex Studio, but perhaps not very often after that. It contains 
settings that pertain to the frame rate to use when recording, image resolution 
(quality of recordings to make), compression bit rate, and local file recording 
folder. For information about video formats and the video Quality setting, see 
Section 3.10.2, “MPEG-4 Quality and File Size” on page 79.

3.2.3 Source Pane Settings

This pane is the second an experimenter will normally use when setting up 
CinePlex Studio. There can be multiple Source panes if there are multiple 
cameras on the system. This pane contains parameters that relate to optical 
settings for each camera (contrast, brightness, sharpness, saturation, etc.), file 
output format (AVI or DVT), labeling/timestamping of frames and calibration. 
(For the calibration procedure, see Calibrating the Arena Dimensions, below.)

3.3 Calibrating the Arena Dimensions

In many experiments, it is useful to calibrate the video images from one or more 
cameras so that the ratio of centimeters to pixels (or inches to pixels) is known. 
The calibration ratio can be useful even if the Tracking Option is not currently 
installed, because the tracking data (such as the animal’s speed) can be processed 
with the calibration data at a later time (if the Tracking Option is purchased). This 
section describes how to perform the calibration procedure on an active camera. 
The calibration procedure can be repeated for any or all active cameras.
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Note:  Calibration only works accurately when the camera is orthogonal to the arena.

CinePlex Studio provides two methods of calibration - single axis (also called 
One-Bar) and dual axis (also called Two-Bar).

Calibration is the final section of the Source (Video) pane. 

Setting Up the Camera

The camera should be set up according to the instructions in Section 3.1, “Setting 
Up Cameras and the User Interface” on page 26.

Selecting Calibration Units and Type

1 Open up the Calibration section (if it is not already open) by clicking on the 
“+” sign.

2 Check the box labeled Use Calibration. Note that the title of the section 
changes from Calibration to Calibrated. This is because the current 
calibration Global Factor is now being applied.

3 Select the unit of measure (Units) - either cm for centimeters or in. for inches.

4 Select the method of calibration (Type) - either One-Bar or Two-Bar.
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Setting Calibration Parameters with One-Bar

5 When One-Bar has been selected:

a Click the “+” sign next to Global Factor and then the “+” next to 
Reference Size to expand their subsections, if needed. If they are 
already shown as “-” signs, this is not needed.

b If the current color in the box next to the Color item will not provide good 
contrast with the video image, click in the box and select a suitable color. 
The color selected is the color of the measurement bar used for 
calibration.

c Choose a feature in the experimental area whose video image extends 
over much of the field of view. As an illustration, the inside diameter of the 
clock frame in the image below will be used as the desired dimension.
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d Measure its longest dimension in the units desired, and record it for 
reference. The inside diameter of the clock frame measured 30.5 cm.

e Click the Adjust button. The cursor will go to the video image and a line 
will appear in the color selected. Select one end of the colored line and 
move it to one end of the feature just measured. Select the other end of 
the line and move it to the other end of the feature.
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In the image above note the green line through the middle of the clock with 
the box on each end. This is the sizing bar.

In the above image note that the left end of the sizing bar has been moved to 
the inside edge of the clock’s frame. Select the other end of the sizing bar and 
move it to the opposite inside edge of the clock frame and ensure the sizing 
bar crosses the intersection of the clock hands.
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In the above image note that the sizing bar now measures the inside diameter 
of the clock’s frame.

f Right-click to record the length of the bar in pixels.

g Go to the slider next to the Actual item and move it so that it reads the 
dimension recorded above. Studio is now calibrated to the measured 
distance. The arrow keys may be used for fine adjustments to the slider 
positions.

In the image above note that the Actual setting has been changed to the 
measured inner diameter of the clock’s frame (30.5 cm).

h Click all three “-” signs once the adjustment is satisfactory to hide the 
adjustments.

i After the parameters are set as desired, on the File menu, click Save 

Settings, or click the Save Settings button ( ) on the toolbar.

Setting Calibration Parameters with Two-Bar

6 When Two-Bar has been selected:

a Click the “+” sign next to Horizontal Factor and then the “+” next to 
Reference Size to expand their subsections, if needed. If they are 
already shown as “-” signs, this is not needed.
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b If the current color in the box next to the Color item will not provide good 
contrast with the video image, click in the box and select a suitable color.

c Choose a horizontal feature (horizontal relative to the video image) in the 
experimental area whose video image extends over much of the field of 
view. Once again the inner diameter of the clock’s frame will be used.
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d Measure the feature’s horizontal dimension in the units desired, and 
record it for reference. The inner diameter is 30.5 cm.

e Click the Adjust button in the Horizontal section. The cursor will go to the 
video image and a horizontal line will appear in the color selected.

In the image above note the green line through the middle of the clock with 
the box on each end. This is the sizing bar.

f Select the horizontal sizing bar and move it vertically so that it rests on the 
desired feature in the frame (in this example, it will be moved to the 
intersection of the clock hands at the center of the clock). Select one end 
of the sizing bar and move it over the desired feature in the image. 
Repeat this process for the other end of the sizing bar. In this example, 
the ends of the sizing bar will be placed at the inside edges of the clock 
frame.
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In the above image note that the sizing bar now measures the inside diameter 
of the clock’s frame.

g Right-click to record the length of the bar in pixels.

h Go to the slider next to the Horizontal Actual item and move it so that it 
reads the dimension recorded above.

i Click the “+” sign next to the Vertical Factor and then the “+” next to 
Reference Size to expand their subsections, if needed. If they are 
already shown as “-” signs, this is not needed.
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j If the current color in the box next to the Color item will not provide good 
contrast with the video image, click in the box and select a suitable color.

k Choose a vertical feature (vertical relative to the video image) in the 
experimental area whose video image extends over much of the field of 
view. Once again the inner diameter of the clock’s frame will be 
measured.
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l Measure the feature’s vertical dimension in the units desired, and record it 
for reference. The inner diameter of the clock’s frame is 30.5 cm.

m Click the Adjust button in the Vertical section. The cursor will go to the 
video image and a line will appear in the color selected.

In the image above note the vertical green line with a box at each end. This 
line is the sizing bar.

n Select the vertical sizing bar and move it horizontally so that it rests on the 
desired feature in the frame (in this example, it will be moved to the 
intersection of the clock hands at the center of the clock). Select one end 
of the sizing bar and move it over the desired feature in the image. 
Repeat this process for the other end of the sizing bar. In this example, 
the ends of the sizing bar will be placed at the inside edges of the clock 
frame.
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In the image above the bottom of the sizing bar has been set within the clock 
frame.

o Right-click to record the length of the bar in pixels.

p Go to the slider next to the Vertical Actual item and move it so that it 
reads the dimension recorded above (30.5 cm).

Now Studio has been calibrated in both horizontal and vertical directions.

q Click all five “-” signs once the adjustments are satisfactory to hide the 
adjustments.

r After the parameters are set as desired, on the File menu, click Save 

Settings, or click the Save Settings button ( ) on the toolbar.
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3.4 Recording Synchronized Video Tracking and Neural Data

This section explains how to record video and tracking data that is synchronized 
with neural data from the OmniPlex System. This procedure requires starting and 
stopping the CinePlex Studio video recording process remotely from the 
OmniPlex System. This method of triggering the recording ensures that:

• The timestamps in the CinePlex and OmniPlex files are derived from the 
same clock

• The CinePlex and OmniPlex file start times and stop times are synchronized

• The CinePlex frame numbers and timestamps are synchronized

Simultaneous starting, stopping, pausing, and resuming of the neural data and 
video files is essential in helping the researcher correlate the behaviors captured 
in the video with the observed neural activity.

Although you can manually start, stop, pause, and resume recording an AVI file 
at any time in CinePlex Studio by simply clicking the appropriate toolbar buttons, 
this method will not record synchronized files, because it produces video files 
that do not have the same start time as the corresponding neural data files.

Note: If the animal is being trained prior to the collection of neural data, the CinePlex 
System can record AVI and/or DVT files without the existence of neural data 
files. In that case, OmniPlex is used only as a clock source for the CinePlex 
System. The procedure for that case is provided in Section 3.6, “Recording 
Video without Neural Data (Used for Animal Training)” on page 3-52.

3.4.1 Recording Procedure

Perform these steps to record synchronized video and neural data. 

The steps must be followed in the sequence listed here. If they are not performed 
in order, it will not be possible to create a synchronized recording of video and 
neural data.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.

CAUTION
Lighting Conditions
If lighting conditions change enough during recording that ‘objects 
too large’ or some other condition occurs, the position data may be 
meaningless.
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1 Ensure that the system is connected as described in Chapter 2, Installing, 
Starting and Testing CinePlex Studio.

2 At the OmniPlex System chassis, turn the power on and start the OmniPlex 
Server and PlexControl.

3 If not already done, configure the OmniPlex System.

4 Click the Start Data button in the PlexControl toolbar so that neural data 
acquisition begins, and the neural data appears in PlexControl display.

5 Double-click the CinePlex Studio icon. Wait for the CinePlex Studio 
application main window to appear on the monitor.

Note: If Studio does not detect the OmniPlex clock, an error message will 
appear. If it does, see Appendix F-Troubleshooting.

6 Verify that Cameras is selected in the Studio dropdown list and that a camera 
image is displayed for each of the camera(s) that will be used in the 
experiment. The image is displayed for each camera icon that is selected. 
The image below shows that both Camera 1 and Camera 2 are selected 
(indicated by the orange color of the icons).

7 If there is an appropriate file containing all the desired CinePlex settings, load 

the file onto the CinePlex System using the Load Settings icon ( ) on the 
main toolbar or the File/Load Settings menu selection.

8 Click on the Global Config tab in the static configuration pane to display the 
Global Config pane. 

Note: This pane is the first an experimenter will normally use when setting 
up CinePlex Studio, but perhaps not very often after that. It contains 
settings that pertain to the frame rate to use when recording, image 
resolution (quality of recordings to make), compression bit rate and 
local file recording folder. For information about video formats 
and the video Quality setting, see Section 3.10.2, “MPEG-4 
Quality and File Size” on page 79.
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9 View the settings in the Global Config pane and modify any that need to be 
changed prior to starting the next recording session.

10 To browse for the desired file location (where the recorded files will be saved), 
click on the browse icon, which is the rectangle with three dots on the Rec 
Folder row of the Global Config pane.

11 When the Browse For Folder dialog box appears, use standard Windows® 
methods to select or create the appropriate folder. The factory default location 
for the Recording folder is C:\PlexonData or D:\PlexonData (if disk D is 
available).

12 When finished choosing or creating a storage folder, click OK.

Note: The location of the Recording folder is included in the Settings file (if 
you save a Settings file), and is restored when the Settings file is 
loaded. To save settings, click Save Settings on the File menu, or 

click the Save Settings button ( ) on the toolbar.

Note: If the Recording drive is not NTFS compatible, a warning message 
displays.

13 To view the CinePlex Studio time display, see the Source pane under the 
Video window. The image below shows the Source 1 pane, which appears 
under the Video 1 window for Camera 1. Similar panes appear for each of the 
cameras you have activated in the previous steps. (Calibration is explained in 
a later step in this procedure.)



CinePlex Behavioral Research System 

Version 3 45

14 In the Camera area of the Source pane (labeled with the camera model 
name), adjust the controls to obtain an acceptable image on the screen. The 
specific controls vary depending on the camera model. Typical adjustments 
include Gain, Auto White Balance, Brightness, Sharpness and 
Saturation.

Note: You can also use other image quality settings. To evaluate image 
quality settings, manually collect a set of AVI files at different settings 
and use the file mode to determine a minimum acceptable image 
quality setting for the experiment. (For information about video 
formats and the video Quality setting, see Section 3.10.2, “MPEG-4 
Quality and File Size” on page 79.)
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15 In the Sources pane, view the digital video recording (DVR) section. 

16 In the digital video recording (DVR) area of the Source pane, select the 
type(s) of output to create - video file (AVI File), text file with frame numbers 
and timestamps (DVT File) or both.

 

17 In the Timecode options, select the In Video checkbox to include the time. 
Choose a Location and a Format setting to configure the display. (CinePlex 

TIP
Reducing blurs and color streaks in the video
If the experimental subject moves quickly, blurs and color streaks can appear 
in the video. Reduce or eliminate these problems by increasing the shutter 
speed. See Shutter Speed in the Global Configuration settings, as shown in 
the image above.

CAUTION
Save the AVI File
It is strongly recommended that you save an AVI File for every 
experimental run, even if you are sending data directly from 
CinePlex to OmniPlex. (AVI File is the default output type.) 
The AVI file is the originally recorded video of the experiment, and 
it can be retrieved and analyzed again. If you deselect the AVI File 
checkbox, the original video will not be saved. 

TIP
Generating timestamps and frame numbers—DVT FIle
The system will generate a digital video tracking (DVT) file if you select the 
DVT File checkbox. The DVT file will have frame numbers and timestamps 
only (no coordinate data). The correlation of timestamps with frame numbers 
might be useful even without the Tracking Option installed.
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Studio maintains a time code that tracks the time elapsed since the last time 
recording began.)

For example, the following images show the time code in the Upper Left 
location in SSSSS.SSS and HH:MM:SS.SSS format, respectively.

18 Repeat Step 13 through Step 17 for any other cameras connected to the 
system.

19 (Optional) If the arena dimensions have not yet been calibrated, the 
calibration can be done now. See Section 3.3, “Calibrating the Arena 
Dimensions” on page 30 for details.

20 From the CinePlex Studio toolbar, click the “A” arming button. A yellow 
flashing cassette icon appears on the status bar.

Note: At this point, CinePlex is in the armed condition and is waiting for a 
start signal to be sent from OmniPlex. The SPK - Activity pane in 
PlexControl shows no data on the CPX1 line.

21 From the PlexControl toolbar, click the Start Recording icon. If PlexControl 
prompts for a file name, enter it.

PlexControl starts recording and displays status information about the neural 
data file on the PlexControl status bar; for information on the PlexControl 
status, see the OmniPlex System instructions.
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CinePlex Studio automatically starts recording and displays information about 
the video file in the CinePlex Studio status bar.

The Studio status bar will display the amount of free space remaining on the 
drive selected.

Note: The system automatically checks that there is at least 10 GB of free 
disk space on the PC before it starts recording a file. The file size can 
grow to fill the space available, except that the system automatically 
stops recording the current file when the available disk space has 
been reduced to 10 GB. 

Studio starts sending the data to OmniPlex, and the SPK - Activity pane in 
PlexControl shows the synchronized data stream (see the blue data lines in 
this image):

Note: Plexon® recommends a short test recording to verify the data stream 
is being sent. The SPK - Activity pane in PlexControl should show the 
presence of the data stream, similar to that shown in the PlexControl 
image above.

22 To pause recording, click the PlexControl Pause Recording icon. 

PlexControl pauses recording and displays status information about the 
neural data file on the PlexControl status bar.

CinePlex Studio pauses recording and displays information about the video 
file in the CinePlex Studio status bar. The status bar flashes green and gray to 
indicate that the recording is paused.

To resume recording, click PlexControl Pause Recording again.

23 To stop recording, press the Stop Recording button in PlexControl (Studio 
recording stops also.)

PlexControl stops recording to the neural data file, clears the recording 
information from the status bar, and saves the file as specified in Step 21. 

CinePlex Studio stops recording and saves the video file(s) to the location that 
was specified as Rec Folder in the CinePlex Studio Global Configuration 
Pane. CinePlex Studio clears the recording information from the status bar 
and re-arms itself for the next recording session.

When Studio is armed, for efficiency it creates temporary files. When 
recording is started remotely (from OmniPlex), Studio writes to these 
temporary files. When recording is stopped, the temporary files are renamed, 
and new temporary files are opened in anticipation of a new recording 
session. The Studio Messages Pane displays information similar to the 
example below.
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Note: At this point, there is no tracking data being sent from CinePlex to 
OmniPlex, because CinePlex is once again in the armed condition. 
The SPK - Activity pane in PlexControl shows no data on the CPX1 
line.

24 You can start and stop recording as many times as desired. When recording 
starts, data will flow from CinePlex to OmniPlex. When recording stops, data 
does not flow.

25 To disarm CinePlex Studio, from the DVR toolbar, click Arm to clear. The 
status bar returns to the disarmed state.

26 To view the captured video file, browse to the file location and double click to 
open the file.

27 To transfer files to an analysis computer (if different than the recording 

computer), follow standard Windows procedures. 

28 To view the neural and video files together, start CinePlex Editor by following 
the procedures described in Chapter 4, Processing Video Files with CinePlex 
Editor. 

Note: You can also view just the video files by using CinePlex Editor, 

Windows Media Player® or CinePlex Studio on the analysis 
computer.

3.4.2 File Naming Procedure During and After Recording

During the recording process, CinePlex Studio creates temporary names for the 
AVI files. When the recording is stopped, Studio renames the files.

If there is only one camera connected to the CinePlex System:

• The format of the temporary files is yyyymmddnnn.avi

• The format of the renamed files is PLX_file_name.avi

If there are multiple cameras connected to the CinePlex System:
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• The format of the temporary files is yyyymmddnnn_N.avi

• The format of the renamed files is PLX_file_name_N.avi

where:

yyyymmdd is the year, month and day

nnn is a 3-digit number, 001, 002, ... 999 assigned automatically by the 
system

N is the camera number for which the file is created - 1, 2, ...

PLX_file_name is the file name specified by the user on the OmniPlex System 
in Step 21 of Section 3.4.1, “Recording Procedure” on page 42.

Note: If Studio is armed on one day, but the start signal is not received until the next 
day, the temporary filename remains the one for the previous day.
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3.5 Monitoring the Video During a Recording Session

The status bar in the CinePlex Studio main window displays information that 
allows the researcher to monitor the video recording process. This drawing shows 
the status bar during a typical recording session. (The image is split into three 
sections to fit the page.)

The contents of the status bar include

• A cassette icon that flashes yellow if recording is armed and is steady green 
when recording is in process.

• A display of the size of the recorded file in time and file size, and the 
remaining recording time and storage space available on the disk

• The maximum number of video frames queued for compression and waiting 
to be written to the AVI file at any time during the current recording session—
maximum queued units (MQU)

• A count of the number of dropped frames during the current recording session

• A recording indicator; a letter R appears when recording is in process

• Numbers identifying the resolution of the current recording in pixels 
(horizontal x vertical)

• The instantaneous frame rate in frames per second (fps). 

Note: During the recording process, the displayed value of the frame rate should 
match the value you specified in the Global Config pane. If the rate does not 
match, it is possible that the computer is experiencing partial congestion. 
Partial congestion is normally caused by non-Plexon applications. Partial 
congestion does not always result in dropped frames, but some processing 
might be slightly delayed. In the event that processing ever experiences 
problems, please contact Plexon support for help in identifying and resolving 
the issue.
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3.6 Recording Video without Neural Data (Used for Animal Training)

This section explains how to record video and tracking data without neural data. 
In this case, the OmniPlex System is activated only for the purpose of providing 
the required clock for the CinePlex System. This procedure requires activation of 
the OmniPlex data stream (which starts the clock), and then starting and stopping 
the CinePlex Studio video recording process locally on the CinePlex System. 
This method of triggering the recording is typically used during animal training, 
when no neural data is being collected.

3.6.1 Recording Procedure

Perform these steps to record video data without neural data.

1 Ensure that the system is connected as described in Chapter 2, Installing, 
Starting and Testing CinePlex Studio.

2 At the OmniPlex System chassis, turn the power on and start the OmniPlex 
Server and PlexControl.

3 If not already done, configure the OmniPlex System.

4 Click the Start Data button in the PlexControl toolbar so that neural data 
acquisition begins, and the neural data appears in PlexControl display.

5 Double-click the CinePlex Studio icon. Wait for the CinePlex Studio 
application main window to appear on the monitor.

Note: If Studio does not detect the OmniPlex clock, an error message will 
appear. If it does, see Appendix F-Troubleshooting.

6 Verify that Cameras is selected in the Studio dropdown list and that a camera 
image is displayed for each of the camera(s) that will be used in the 
experiment. The image is displayed for each camera icon that is selected. 
The image below shows that both Camera 1 and Camera 2 are selected 
(indicated by the orange color of the icons).

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.

CAUTION
Lighting Conditions
If lighting conditions change enough during recording that ‘objects 
too large’ or some other condition occurs, the position data may be 
meaningless.
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7 If there is an appropriate file containing all the desired CinePlex settings, load 

the file onto the CinePlex System using the Load settings icon ( ) on the 
main toolbar or the File/Load Settings menu selection.

8 Click on the Global Config tab in the static configuration pane to display the 
Global Config pane. 

Note: This pane is the first an experimenter will normally use when setting 
up CinePlex Studio, but perhaps not very often after that. It contains 
settings that pertain to the frame rate to use when recording, image 
resolution (quality of recordings to make), compression bit rate and 
local file recording folder. For information about video formats and the 
video Quality setting, see Section 3.10.2, “MPEG-4 Quality and File 
Size” on page 79.

9 View the settings in the Global Config pane and modify any that need to be 
changed prior to starting the next recording session.

10 To browse for the desired file location (where the recorded files will be saved), 
click on the browse icon, which is the rectangle with three dots on the Rec 
Folder row of the Global Config pane.
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11 When the Browse for Folder dialog box appears, use standard Windows 
methods to select or create the appropriate folder. The factory default location 
for the Recording folder is C:\PlexonData or D:\PlexonData (if disk D is 
available).

12 When finished choosing or creating a storage folder, click OK.

Note: The location of the Recording folder is included in the Settings file (if 
you save a Settings file), and is restored when the Settings file is 
loaded. To save settings, click Save Settings on the File menu, or 

click the Save Settings button ( ) on the toolbar.

Note: If the Recording drive is not NTFS compatible, a warning message 
displays.

13 To view the CinePlex Studio time display, see the Source pane under the 
Video window. The image below shows the Source 1 pane, which appears 
under the Video 1 window for Camera 1. Similar panes appear for each of the 
cameras you have activated in the previous steps. (Calibration is explained in 
a later step in this procedure.)
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14 In the Camera area of the Source pane (labeled with the camera model 
name), adjust the controls to obtain an acceptable image on the screen. The 
specific controls vary depending on the camera model. Typical adjustments 
include Gain, Auto White Balance, Brightness, Sharpness and 
Saturation.

Note: You can also use other image quality settings. To evaluate image 
quality settings, manually collect a set of AVI files at different settings 
and use the file mode to determine a minimum acceptable image 
quality setting for the experiment. (For information about video 
formats and the video Quality setting, see Section 3.10.2, “MPEG-4 
Quality and File Size” on page 79.)
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15 In the Sources pane, view the digital video recording (DVR) section. 

16 In the digital video recording (DVR) area of the Source pane, select the 
type(s) of output to create - video file (AVI File), text file with frame numbers 
and timestamps (DVT File) or both.

17 In the Timecode options, select the In Video checkbox to include the time. 
Choose a Location and a Format setting to configure the display. (CinePlex 
Studio maintains a time code that tracks the time elapsed since the last time 
recording began.)

For example, the following images show the time code in the Upper Left 
location in SSSSS.SSS and HH:MM:SS.SSS format, respectively.

TIP
Reducing blurs and color streaks in the video
If the experimental subject moves quickly, blurs and color streaks can 
appear in the video. Reduce or eliminate these problems by increasing the 
shutter speed. See Shutter Speed in the Global Configuration settings, as 
shown in the image above.
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18 Repeat Step 13 through Step 17 for any other cameras connected to the 
system.

19 (Optional) If the arena dimensions have not yet been calibrated, the 
calibration can be done now. See Section 3.3, “Calibrating the Arena 
Dimensions” on page 30 for details.

20 To start recording video, click the Start recording button (the red circular 
icon) on the CinePlex Studio toolbar. A green cassette icon appears on the 
status bar to indicate that the recording is in process.

The Pause or resume recording and Stop recording buttons appear on the 
CinePlex toolbar.

Note: The system automatically checks that there is at least 10 GB of free 
disk space on the PC before it starts recording a file. The file size can 
grow to fill the space available, except that the system automatically 
stops recording the current file when the available disk space has 
been reduced to 10 GB. 

21 To pause recording, click the Pause or resume recording icon. 

CinePlex Studio pauses recording and displays information about the video 
file in the CinePlex Studio status bar. The status bar flashes green and gray to 
indicate that the recording is paused.

To resume recording, click the Pause or resume recording icon again.

22 To stop recording, press the Stop recording icon.

CinePlex Studio stops recording and saves the video file(s) to the location that 
was specified as Rec Folder in the CinePlex Studio Global Configuration 
Pane. CinePlex Studio clears the recording information from the status bar 
and re-arms itself for the next recording session.

The Studio Messages Pane displays information similar to the example below.
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23 You can start and stop recording as many times as desired.

24 To view the captured video file, browse to the file location and double click to 
open the file.

25 To transfer files to an analysis computer (if different than the recording 
computer), follow standard Windows procedures. 

26 To view the video files, navigate to the directory where the files were saved in 
Step 11) and double click on the desired file to view it.



CinePlex Behavioral Research System 

Version 3 59

3.7 Video Playback and Rerecording In Studio Files (Offline) Mode

This section explains how to use CinePlex Studio in offline mode to play back 
and rerecord video from existing files. The existing AVI and/or DVT files are the 
ones recorded previously by means of the procedure in Section 3.4, “Recording 
Synchronized Video Tracking and Neural Data” on page 42.

Offline mode allows existing CinePlex video file(s) to be viewed and embedded 
data to be extracted. The files can also be rerecorded with different or changed 
settings from the original recording.

The offline functions of CinePlex Studio can be used on the OmniPlex/CinePlex 
host PC where the camera(s) are installed, or on a standalone computer. The 
CinePlex Studio license must be present on the computer.

3.7.1 Entering Offline Mode

CinePlex Studio has two modes of operation: Cameras (online) mode and Files 
(offline) mode. You can switch from Cameras mode to Files mode using the 
video source dropdown list on the CinePlex Studio main toolbar, as shown in this 
drawing.

Note: CinePlex Studio comes up in Files (offline) mode automatically if no cameras 
are detected.

3.7.2 Selecting Files to Be Viewed and/or Rerecorded

Files are represented by icons in the toolbar. You can select from one to four files 
to process in offline mode, up to the number of cameras licensed for the system. 
The number in the file icon corresponds to the cameral number on which a file 
was originally recorded. In the following image, for example, File 1 is selected, 
therefore the source file must be one that was recorded on Camera 1.

3.7.3 Managing the Offline Main Window Layout

The image below shows a typical layout with files from Camera 1 and Camera 2 
enabled.

Files
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The Video Edit pane allows the opened file(s) to be viewed frame by frame. 

The Global Config and Source panes allow you to change settings and rerecord 
the files. (The procedure is presented below.)

Recording is started from the Start recording from file ( ) button.
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3.7.4 Procedure for Loading and Reviewing Video Files

The following procedure organizes the main window and loads the desired files. 
It also displays the Video Edit pane, which can be used to replay the video file 
frame by frame.

To view files from a single camera

1 To view files from a single camera, select the appropriate file icon. For 
example, in the image below, the file from Camera 1 (File 1) is selected.

2 From the Window dropdown menu, select Layout and then Reset to Default 
Layout.

This action displays the Video Edit pane and the selected Source pane. In the 
image below, Source 1 is displayed.
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3 In the Source pane, in the File Name row, click on the folder icon to navigate 
to the directory containing the desired AVI file and select the file.

Note: If you select a file that was created with any camera other than the 
camera associated with Source, the system will prompt you to select 
a different file (a file that was created with appropriate camera). The 
system can automatically detect which camera created the file, 
regardless of the file name. For example, in the image below, only 
files created with Camera 1 can be loaded in the Source 1 pane.
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The buttons in the Video Edit pane can be used to replay the video file frame 
by frame.

4 To view files that were created with a different camera, repeat Step 1 through 
Step 3. (In Step 1, for example, disable all Files except the one file to be 
worked on next. For example, disable File 1 and enable File 2.)

To view files from multiple cameras

1 To view files from multiple cameras, select the appropriate file icons. For 
example, in the image below, the files from Camera 1 (File 1) and Camera 2 
(File 2) are selected.
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2 From the Window dropdown menu, select Layout and then Reset to Default 
Layout.
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This action displays the Video Edit panes and the selected Source panes. In 
the image below, Source 1 and Source 2 are displayed.

3 In each of the Source panes, in the File Name row, click on the folder icon to 
navigate to the directory containing the desired AVI file and select the file.

4 The options for file selection and video playback for multiple files are similar to 
those for a single file. (See To view files from a single camera on page 61.)



66 CinePlex Behavioral Research System 

3 Recording Video with CinePlex Studio 

3.7.5 Setting the Recording Parameters and Starting the Recording

The recording parameters are set in the Source pane. For example, the image 
below shows the Source frame for File 2, and the File Name is a file that was 
originally recorded with Camera 2.

In this pane, you can set parameters that will cause the system to:

• Rerecord CinePlex files previously saved in MJPEG format to the much more 
compact MPEG format, thus saving storage space

• Rerecord CinePlex files already in MPEG format with a reduced quality 
setting to reduce further their size and save storage space

• Change quality, brightness, contrast or other settings so that existing files are 
more usable

If the Tracking Option is installed (now or in the future), the following 
capabilities are also available:

• Change tracking parameters and retrack the file

• Modify existing tracking parameters and rerecord

In Files mode, CinePlex Studio operating settings can be taken from:

• Existing settings files saved in online mode

• Existing settings files saved in offline mode

• Settings data contained within the AVI files themselves
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• New settings made by the user while analyzing the video file(s)

• Modifications made to settings from any of the sources above

Recording of the existing video (with the new settings) is started from the Start 
recording from file ( ) button in the main toolbar.

3.7.6 Summary of Offline Procedures

This section summarizes the use of the offline procedures.

1 Use CinePlex Studio to record one or more video files on an internal hard 
drive. If the Recording Folder has not been set, a notification message will 
display. See Section 3.4.1, “Recording Procedure” on page 42.

2 The AVI and/or DVT files can be rerecorded on the host PC that is part of the 
CinePlex/OmniPlex System, or the files can be transferred to another 
computer for analysis computer. When finished copying the files to the 
analysis computer, rename the files, if desired.

The recommended system requirements for an offline analysis computer 
include a dual core Intel processor operating at better than 3 GHz with 3 GB 
of memory, and an NVIDIA® GeForce® 9600 GT or better video card. In 
addition, the appropriate Plexon license (see Section 1.5, “CinePlex Licensing 
Options” on page 5) must be plugged in to one of the USB ports. For a more 
detailed discussion of requirements, contact Plexon support at 
+1-214-369-4957 or support@plexon.com. 

3 Extraction (see Section 3.8, “Additional File-processing Tools” on page 69).

3.7.7 Offline Functionality Compared to Online Functionality

Most offline functionality is only marginally different from its online equivalent. 
The major exception is that the optional tracking and behavior functionality in a 
recorded file will be slightly different than the functionality for live video. This is 
because the compression techniques used to create AVI files of manageable size 
inherently discard some of the data that was present in the original, that is, there 
are losses that occur during compression. In particular, some color, details, and 
brightness information is compromised. Normally the differences are not visible 
to the naked eye, but they will cause slight differences in the sensitive algorithms 
used for tracking analysis (if the Tracking Option is installed).

Differences in the user interface are described below:

• Global Config pane - The frame rate and resolution shown are that of the 
source files selected. Other sections are unchanged.

mailto:support@plexon.com
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• Source pane(s) - Most Camera adjustments are replaced with a file selection 
browsing tool. In their places are simple adjustments for brightness and 
contrast. Other sections are unchanged.

3.7.8 Transferring Files to Use in Offline Mode

To enable offline analysis, bring a pair (or multiple pairs) of AVI and neural data 
files together on the same computer - the “analysis computer”-with CinePlex 
Editor. You can use a variety of means to transfer the AVI files from the CinePlex 
Studio internal hard drive to a separate analysis computer, if needed. Likewise, if 
the neural data files are stored elsewhere, you may transfer the neural data files to 
the analysis computer, perhaps by using a network connection or some other 
means. If the analysis computer is the Plexon OmniPlex/CinePlex computer, the 
neural data files are already stored on local disk(s).



CinePlex Behavioral Research System 

Version 3 69

3.7.9 File Naming Procedure in Offline Mode

CinePlex Studio renames files during the rerecording process. After you press the 
Rec button, CinePlex Studio prompts for new file name(s), and you can accept 
the name as shown or enter a new name.

If there is only one file being rerecorded, the format of the prompted file name is 
filename-nn.avi, 
where:

— filename is the original file name of the opened source file

— nn is a 2-digit number, 01, 02, ... 99 assigned automatically by the 
system for each new rerecorded file instance

for example:

filename-01.avi, filename-02.avi, filename-03.avi, ...

If there are multiple files being rerecorded, the format of the prompted file name 
is filenameN-nn.avi,
where:

— filenameN is the original file name for one of the opened source files

— nn is a 2-digit number, 01, 02, ... 99 assigned automatically by the 
system for each new rerecorded file instance

for example:

filename1-01.avi, filename1-02.avi, filename1-03.avi, ...
filename2-01.avi, filename2-02.avi, filename2-03.avi, ...

3.8 Additional File-processing Tools

The following tools can also be used for processing files:

• Use the CinePlex Studio Extractor function to extract static and dynamic data 
from a Plexon AVI file for analysis with a database program such as 

Microsoft® SQL Server® or data processing tools such as Microsoft Excel®. 
See Using the Extractor, below.

• Use CinePlex Editor (or some other method) to match up the AVI file with its 
partner neural data file, or DVT file, or both, and analyze the data. See 
Chapter 4, Processing Video Files with CinePlex Editor.
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3.9 Using the Extractor

This section contains information necessary for setting up and operating the 
CinePlex Extractor program. CinePlex Extractor is an offline tool that extracts 
desired static and dynamic data from a Plexon AVI file, placing it into Plexon 
Settings file format and/or formats suitable for use by database programs such as 
Microsoft SQL Server or data processing tools such as Microsoft Excel.

Static data in an AVI file includes system information and settings data. Dynamic 
data includes frame numbers, timestamps and (if the Tracking Option is 
purchased and installed) positions, speeds, angles, and other computed 
information.

Before attempting to use the extractor, you must load an AVI file from which the 
data can be extracted. The selected file must be one that was made during the 
video recording process (see the recording sections earlier in this chapter).

Entering offline mode and viewing the main toolbar

1 Verify that Files (offline) mode is selected in the CinePlex Studio main 
window.

The toolbar displays from one to four file icons depending on the number of 
cameras licensed.

When the offline main window is displayed, the Extractor icon and Extractor 
pulldown list selection are both inactive (greyed out), as shown in the image 
below. The Extractor function remains inactive and cannot be selected until a 
valid AVI file is loaded.

TIP
Extractor operates on one file at a time
The Extractor function can extract either settings or data from a single video 
file. The procedures in this section explain how to load and process files in 
the most convenient manner.

Files
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Selecting a single AVI file

1 To select a file that was originally recorded on Camera 1, select the File 1 
icon. The File 1 icon becomes orange, as shown in the image below. Note 
that the Extractor icon remains inactive.

(To view files from a different camera, select the appropriate File icon.)

2 From the Window dropdown menu, select Layout and then Reset to Default 
Layout.

This action displays the Video Edit pane and the selected Source pane. In the 
image below, Source 1 is displayed.
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3 In the Source pane, in the File Name row, click on the folder icon to navigate 
to the directory containing the desired AVI file and select the file.

Note: If you select a file that was created with any camera other than the 
camera associated with Source, the system will prompt you to select 
a different file (a file that was created with appropriate camera). The 
system can automatically detect which camera created the file, 
regardless of the file name. For example, in the image below, only 
files created with Camera 1 can be loaded in the Source 1 pane.
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Note that the Extractor icon and Extractor pulldown option are now active, 
because a valid file is loaded.



74 CinePlex Behavioral Research System 

3 Recording Video with CinePlex Studio 

4 From the File menu select Extractor, or click the Extractor icon ( ) in the 
toolbar (see the image above to locate these features).

5 The Extractor dialog box opens.

6 To extract data, drag and drop entries in the Available Data panel to the panel 
on the right. When the panel on the right is populated with one or more 
entries, the Data to Extract banner appears. The order of the entries in the 
Data to Extract section may be rearranged by dragging and dropping them 
into the desired position in the list.

7 When ready to extract the data, click the Extract Data button.

8 If it is desired to stop the data extraction before the end of the file is reached, 
click the Stop button.

The data is extracted to a comma-separated-values (CSV) file and can be 
opened in a spreadsheet application such as Microsoft Excel. The column 
headings are presented in the order that was specified in the Data to Extract 
section of the dialog box.
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The file can be opened in a text format.

 

The CSV file can be opened in an application such as Excel.

 

9 The settings from the file may be extracted by clicking the Extract Settings 
button or a DVT file may be created by clicking the Make DVT 2.0 button. An 
example of a text file with the extracted settings information is shown below.

 



76 CinePlex Behavioral Research System 

3 Recording Video with CinePlex Studio 

10 Repeat Step 3 through Step 9 to extract data or settings from any additional 
files from this same camera.

11 Repeat the entire procedure to extract data or settings from the recordings 
made by other cameras.

Selecting AVI files from multiple camera sources sequentially

If you want to extract data or settings from multiple cameras, it might be 
convenient to display the Source panes from all the cameras of interest and then 
enable one source at a time. For example, if the goal is to extract data for 
[Experiment A, Cameras 1 and 2], then [Experiment B, Cameras 1 and 2], and so 
forth, it is convenient to display the Source panes for both Camera 1 and 
Camera 2, and toggle between the source panes to load files and extract data. 
The following procedure performs that function.

1 To display Source panes for Camera 1 and Camera 2, select the File 1 and 
File 2 icons. These icons become orange, as shown in the image below. Note 
that the Extractor icon remains inactive.

2 From the Window dropdown menu, select Layout and then Reset to Default 
Layout.
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This action displays the Video Edit pane and the selected Source panes. In 
the image below, Source 1 and Source 2 are displayed. Note that the 
Extractor icon remains inactive because a valid file has not yet been loaded.

3 Now that panes for Source 1 and Source 2 are both displayed, it is easy to 
disable one of the sources at a time. Note that Extractor can only process one 
AVI file at a time. 

For example, to work with Source 1, it is necessary to disable the other 
sources. In this example, Source 2 needs to be disabled. Click on the File 2 
icon to deselect it.

4 Load a file for Source 1 in the same manner as above (as was done in 
Selecting a single AVI file on page 71).

Note that the Extractor icon is enabled in the toolbar, because a valid file has 
been loaded.

5 Extract the desired File 1 settings or data (as was done in Selecting a single 
AVI file on page 71).

6 To work with Source 2, it is necessary to disable the other sources. In this 
example, Source 1 needs to be disabled and Source 2 enabled.

Select the File 2 icon and deselect the File 1 icon.
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7 Load a file for Source 2.

8 Extract the desired File 2 settings or data in the same manner as above.

9 Repeat Step 3 through Step 8 as many times as needed to extract settings or 
data from all the files of interest.
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3.10 General Information on Video Formats, Synchronization and 
Timestamps

This section discusses technical aspects of video recording, including video file 
formats, synchronization and timestamps.

3.10.1 Reference Information - Digital Video Recorder AVI Files

The Digital Video Recording (DVR) feature of CinePlex Studio stores the video 
recording from one or more cameras on an internal hard drive. In most 
experiments, the user simultaneously collects a neural data file in an AVI file. 
With CinePlex Studio, you may start, stop, and time stamp these AVI files in a 
way that enables you to subsequently correlate them offline with the 
simultaneously-captured neural data.

Note: If Studio is armed on one day, but the start signal is not received until the next 
day, the filename remains the one for the previous day.

CinePlex Studio records video into AVI files at a resolution of 640x480 pixels at 
up to 200 frames per second, which implies a raw data rate of over 700 GB/hour. 
To reduce disk usage, CinePlex Studio compresses the video using standard 
MPEG algorithms before it writes it to the AVI file. You can vary the file 
compression to find a suitable balance between AVI file size and image quality.

3.10.2 MPEG-4 Quality and File Size

MPEG-4 recording format is used because it produces files that are routinely 75 
to 90% smaller than the equivalent MJPEG formatted files that were produced by 
earlier versions of CinePlex Studio.

The CinePlex System Quality settings for MPEG-4 range from 1 to 10. The 
values represent the nominal bit rate divided by 500,000. The default value of 4 is 
adequate for most experiments and Plexon recommends using that value unless 
there is a specific reason to modify it.

Note: If you increase the MPEG Quality setting, for example, increasing it from 4 to 
10, the size of the AVI file increases significantly (assuming the same recording 
duration), but it does not dramatically increase the quality of the image. 
Conversely, if you reduce the Quality setting, for example, from 4 to 2, the size 
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of the AVI file is reduced (for the same recording duration), however, the quality 
of the image degrades significantly.

3.10.3 MPEG Recording Processes

While it records, CinePlex Studio continually calculates and displays the amount 
of recording time left until the target hard drive would fill up. As the hard drive 
capacity is neared, CinePlex Studio stops recording.

The AVI files created by CinePlex Studio are industry-standard AVI-format files 
that you can play with many standard tools, including Microsoft Windows Media 
Player, which is pre-installed on most Windows computers. You can also use a 
variety of commercial software applications to edit and perform other operations 
on AVI files. 

Note: Windows Media Player and other video players render files slower than real 
time if the files were recorded at 40 frames per second or greater. This can be 
confusing because the slider moves faster than the video plays such that the 
slider reaches the end of its travel before the video finishes playing.

The MPEG/AVI format allows the embedding of additional data segments within 
AVI files. Each embedded data segment has an identification tag. Typically, an 
AVI file reader that does not recognize a tag for an embedded data segment skips 
that data segment. CinePlex Studio always produces AVI files with a Plexon-
specific additional tagged data segment that contains dynamic data, including the 
frame timestamp, for each video frame. CinePlex Editor can read this additional 
data segment in the AVI files generated by CinePlex Studio and thus recover the 
frame timestamp. Other AVI file readers like Windows Media Player ignore this 
data. This Plexon-specific nondestructive embedded data is not visible on the 
video frame. However, CinePlex Studio contains an optional feature that can 
overlay this time stamp in visible numerals on the video image itself; see Section 
3.4, “Recording Synchronized Video Tracking and Neural Data” on page 42. 

3.10.4 Synchronizing Files from Two Video Cameras

In some cases of synchronizing files from two video cameras, one file can be 
several frames longer than another due to minor software delays handling the 
Stop signal. The critical functionality is that the cameras start together and that 
triggers for corresponding frames occur at exactly the same time.

3.10.5 Synchronizing Video Files with Neural Data Files

To synchronize the video files with the neural data files, both systems must:

• derive all time stamps from the same clock

• start recording both files at the same time - use the same timestamp for 
relative time zero

• stop recordings at approximately the same time

Use of the same clock to generate the time stamps in each file avoids longer-term 
“drifting” of the time-base of one file relative to the other. For example, say the 
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clock controlling the time stamp generation for video frames has a frequency 
difference of 1% from the clock controlling the time stamp generation of neural 
firing events in the neural data files; after 100 seconds, the occurrences that 
should appear as simultaneous in the neural data and AVI files appear instead as 
one second apart. Since CinePlex Studio is integrated with an OmniPlex System, 
synchronization occurs because CinePlex Studio is controlled with a clock signal 
derived from the main OmniPlex System clock. Thus, the PLX and AVI files are 
guaranteed to have the same time-base.

Note: The CinePlex Studio clock is 1 MHz. This means that the resolution of time 
stamps generated by CinePlex Studio is 1 sec.

When using CinePlex Studio with the OmniPlex System, OmniPlex generates 
control signals and routes the signals through the control cable to the appropriate 
inputs for CinePlex Studio. To use this mode of operation, arm CinePlex Studio 
to respond to the electrical control signals. When armed, CinePlex Studio starts 
recording the video file exactly one frametime after the start of the neural data 
file.

Note: CinePlex Studio resets the relative timestamp to zero when armed and 
recording is started by PlexControl or when clicking the Record button to 
manually start recording a video file. Otherwise the time stamps continue to 
increment until CinePlex Studio is shut down.
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4.1 Understanding CinePlex Editor Files

For a complete list of CinePlex® Editor features, see Section 1.7, “CinePlex 
Editor Features” on page 7.

Although it can be used to work with single files, CinePlex Editor is typically 
used with a pair of data files recorded in the lab—a video file and a neural data 
file. To use CinePlex Editor successfully, it is important to understand how 
CinePlex Editor works with files. This section describes what happens to the 
various files when creating a CinePlex project, importing data, editing 
information, saving a project, re-opening a project file, and exporting data.

Note: When using an AVI file and a DVT file, the system uses the timestamps from 
the DVT file.

Note: When using an AVI file and a PLX file, the system uses the timestamps from 
the AVI file.

When starting CinePlex Editor for the first time, it prompts for a separate file to 
store project information. This CinePlex project (CPJ) file can include the 
following items:

• File references: locations and names of the neural data file and the video file

• Marker definitions, which includes the marker type, name, and any zone or 
level definitions as appropriate

Note: Markers are a type of indicator or identifier. Marker occurrences are 
placements of particular markers in a file. For more information on markers, 
see Section 4.2.4, “Defining a New Marker” on page 92.

• Information for each marker occurrence

4.1.1 Creating a Project File

Normally the first step is to create a CinePlex Project file. To create a project file 
you must specify the neural data file, which is usually either a PLX or a NEX file 
(although it can be a DVT file), and the associated AVI video file. The New 
Project Wizard can step through this process; see Section 4.2.2, “Setting Up a 
New Project” on page 87. After these files are specified, their file names are 
stored in the CPJ file, and the initial import of data into the project begins. 

Note: A CinePlex Project file can accommodate only one pair of data files—usually a 
neural data file and a video file.

CAUTION
Upgrade Notice
If the system has been upgraded to CinePlex Version 3, CinePlex 
Editor should also be updated. The upgraded CinePlex Editor is 
backwards compatible and will also read AVI files created by 
CinePlex Capture 1.0, 1.1, 1.2, 1.4, and 2.0.
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4.1.2 Importing Data Files

During the initial import of the neural and video data into a project, CinePlex 
Editor creates markers and marker occurrences based on the contents of the 
neural data and video files. From the neural data file, CinePlex Editor translates 
any events (for example, Type 4 data from PLX files) or appropriate NEX 
variables (event, marker, or interval) into markers and marker occurrences. From 
the video file, CinePlex Editor creates a Frame marker and creates occurrences 
for the timestamps of each video frame. However, CinePlex Editor does not store 
neural data, continuous data, or the video frame images in the CPJ file.

4.1.3 Changing and Saving Project Files

After importing the marker information from the data files into CinePlex Editor 
and it is in the form of marker occurrences, you may edit, extend, or even delete 
the information; then you may save the changes to a CPJ file. When saving the 
CPJ file, CinePlex Editor also saves any new marker information that it creates 
into the CPJ file. Thus, when re-loading a CPJ file, CinePlex Editor completely 
restores the markers and marker occurrences that were present when the CPJ file 
was saved.

4.1.4 Reopening Project Files

When subsequently re-opening a CPJ file, CinePlex Editor gets the marker data 
exclusively from the CPJ file; CinePlex Editor does not re-import the markers 
from the neural data or video files. However, CinePlex Editor does find the 
original neural data and video files on the hard drive, opens them and reads them 
to get the neural spike data, continuous data, and video images. 

Note: Moving the files—If you move the original neural data or video files into the 
same folder on which the CPJ file resides, CinePlex Editor will find them 
automatically when it reopens the project file. If you move the original neural 
data or video files to some other location on the hard drive, CinePlex Editor 
prompts to locate the files when it reopens the project file.

4.1.5 Exporting Files

Although CPJ files cannot currently be used by any software other than CinePlex 
Editor, you may export all of the data stored in CPJ files into other formats, such 
as PLX or NEX data files, text files or comma-separated-values (CSV) files. Text 
and CSV files can be opened in applications such as Excel® or MATLAB® for 
additional analysis.
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4.2 Getting Started

This section describes a quick-start example to provide familiarization with 
CinePlex Editor.

4.2.1 Using the Quick Start Files

This quick-start example uses two sample data files that do not install with 
CinePlex Editor: CM_Quickstart.plx and CM_Quickstart.AVI. Because these two 
files are very large, they are located in the Quickstart folder on the USB drive that 
was delivered with your CinePlex System. As an alternative, instead of using 
CM_Quickstart.plx and CM_Quickstart.AVI, you may use any video data file 
(AVI) collected with CinePlex Studio together with a neural data file (PLX, NEX, 
DVT) collected by MAP or an OmniPlex® System. Before using the quick-start 
sample files, Plexon recommends copying them to the local disk on the computer 
to improve performance.

The quick-start example consists of the following series of procedures:

• Section 4.2.2, “Setting Up a New Project” on page 87 

• Section 4.2.3, “Understanding the CinePlex Editor Main View” on page 89

• Section 4.2.4, “Defining a New Marker” on page 92

• Section 4.2.5, “Creating Marker Occurrences” on page 93

• Section 4.2.6, “Saving and Exporting the Data” on page 94

• Section 4.2.7, “Re-opening a Project File” on page 96
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4.2.2 Setting Up a New Project

This procedure covers the steps required to set up a new project. 

1 Click the CinePlex Editor desktop icon or click CinePlex Editor on the 

Windows® Start menu. The Welcome To CinePlex Editor dialog box opens.

Note: The Welcome to CinePlex Editor dialog box provides a quick way to 
start a new project, load an existing project file, or load a recently-
used project file. The first time CinePlex Editor runs, CPJ files do not 
appear in the list box and Open the Selected Recent CinePlex 
Project is unavailable. 

2 Click Start a New CinePlex Project, which starts the New Project Wizard. 
This wizard is a series of dialog boxes that guide you through the process of 
setting up a new project. The New Project Wizard opens.
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3 In the Video Data Input File (AVI) area, click Browse, go to the directory 
where the quick-start files are stored and locate CM_Quickstart.AVI. Open the 
file. The New Project Wizard changes all the file names to match.

Note: When you enter a name in the Video Data Input File (AVI) box, the 
Neural Data Input File (PLX, NEX, DVT) and CinePlex Project File 
(CPJ) boxes change to reflect the name entered. This is a typical 
example of the helpful behavior of CinePlex Editor, which suggests 
file names. 

Note: For use with CinePlex, AVI files must be saved in Motion JPEG 
(MJPG) video compression format. If you attempt to open an AVI file 
that is not in MJPG format, a notification dialog box appears:

4 For this quick-start procedure, accept the suggested names and click 
Continue. The Verify Project Files dialog box opens, which contains some 
basic information to allow verification of the selected files.
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5 If the file information is correct, click Continue.

The initial import operations begin; CinePlex Editor creates the CPJ file and 
opens the CinePlex Editor main view.

4.2.3 Understanding the CinePlex Editor Main View

This procedure covers the steps required to set up and control the CinePlex Editor 
main view. 

Viewing the CinePlex Editor main window

1 When the CinePlex Editor main view appears, click the maximize button in the 
Windows title bar to maximize the CinePlex Editor window. 

Note: CinePlex Editor is easier to set up and use when its screen area is 
maximized.

The CinePlex Editor main window should look similar to the following image:

You can reset the window arrangement to the default view by selecting 
Window | Layout | Reset to Default Layout.
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The image below shows a typical main screen after some of the procedures in 
this chapter have been completed.

The first frame of the video file appears in the Video window at the upper-
right. Because the CM_QuickStart neural and video data files were recorded 
using CinePlex Studio with the Tracking option enabled, CinePlex Editor 
imports the tracking coordinates from the neural data file, and they appear as 
crosshairs superimposed over the video.

The neural data appears in the Activity window at the bottom, which shows 
the neural activity at the beginning of the file. Each row in the Activity window 
represents either a marker or a channel of data. The marker occurrence times 
and neural firing times for each channel appear as tick marks in the view. You 
may color code the ticks as appropriate for the marker type and unit 
designation; for more information, see Section 4.2.4, “Defining a New Marker” 
on page 92.

The Activity window displays data for markers and channels. If the Show 
checkbox for a marker or channel is selected, the Activity window displays the 
marker or channel. If you deselect a checkbox, the associated marker or 
channel is not displayed in the Activity window.

Running the video

2 On the toolbar, click the Play button 

The video plays, and the neural data scrolls from right to left in the Activity 
window. This keeps the current video frame at the position marked by the 
current-time indicator in the Activity window. The current-time indicator is the 
downward-pointing triangle near the center of the view, which is surrounded 
by the current frame time and frame number.
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3 Click the Pause button to pause the display. 

Note: You may also pause the display by pressing the SPACEBAR key. To 
restart the display click the Pause button or press the spacebar key.

4 Click the Previous Frame and Next Frame buttons to move backwards or 
forwards to sequentially view each frame in the display.

Note: You may also step through the display by pressing the LEFT ARROW 
key or the RIGHT ARROW key.

5 Click Play. Click the rate buttons (Slower/Faster) to decrease or increase the 
speed of the display. Continued decreasing the speed will eventually cause a 
reversal to occur, and continued increasing the speed will eventually reach a 
maximum speed.

Note: You may also change the speed by using the UP ARROW key and the 
DOWN ARROW key on the computer keyboard. You may also select a 
speed from the drop list on the toolbar.

6 Click the Reverse Animation button to switch the direction of play. The speed 
of the new direction will be the same as in the old direction. 

7 Click the Normal Speed button to reset the playback speed to normal, which 
is one times the recorded speed of the video in the forward direction.

8 Click the Rewind button to return to the beginning of the file.
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4.2.4 Defining a New Marker

This procedure covers the steps required to define a new marker. The Markers 
window in the upper left corner of the main view shows the set of markers 
imported from the data files.

The >> indicator denotes the current marker. The Markers window shows the 
following basic information about each marker:

• Name shows the name assigned to the marker. Marker names must be unique.

• Type indicates the abbreviation that denotes the type of the marker; for a 
complete list of marker types, see Section 4.5.1, “Defining Markers” on 
page 98.

• Count shows the number of occurrences or each marker type.

• Key indicates the keystroke that is associated with this marker, which can be 
used to find and insert markers.

• Show indicates if the occurrences of this marker display in the Activity 
window.

• Display Color shows the color of the occurrences of this marker in the 
display views.

For the purpose of this quick-start example, suppose you want to use CinePlex 
Editor to invalidate intervals in the neural data that were corrupted by artifacts, in 
this case from the animal chewing. You do this by defining a marker to bracket 
the chewing interval as in the procedure below.

1 Click Pause. 

Note: Although pausing is not required, the video can be distracting when 
performing other operations in CinePlex Editor. 

2 Define a new marker to denote the time intervals that are dominated by 
artifacts. This can be done in three ways:

• Click the New Marker button, 

• or, from the Edit menu, click Define New Marker,

• or, from the right-click menu in the Markers window, select Define New 
Marker.
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The Define New Marker dialog box appears.

Note: The F (Frame) marker is a special time-only marker applied 
automatically by CinePlex Studio to associate a time with each video 
frame. This marker always appears grayed out in the Define New 
Marker dialog box because it is system-generated.

3 In the Type area, click I to define an interval marker. 

4 In the Name box, in the place of the default name Interval type “Chewing 
Artifact.” Retain the default settings for the other items.

Note: For explanations for the other items in the Define New Marker 
window, see Section 4.5.1, “Defining Markers” on page 98. 

5 Click OK. 

The Chewing Artifact entry appears in the Markers window, and the >> 
symbol appears in the left-most column to indicate that this marker is currently 
selected. However, there are no occurrences of this marker, so the value in 
the Count column is 0.

4.2.5 Creating Marker Occurrences

This procedure covers the steps required to create new marker occurrences. It is 
possible to have more than one occurrence for any given marker. You may 
manually enter marker occurrences in three different ways:

• keystroke

• button click in the Input window

• mouse click in an appropriate view

Each method has advantages and disadvantages; we suggest trying each method 
to find the appropriate one. For more information on each one of these methods, 
see Section 4.5.2, “Inserting Marker Occurrences” on page 99.
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This quick-start example covers only the keystroke method. In the previous 
procedure you defined the Chewing Artifact marker, which appears in the 
Markers window in the Name column and its associated key appears in the Key 
column as 5. If you press the 5 key, CinePlex Editor expects an operation with the 
Chewing Artifact marker.

The available marker operations appear in the Input window, which normally 
opens directly beneath the Markers window. The Keystroke radio buttons define 
the operations associated with pressing keys. The default selection is Find. If the 
5 key is pressed, CinePlex Editor finds the next occurrence of the Chewing 
Artifact marker. However, because no occurrences of the Chewing Artifact 
marker have been created, the 5 key currently has no effect. To create marker 
occurrences follow the procedure below.

1 In the Markers window, select the Chewing Artifact marker.

2 To arm CinePlex Editor to insert new marker occurrences when pressing the 5 
key, in the Input window at Keystroke, click Insert. 

3 Click Play, or press the SPACEBAR key.

4 Although interval markers are easier to insert while CinePlex Editor is playing, 
the default 1X playback speed can be too fast to insert markers precisely. 
Adjust the playback speed by selecting a slower setting from the speed 
droplist on the toolbar, for example, 1/8X.

5 To insert an occurrence of the Chewing Artifact marker, press the 5 key once 
to define the beginning of the interval and press the 5 key again to define the 
end of the interval. 

Note: You may use other CinePlex Editor capabilities to change marker 
occurrence intervals, so a convenient work method is to quickly insert 
placeholder marker occurrences, which can later be edited to set 
precise start and end times. This is discussed under .

6 Insert several more occurrences using the 5 key. As occurrences are entered, 
they appear in the ‘Chewing Artifact’ Marker Occurrences window. Each 
marker occurrence appears with the start and end times for each interval. 

Note: The Marker Occurrences default window is tall and narrow and it can 
obscure the complete window title. Move the mouse cursor over the 
title bar to see the complete title. Also, the title of this window 
changes to include the currently selected marker in single quotation 
marks. The information that appears in the window also changes for 
each marker type. For example, a Coordinate marker shows Time, X, 
and Y coordinates instead of Start Time and End Time. 

7 Click Pause. In the Edit Markers window next to Keystroke, click Find. 

8 Press the 5 key to advance to an occurrence of the Chewing Artifact marker. 
Press the 5 key several times to cycle through the intervals entered.

4.2.6 Saving and Exporting the Data

This procedure covers the steps required to save the marked up files from the 
quick-start example and to export the data for use in other applications. When 
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saving a project, CinePlex Editor saves all the marker information in the CPJ file. 
You may also export the marker data to:

• PLX file: The markers become Type 4 Events in the PLX file, along with the 
spike and continuous data from the original neural data file.

• NEX file: The markers become NEX variables, along with the spike times 
and continuous data from the original neural data file.

• Text file: Each marker occurrence becomes a line in the text file.

• CSV file: Each marker occurrence becomes a line in the CSV file.

Note: Text and CSV files can be opened in applications such as Excel or MATLAB for 
additional analysis. In an Excel spreadsheet, each marker occurrence 
becomes a row in the spreadsheet. In a MATLAB file, each marker occurrence 
becomes a row in a 2D matrix.

To save the project and export the data, follow the procedure below.

1 To save the quick-start example work, click Save. The Save As dialog box 
opens with the file name CM_Quickstart-01. Click Save to save 
CM_Quickstart-01.

Note: If you reload the same CPJ file just saved, the system puts CinePlex 
Editor back into the same state it was in prior to the save operation. 
CinePlex Editor reloads with the same markers, marker occurrences, 
current marker selection, etc.

2 For this quick-start example, export the data as a CSV file. From the File 
menu, select Export Markers. 

The Export Marker Data dialog box opens.

3 In the Format area, accept the default value Text file. The Export Marker 
Data dialog box includes various options for how, where, and what data to 
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export. However, for this quick-start example, accept the defaults values and 
click Export! 

The Export Complete dialog box appears.

4 Locate CM_Quickstart.txt. Open the file with Windows Notepad or another 
text reader to see how the data is exported.

4.2.7 Re-opening a Project File

This procedure covers the steps required to re-open a project file.

1 Exit and re-start CinePlex Editor. 

The Welcome To CinePlex Editor dialog box opens.

Note: The Welcome To CinePlex dialog box now contains an entry for the 
CM_Quickstart.cpj file in the recent projects list box. 

2 Double-click CM_Quickstart.cpj to open the quick-start example project.

CinePlex Editor opens in the same state that it was in when the project file 
was saved.

3 This completes the last procedure in the Quick-Start Example.
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4.3 Using the Activity Window

The Activity window displays data for markers and channels. If the Show 
checkbox for a marker or channel is selected, the Activity window displays the 
marker or channel. If you deselect a checkbox, the associated marker or channel 
is not displayed in the Activity window.

In the Activity window, CinePlex Editor provides two frequently-used items to 
display neural data—the time pointer and the time range. The time pointer 
represents the concept of a current instant. The frame in the Video window is the 
frame whose occurrence time is no later than the current time pointer and is the 
nearest frame on the left side of the current time pointer. The range of neural data 
in the Activity window is based on the time pointer. 

The inverted white triangle symbol in the Activity window depicts the current 
time:

The Activity window displays the current time in seconds (t), and the current 
frame number (F). The Activity window default setting positions the current time 
symbol at the center of the window, so that an equal span of time before and after 
the current time appears in the window. However, you may reposition the current 
time symbol by clicking and dragging it with the left mouse button. In this way, 
you may configure the Activity window to show an asymmetric span of time 
about the current time; for example, from 1 second before to 5 seconds after the 
current time.

In general, the time pointer may or may not point to the time of a video frame. 
The video frame that appears for a given current time is the frame at the latest 
time, which can be less than or equal to the current time. However, you may 
configure CinePlex Editor to lock the current time to the times of Frame Markers; 
see Lock to Video Frames in Section 4.7.5, “Repairing Tracking Coordinates” 
on page 141.

You may expand or contract the range of time that appears in the Activity 
window by clicking Zoom In or Zoom Out. You may also shift the current time 
by dragging the scroll bar at the bottom of the window.

You may also override the current time in a more persistent way by using the 
Find functions to change the current time to be that of a marker. For example, by 
clicking the Find Occurrences button, or from the Find menu, select Find 
Marker Occurrences..., which opens the Find Marker Occurrences dialog 
box.
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4.3.1 Understanding Looping

By default, CinePlex Editor starts in looping mode, where animation and 
searches that run past the end of the file restart from the beginning. To turn off 
looping mode, from the Looping menu, click Toggle Looping.

4.4 Customizing the User Interface

Although the default user interface setup in CinePlex Editor may be adequate for 
the needs, you may also customize the user interface. For details on customizing 
the user interface, see Appendix E‚ Navigating the Plexon User Interface.

Some general principles and conventions repeat throughout the CinePlex Editor 
user interface as well as the Plexon User Interface.

• Right-click Menus – See Section E.3.5, “Right-click Menus” on page 17.

• Current Selections – See “Current Selections” on page E-17. The currently 
selected marker and channel also appear in their selected color (bright violet 
by default) in the Activity window. 

• Keystroke Shortcuts – See “Keyboard Customization” on page E-19.

• Views – You may quickly close and re-open windows by using the View 
options or the corresponding toolbar buttons.

• Undo – See “Undo” on page E-17.

• Quick Reference – See “Help Menu” on page E-12.

4.5 Using Markers and Marker Occurrences

This section explains how to use markers and marker occurrences. Markers are 
designators that are used to identify or describe timepoints in a file. There can be 
several types of markers. Each marker type contains specifically-defined 
information. CinePlex Editor uses seven different marker types; for detailed 
descriptions of the content of each marker type, see “Marker Type” on page D-
72. A marker occurrence is a specific circumstance, or instance, where a marker 
appears. A marker can have multiple occurrences. Each marker occurrence 
contains unique information, which consists of a minimum of a timestamp and 
the other values defined by its marker type.

4.5.1 Defining Markers

To define a CinePlex Marker, designate it as one of the seven available CinePlex 
types defined in “Marker Type” on page D-72 and name it uniquely. You may add 
optional information to the definition such as comments, associated keystroke, 
display color, and associated event IDs. Follow the procedure below to define 
markers.
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1 On the Edit menu, click Define New Marker.

The Define New Marker dialog box appears.

Note: The F (Frame) marker is a special time-only marker applied 
automatically by CinePlex Studio to associate a time with each video 
frame. This marker always appears grayed out in the Define New 
Marker dialog box because it is system-generated.

2 In the Type area, click a marker type. 

3 In the Name box, type a unique name for the marker.

4 Add any additional items. For more information, see Section 4.2.4, “Defining a 
New Marker” on page 92.

5 Click OK.

The new marker appears as the selected marker in the list in the Markers 
window. You can select/deselect the Show checkbox to show/hide a particular 
marker in the Activity window on the CinePlex Editor main screen.

4.5.2 Inserting Marker Occurrences

There are three primary methods to insert new marker occurrences:

• Keystroke



100 CinePlex Behavioral Research System 

4 Processing Video Files with CinePlex Editor 

• Button 

• Left-Click (of the mouse button)

In the Input window, select an input method. For more information on the Input 
window, see “Input Window” on page D-17.

Note: You may also use items from the Edit menu to choose one these input 
methods to insert new marker occurrences. For more information, see “Edit 
Menu” on page D-38.

Keystroke

To use the keystroke method to insert marker occurrences, associate a key with 
each marker for which occurrences are created. When defining a marker, you 
typically associate a keystroke with it. The associated keystroke appears in the 
Key column of the Markers window. 

Note: If there is no associated key with the marker or to change the key association, 
from the right-click menu in the Markers window, click Edit Selected Marker to 
open the Edit Marker dialog box. For more information, see “Edit Selected 
Marker” on page D-40.

To insert marker occurrences using the keystroke method, follow the procedure 
below.

1 In the Input window, next to Keystroke click Insert.

Note: This arms CinePlex Editor to insert an occurrence of a marker at the 
current time when pressing the key associated with that marker. 

2 Use keystroke insertion when CinePlex Editor is paused or playing. Enter 
marker occurrences with keystrokes for each marker type as follows:

• For Time Only (T) markers – Press the associated key once to insert a 
single marker occurrence at the current time.

• For Interval (I) markers – Press the associated key once to start the 
interval. Press the key a second time to end the interval. 

• For Scalar (S) markers – The keystroke behavior for Scalar markers 
changes with the animation status as follows: 



CinePlex Behavioral Research System 

Version 3 101

• If paused – Open a Scalar window for the marker. Press the 
associated key and drag the mouse pointer in the Scalar window 
to set the value for the new occurrence. 

• If playing – Open a Scalar window for the marker. Press the 
associated key to pause the animation. Drag the mouse pointer in 
the Scalar window to set the value for the new occurrence.

• For Coordinate (C) markers - Press the associated key and move the 
mouse pointer in the Video window and click to enter the coordinate 
values. If it was playing before pressing the key, after clicking, CinePlex 
Editor enters the new marker occurrence, and resumes animation.

Note: Although you typically insert Level Interval (L) and Zone Interval (Z) markers 
automatically by using the Levels Editor and Zones Editor dialog boxes, 
you may also enter them with a keystroke.

Note: For Scalar and Coordinate markers, to use the keystroke or button method 
you must set the value of the Scalar or Coordinate marker occurrence by 
clicking the mouse in either the Scalar window or the Video window. For this 
reason, the left-click input method is better for entering Scalar or Coordinate 
marker occurrences. Also, it does not make sense to use the keystroke or 
button input methods unless the Scalar or Video windows are open.

Button Insertion

The Input window includes an associated button for each marker. Each button 
displays the marker name. CinePlex Editor automatically creates a button for 
each new marker defined. As you define new markers or reposition the Input 
window, the button palette rearranges itself. Follow the procedure below:

1 In the Input window, next to Button click Insert.

2 To insert a marker occurrence, in the Input window click the appropriate 
marker button. 

CinePlex Editor inserts the occurrence at the current time.

Note: With button insertion, each marker type behaves exactly the same as 
described in the preceding section for keystrokes.

Left-Click Insertion

The Left-Click insertion method is fundamentally different from the other 
insertion methods. Use the Left-Click method only to insert occurrences for the 
currently selected marker. 

Understanding Click-To-Add Mode

Click-To-Add mode is a semi-automatic subset of the Left-Click insertion 
method. In Click-To-Add mode, each time a marker is chosen and the left mouse 
button is clicked, CinePlex Editor inserts an occurrence of the marker and 
automatically advances the video by a preset number of frames. Two examples 
follow:

• Example 1: You watch each frame in the Video window and assign a Scalar 
value to some on-screen behavior, say a number between 1 and 10 for a rat's 



102 CinePlex Behavioral Research System 

4 Processing Video Files with CinePlex Editor 

activity level. To assign a range to the Scalar window, see “Scalar Right-click 
Menu” on page D-26. With each frame, left-click in the Scalar window to 
enter a Scalar marker occurrence with a value that corresponds to the location 
clicked in the Scalar window, at the time of the current video frame. After 
each left-click, CinePlex Editor automatically advances to the next frame or 
to the number of frames set. To set the number of frames, see Number of 
Frames to Advance During Click-To-Add in “General Tab” on page D-59. 

• Example 2: You watch each frame in the Video window and mark some 
position of interest, for example, the end of the rat's tail. With each frame, 
left-click in the Video window to enter a Coordinate marker occurrence with 
a value that corresponds to the location clicked in the Video window, at the 
time of the current video frame. After each left-click, CinePlex Editor 
automatically advances to the next frame or to the number of frames set. 

To insert marker occurrences with a mouse click, follow the procedure below.

1 In the Input window, next to Left-Click click Insert.

Note: This arms CinePlex Editor to insert an occurrence of a marker at the 
current time when clicking (left-click) the mouse. 

2 In the Markers window, click the marker for which to insert occurrences.

A >> appears in the left most column to designate the marker as the currently 
selected marker.

3 Use mouse click insertion when CinePlex Editor is paused or playing. Enter 
marker occurrences for each marker type as follows:

• For Time Only (T) markers – Click in the Activity window only, as follows, 
otherwise CinePlex Editor ignores the click. 

• If paused – Click anywhere in the window and the occurrence 
appears at the time corresponding to the pointer location. 

• If playing – Because the display typically moves too fast for 
precise insertion, click anywhere in the window and the 
occurrence appears at the current time. Keep the pointer over the 
Activity window while watching the video and click to insert each 
occurrence.

• For Interval (I) markers – Click in the Activity window only, as follows, 
otherwise CinePlex Editor ignores the click.

• If paused – Click once to mark the start of the interval. Click a 
second time to mark the end of the interval. You may enter the 
ends of the interval in either order, but CinePlex Editor always 
makes the earlier time the start time for the Interval marker 
occurrence. 

• If playing – Click once to mark the start of the interval. The start 
time appears at the current time and the interval expands. Click a 
second time to mark the end of the interval. The end also appears 
at the current time. You may keep the pointer over the Activity 



CinePlex Behavioral Research System 

Version 3 103

window while watching the video, then click to mark the start time 
and click again to mark the end time of each occurrence.

• For Scalar (S) markers – Click in the Scalar window only, as follows, 
otherwise CinePlex Editor ignores the click. 

• If paused – Click-To-Add mode activates; see “Understanding 
Click-To-Add Mode” on page 101. Click to insert a Scalar marker 
occurrence with a value (see Note that follows) that corresponds 
to the location clicked in the Scalar window, at the time of the 
current video frame. With this feature, you may enter a new Scalar 
occurrence on every nth frame and then use the Interpolate 
Missing Occurrences feature to fill in the skipped values; see 
“Understanding Click-To-Add Mode” on page 101.

Note:You must have the Scalar window configured correctly for 
the desired range of the Scalar value; see “Scalar Right-
click Menu” on page D-26.

• If playing – Click to insert an occurrence at the current time with a 
value that corresponds to the location clicked in the Scalar 
window. The animation does not pause.

• For Coordinate (C) markers – Click in the Video window only, as follows, 
otherwise CinePlex Editor ignores the click. 

• If paused – Click-To-Add mode activates; see “Understanding 
Click-To-Add Mode” on page 101. Click in the Video window to 
enter a Coordinate marker occurrence with a value that 
corresponds to the location clicked in the Video window, at the 
time of the current video frame. With this feature, you may enter a 
new Coordinate occurrence on every nth frame and then use the 
interpolate missing occurrences feature to fill in the skipped 
values; see “Interpolating missing occurrences” on page 113.

• If playing – Click to insert an occurrence at the current time with a 
value that corresponds to the location clicked in the Video window. 
The animation does not pause.

Note: The left-click method works for Level Interval and Zone Interval 
markers. However, in general you should automatically generate 
these marker types by using the Levels Editor and Zones Editor 
dialog boxes. See Section 4.6, “Using the Freezing Detector, Levels 
Editor and Zones Editor” on page 119.

4.5.3 Editing Markers and Marker Occurrences

This section includes a series of short procedures dealing with markers and 
marker occurrences. Each procedure uses the most-efficient primary method, but 
additional methods that can be used to accomplish the same task appear in 
parentheses after the primary one. Follow the procedure below to delete a 
selected marker.
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1 In the Markers window, select the marker to delete.

2 From the Markers window right-click menu, choose Delete Selected Marker 
(or from the Edit menu, choose Delete Selected Marker, or click the Delete 
Selected Marker button):

CinePlex Editor immediately deletes the selected marker and its marker 
occurrences. 

Note: CinePlex Editor provides no confirmation before it deletes the marker. 
However, to undo the deletion, from the Edit menu, click Undo.

Deleting all occurrences of a selected marker

1 In the Markers window, select the marker with the marker occurrences to 
delete.

2 From the Markers window right-click menu, choose Delete all Occurrences 
of Selected Marker (or from the Edit menu, choose Delete all Occurrences 
of Selected Marker, or click the Delete all Occurrences of Selected Marker 
button):

CinePlex Editor immediately deletes all marker occurrences for the selected 
marker. 

Note: CinePlex Editor does not delete the marker itself, but it removes all 
occurrences of the marker. CinePlex Editor provides no confirmation 
before it deletes the marker occurrences. However, to undo the 
deletion, from the Edit menu, click Undo.

Copying a selected marker

1 In the Markers window, select the marker to copy.

2 From the Markers window right-click menu, choose Make Copy of Selected 
Marker (or from the Edit menu, choose Make Copy of Selected Marker). An 
exact copy of the selected marker named Copy of <OldMarker> appears in 
the Markers window.

Note: The new marker has the same marker occurrences. However, the 
new marker gets new values for the associated key and for the Event 
ID(s), since those values need to be unique among the markers.
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Adding new marker occurrences

1 In the Marker Occurrences window, select the marker for the new occurrence.

2 From the Marker Occurrences window right-click menu, choose Add New 
Marker Occurrence (or from the Edit menu, choose Add New Marker 
Occurrence, or click the Add New Marker Occurrence button). The New 
Marker Occurrence dialog box for the selected marker opens.

Note: For more information on the New Marker Occurrence dialog box, 
see “Add New Marker Occurrence” on page D-41.

3 In the Time box, type a time in seconds for the marker occurrence. If the 
marker is a Coordinate marker, type the X and Y coordinates. Click OK.

Editing marker occurrences

1 In the Marker Occurrences window, select the marker occurrence to edit.

2 From the Marker Occurrences window right-click menu, choose Edit 
Selected Marker Occurrence (or from the Edit menu, choose Edit Selected 
Marker Occurrence, or click the Edit Marker Occurrence button):

The Edit Marker Occurrence dialog box opens.

Note: For more information on the Edit Marker Occurrence dialog box, 
see “Edit Selected Marker Occurrence” on page D-42.

3 In the Time and End Time boxes, type new times in seconds. If the marker 
type includes coordinates, change these as needed. Click OK.

Deleting selected marker occurrences

1 In the Marker Occurrences window, select a marker occurrence to delete.

Note: To delete more than one occurrence, see Step 3.

2 From the Marker Occurrences window right-click menu, choose Delete 
Selected Marker Occurrence (or from the Edit menu, choose Delete 
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Selected Marker Occurrence, or click the Delete Marker Occurrence 
button):

CinePlex Editor deletes the currently selected marker occurrence.

3 You may also select multiple occurrences to delete. To delete a currently 
selected marker occurrence plus all of the marker occurrences that are 
highlighted with a black background in the Marker Occurrences window, from 
the right-click menu choose Delete Highlighted Marker Occurrences.

CinePlex Editor immediately deletes all of the marker occurrences that are 
highlighted in the Marker Occurrences window.

Note: CinePlex Editor includes other right-click menu entries for selecting and 
copying text with marker occurrence information onto the Windows clipboard, 
which can be pasted into other applications.

4.5.4 Automatically Generating Marker Occurrences

CinePlex Editor can automatically generate marker occurrences. When you 
define a new marker using the Define New Marker dialog box (see Section 
4.2.4, “Defining a New Marker” on page 92), you may choose to have CinePlex 
Editor populate the new marker with algorithmically-generated marker 
occurrences. The available algorithms for generating marker occurrences depend 
on the marker type, which the following sections describe. 

Automatically generating Time-Only or Frame Marker occurrences

1 To automatically generate Time-Only or Frame Marker occurrences, in the 
Define New Marker dialog box, click T then click Generate Occurrences to 
open the Generate Marker Occurrences dialog box. 

2 To generate occurrences for this marker from the occurrences of another 
marker, click Generate from occurrences of another Marker. Otherwise, go 
to Step 4.

3 Select a marker from the drop-down list. Click OK. 

CinePlex Editor generates marker occurrences at the times of the 
occurrences of the marker selected in the drop list.
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4 To generate occurrences for this marker based on other criteria, click 
Generate based on. 

5 To generate regularly-spaced marker occurrences, in the Time of First 
Occurrence box type an offset from the beginning of the file.

6 To space the occurrences at intervals such that they occur at a specified rate, 
in the Occurrence Rate box, type the rate in occurrences per second. 

7 To specify the total number of marker occurrences to generate, in the 
Number to Generate box, type the total.

Note: Under some conditions, the New Project Wizard also displays the 
Generate Marker Occurrences dialog box so that the required frame 
marker occurrences can generate. The suggested values that appear 
in the Occurrence Rate and Number to Generate edit boxes when 
the dialog box first appears correspond to the frame rate and number 
of frames detected in the currently-loaded video data file. In most 
cases, simply click OK to generate appropriate frame marker 
occurrences.

Automatically generating Interval marker occurrences 

1 To automatically generate Interval marker occurrences, in the Define New 
Marker dialog box, click I, then click Generate Occurrences to open the 
Generate Interval Marker Occurrences dialog box. 

2 From the Generate Intervals that cover time spans drop-down list box, 
select one of the following algorithms to generate the intervals:

• Between Marker 1 and Marker 2 – If this algorithm is selected, go to 
Step 3.

• Around Marker 1 – If this algorithm is selected, go to Step 4.

• Between a time offset from Marker 1 and a time offset from Marker – 
If this algorithm is selected, go to Step 5.

• Defined by time ranges read in from a file – If this algorithm is selected, 
go to Step 6.
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3 Select entries in the Marker 1 and Marker 2 lists. Click OK. 

Intervals generate with a start time that corresponds to the occurrence times 
of the Marker 1 selection. The end time correspond to the first subsequent 
occurrence time of the Marker 2 selection. CinePlex Editor ignores additional 
occurrences of Marker 1 that occur before an ending Marker 2.

4 Select entries in the Marker 1 list. In the two Time Offset... boxes, enter time 
offsets TS and TE in seconds. Click OK.

Note: For every occurrence of Marker 1 at time t, an interval generates from 
time t + TS to time t + TE, where TS and TE are the time offsets 
entered in the first and second marker boxes respectively. TS and TE 
can be positive or negative.

5 Select entries in the Marker 1 and Marker 2 lists, and enter time offsets in the 
Time Offset... boxes. Offsets can be positive or negative. Click OK.

Note: This is a generalization of the first algorithm where the interval is 
offset in a fashion similar to the second algorithm from the exact times 
of the start and end marker occurrences.

6 In the Ranges File box, type or select a text file that contains the ranges. 
Click OK.

Note: The format of the text file is one range per line of text, with each line 
containing the start time and end time in seconds. The delimiter 
between the times can be a comma, a space, or a tab.

Automatically generating Scalar and Coordinate marker occurrences

• In the Define New Marker dialog box, if you select S (Scalar) or C 
(Coordinate) and click Generate Occurrences, CinePlex Editor just 
generates some fake, random data for testing and demonstration purposes. It 
has no usefulness in general.

Automatically generating Level Interval and Zone Interval marker 
occurrences

• In the Define New Marker dialog box, if you select L (Level Interval) or R 
(Zone Interval) and click Generate Occurrences, CinePlex Editor defines 
the new marker and then opens either the Levels Editor or Zones Editor 
dialog boxes. Use the editors to generate occurrences based on level 
crossings for Scalar markers, or Zone containment for Coordinate markers. 
For basic information, see Section 4.6, “Using the Freezing Detector, Levels 
Editor and Zones Editor” on page 119. For detailed information on the Levels 
Editor and Zones Editor, see “Levels Editor” on page D-47 and “Zones Editor” 
on page D-50.

4.5.5 Operating with Marker Occurrences

With CinePlex Editor, you may perform certain simple operations on marker 
occurrences. You can find, move, and delete occurrences. You may also shift, 
align and interpolate marker occurrences, and invalidate waveforms that occur 
either inside or outside of Interval marker occurrences.
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Finding Marker Occurrences

CinePlex Editor includes the following three ways to find marker occurrences:

• Keystroke

• Button

• Using the Find menu items or toolbar buttons

Finding marker occurrences with a keystroke

• In the Input window next to Keystroke, click Find. Press the key associated 
with the marker, which appears in the Key column of the Markers window.

CinePlex Editor advances the file in the Activity window to align the first 
occurrence of the marker with the current time triangle.

Finding marker occurrences with a button click

• In the Input window next to Button, click Find. In the Input window, click 
the button associated with the marker.

CinePlex Editor advances the file in the Activity window to align the first 
occurrence of the marker with the current time triangle.

For additional information on finding marker occurrences, see “Find Marker 
Occurrences” on page D-46.

Interval Operations

For Interval, Level Interval, or Zone Interval markers, you may invalidate spike 
waveforms inside or outside of the Intervals, or remove the occurrences of other 
markers that fall inside or outside of the intervals.

To use an Interval marker (see Section 4.2.4, “Defining a New Marker” on 
page 92) for operations, from the Tools menu, click Interval Operations to open 
the Interval Operations dialog box:

From the Interval Marker to Use list, choose one of the currently-defined 
Interval, Level Interval, or Zone Interval markers. 
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To mark as invalid each waveform (spike time) in every channel that falls inside 
the start and end times of all occurrences of the Interval marker, click Invalidate 
Waveforms that occur within the Intervals. This operation can be inverted; 
before doing so, see the cautionary note in this section.

If a marker occurrence falls inside a defined interval, you may remove that 
marker occurrence. To do so, click Remove Occurrences within the Intervals, 
for Marker, and choose a non-Interval marker from the second list. This 
operation may be inverted; before doing so, see the following cautionary note.

If you click Negate the selected operation, in the Interval Operations dialog 
box, the text in the Operation to Perform Using Interval Marker area changes 
as follows:

 

If you choose an operation and click Negate the selected operation, you either 
invalidate all waveforms that do not fall between the start and end times of any 
Interval occurrences or remove all occurrences of the selected marker that do not 
occur inside the time span any Interval marker occurrence. For more information 
on the Interval Operations dialog box, see “Interval Operations” on page D-52.

Shifting Marker Occurrences

You may add a constant offset, which can be negative, to all the timestamps of a 
marker. You may use this capability to align neural data files and video files. 

CAUTION
Negate inverts the selection for the entire file
If you click Negate the selected operation, the selection is logically 
inverted. This means you invalidate or remove all the items you did 
not select, which is the entire portion of the file outside the limits of 
the Interval occurrences.



CinePlex Behavioral Research System 

Version 3 111

Shifting marker occurrences

1 From the Tools menu, click Shift Marker Occurrences to open the Shift 
Marker Occurrences dialog box:

2 Choose a marker from the Marker list. 

Note: The first, last, and range of times covered by the occurrences of the 
chosen marker appear below the Marker list.

3 Choose one of the following methods for specifying the time shift:

• To shift marker occurrences by a fixed amount, in the Shift by box, enter 
the amount of the shift in seconds.

• To shift marker occurrences so that the first occurrence is at a specified 
time, enter the specified time in seconds in the Shift so that first 
Occurrence is at time box. CinePlex Editor applies this shift amount to 
all occurrences.

• To shift marker occurrences so that the first occurrence of a marker to 
shift is at the time of another marker occurrence, select the marker 
representing the time to shift to from the Shift so that first Occurrence 
is at time of Marker list, and enter the occurrence of the marker to use by 
typing its 1-based index in the Occurrence box.

4 Click OK to shift the marker occurrences and close the dialog box.

Snap-To Marker Occurrences

The Snap-To Marker Occurrences tool shifts all the occurrences of a marker to 
match up in time with the occurrences of another marker. 

Repositioning marker occurrences to align with others

1 From the Tools menu, choose Snap-To Marker Occurrences 

The Snap-To Marker Occurrences dialog box opens.
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2 From the Marker To Adjust list, choose the marker to match up in time. From 
the Snap-To Occurrences of Marker list, choose the marker representing 
the occurrences to match in time. 

Note: Typically, the entry in Marker To Adjust is the one to align with the 
times of the video frames and the entry in Snap-To Occurrences of 
Marker is a Frame marker. CinePlex Editor uses the following 
algorithm: For every occurrence of the entry in Marker To Adjust, 
CinePlex Editor finds the best match occurrence of the entry in Snap-
To Occurrences of Marker, and makes the occurrence time of the 
entry in Marker To Adjust equal to the time of the best match 
occurrence.

3 To determine the best match occurrence of the entry in Snap-To 
Occurrences Marker, click one of the following items:

• Snap-to Previous Occurrence: Click this item to use the occurrences 
that are positioned immediately before the times of the entry in Marker To 
Adjust. This adjustment always reduces the time of the occurrences 
being adjusted.

• Snap-to Next Occurrence: Click this item to use the occurrences that 
are positioned immediately after the times of the entry in Marker To 
Adjust. This adjustment always increases the time of the occurrences 
being adjusted.

• Snap-to Closest Occurrence: Click this item to use the occurrences that 
are closest in time the entry in Marker To Adjust. This adjustment can 
shift the occurrence being adjusted either direction in time.

4 If the entry in Marker to Adjust is an Interval-type marker, it consists of two 
times—a start time and an end time. To adjust the span, which can change 
the duration of the interval by making both the start and the end times snap to 
their respective best match occurrences, click Snap interval start and end 
times independently. To retain the span, which retains the duration of the 
interval by only making the start times snap to their best match occurrences 
and shifting the end times to match, click to clear the checkbox.

5 Click OK to adjust the occurrences and close the dialog box. A confirmation 
dialog box appears to display how many marker occurrences were moved. 
The result may be two or more markers with the same timestamp.
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Interpolating Missing Marker Occurrences

This tool is useful for adding entries in any gaps in marker occurrences. For 
example, when tracking some feature on the video by hand, you may enter 
tracking coordinates only for every nth frame, and then interpolate them to 
complete the remaining frames; this is a form of key-frame animation. Also, 
CinePlex Studio is occasionally unable to provide valid coordinates for some 
video frames, for example, when the headset cable for a rat occludes the LED 
being tracked. You may use this tool to complete tracking coordinates for every 
frame.

Interpolating missing occurrences

1 From the Tools menu, choose Interpolate Missing Occurrences.

The Interpolate Missing Occurrences dialog box opens.

Note: For detailed information on how the interpolation algorithm runs, see 
“How the Interpolation Algorithm Works” on page D-57.

2 In the Timestamp Determination area, choose one of the following items:

• Assume Periodicity: If the results in the Perodicity area indicate that 
the data is truly periodic enough so that filling in gaps by assuming a 
periodicity is valid, click this item. 

• Use Frame Marker Times: If there should be marker occurrences for the 
selected marker for every frame, click this item; this lets the frame 
markers—not the periodicity analysis—determine where missing marker 
occurrences appear.

3 In the Value Interpolation area, if the marker being interpolated is a Scalar 
marker or a Coordinates marker, choose one of the following methods to 
calculate reasonable values to give the added marker occurrences:

• Sample-and-hold the previous value – Click this item to assign the 
value or coordinates of the last pre-gap marker occurrence to the new 
marker occurrences that fill the gap. 
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• Linear Interpolation – Click this item to assign values to the new marker 
occurrences that fall on a line connecting the last pre-gap value or 
coordinates with the first post-gap value or coordinates.

4 To have CinePlex Editor define and populate a new marker to identify the 
marker occurrences that it generates through interpolation, click Generate 
new Time-only Marker at times for added Occurrences. Otherwise, click to 
clear the checkbox.

Note: If you choose this item, CinePlex Editor defines a new marker name 
“Interpolated X”, where X represents the name of the interpolated 
marker; this tags the occurrences that are not part of the original data.

5 Click OK to close the dialog box.

CinePlex Editor adds the new occurrences to the file and, if you chose the 
item in Step 4, adds an new row entitled “Interpolated __” to the list in the 
Activity window.

4.5.6 Selecting and Editing Marker Occurrences

To select a marker, in the Activity window, double-click on any marker time-line, 
or on the label for a marker. The label of the marker selected appears in the 
highlight color, which is violet by default.

In the Input window (see “Input Window” on page D-17), if you choose Select 
for the Left-Click input, a left click in the Activity window selects the nearest on-
screen marker occurrence for the selected marker. The selected marker 
occurrence appears with a white box around it:

If you select the end time interval, the white box appears around the end time tick 
mark and the interval line:

In the Marker Occurrences window, the newly selected marker occurrence 
appears with a > next it, and the window can scroll to position the newly selected 
marker occurrence near the top of the view. If the Activity window is in the mode 
where it is selecting the nearest marker occurrence, the mouse pointer becomes 
white crosshairs. 

In the Activity window, the status bar shows useful information about the 
selected marker and marker occurrence. The name of the selected marker appears 
and the 1-based index of the selected marker occurrence; for example, in the 
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following image idx indicates the 4th occurrence of this marker and t indicates its 
time in seconds:

In the Activity window, you may also drag selected marker occurrences to 
different times; this enables you to make minor adjustments to the positioning of 
marker occurrences. To drag a marker occurrence to a new time, hold down the 
SHIFT key, click the marker occurrence, and drag it to a new time. For Interval-
type markers, you may independently adjust the start and end times; for selection 
techniques, see the preceding paragraphs.

4.5.7 Entering or Editing Coordinate Markers 

In the Input window (see “Input Window” on page D-17), if you choose Insert 
for the Left-Click input and the selected marker is a Coordinate marker, you may 
enter or change coordinates by clicking in the Video window. If the Video 
window is in the mode where a left-click can change or add new Coordinate 
marker occurrences, the mouse pointer in the Video window changes to 
crosshairs and a line of text at the bottom of the window shows the current 
coordinates.

Because CinePlex Editor can enable only one marker occurrence for any given 
time, if you enter a new coordinate at the time of an existing marker occurrence, 
you effectively replace the existing coordinates. Thus, if the Coordinate marker 
occurrences occur at the same time as the Frame marker occurrences, you may 
touch up existing coordinates with a simple click on the new location. 

By default, the Click-To-Add feature (see “Left-Click Insertion” on page 101) 
automatically advances a number of frames, so if you continually click in the 
Video window you can quickly enter a sequence of coordinates on subsequent 
video frames.

4.5.8 Importing Markers

CinePlex Editor can import additional markers and marker occurrences from 
additional neural data files into an existing project. You may add neural data files 
to the project and process them as during the initial import of neural data when 
the project was first created (see Section 4.2.2, “Setting Up a New Project” on 
page 87). You may turn their events (from PLX files) or variables (from NEX 
files) into the appropriate markers and marker occurrences. 

To import markers, from the File menu, click Import Markers to open a 
Windows file selection dialog box for the neural data file. After selecting the file, 
click OK to import the data from that file as new markers. CinePlex Editor must 
have unique marker names, so if a marker name from the imported neural data 
files conflicts with an existing marker, CinePlex Editor renames the file by 
adding “_n” to the name, and increasing the number n until it establishes a unique 
name.
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4.5.9 Exporting Markers to text or CSV files

CinePlex Editor can export marker occurrences data in a tabular format to either a 
text file or comma-separated-values (CSV) file. Files in either of those formats 
can then be imported into other applications for data analysis. For example, a 
CSV file can be opened in MATLAB or Excel programs. 

Exporting makers as Text or CSV files

1 From the File menu, click Export Markers to open the Export Marker Data 
dialog box.

The Export Marker Data dialog box opens.

2 In the Format area, select the type of file to export. 

3 For all formats, CinePlex Editor exports one marker occurrence per row (or 
per line for text files), and all rows have the same number of columns. 

For Text file only: From the Delimiter to use between values list, select one 
of the following delimiters: Comma; Comma, Space; Space; Semicolon; or 
Tab. 

4 If you want the file to have a header row, click Export a Row of Column 
Headers. 
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5 In the Which Markers area, click Selected Marker only to export only the 
occurrences for the selected marker. To export the occurrences for all 
markers, click All Markers.

6 You may set the columns for each row in the What to Export for Each 
Marker Occurrence area. For more information on exporting marker data, 
see “Export Markers” on page D-32.

7 In the Output File area, in the File box, type or select the output file name. 

8 In the Output File area, click the Append if existing checkbox to append the 
marker data onto the end of a file that already exists on disk. Otherwise, 
CinePlex Editor overwrites the existing file.

9 Click Export! to create the file and close the dialog box. The Export 
Complete dialog box appears.

4.5.10 Exporting as a PLX File

CinePlex Editor can export marker occurrences data along with spike and 
continuous data read in from the original neural data file to a new PLX file.

Mapping Markers to Event IDs

When exporting to a PLX file, the marker occurrences in the project are 
represented as external events (type 4 data) in the output PLX file. There are two 
kinds of external events in the PLX file format:

1 Individual External Events – These events appear only by their Event ID, and 
each occurrence includes a timestamp only. There can be many different Indi-
vidual External Events (with different Event IDs) present in a PLX file. 

2 Strobed Events – These events appear only by a special Event ID, so only one 
strobed event can be in a PLX file. Each occurrence of a strobed event stores 
a timestamp plus a single 16-bit value, called the strobe code.

You must define a mapping between markers and Event IDs before CinePlex 
Editor can represent marker occurrences as external events.

Each marker for which the marker occurrences are to be exported to a PLX file 
must have its own unique Event ID. You may define or edit the Event IDs in the 
Define New Marker or New Marker Occurrence dialog boxes (see “Define 
New Marker” on page D-39 and “Add New Marker Occurrence” on page D-41), 
or you may change them in the Export To PLX dialog box (see “Export to PLX” 
on page D-36. 

CAUTION
Set the Append if existing checkbox correctly
Pay special attention to the Append if existing checkbox. 
If it is checked, the new marker data will be appended to the existing 
file.
If it is unchecked, the new export file will overwrite the current 
export file.
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The fact that individual external events do not have any data values associated 
with them means that only Time-Only, Frame, and Interval-type (Interval, Level 
Interval, or Zone Interval) markers can be represented by using individual 
external events. For Interval-type markers, specify two Event IDs, one to 
represent the start time of the interval and one to represent the end time.

Furthermore, the fact that a PLX file can only contain one kind of strobed events 
means that only a limited number of Scalar or Coordinates markers can 
simultaneously appear in a single PLX file. For example, if the strobed events in 
a PLX file are to represent all the occurrences of a certain Scalar marker, then 
there is no way to represent another scalar marker or any coordinates markers in 
the same PLX file. 

Because of the existence of the VideoTracker protocol, coordinates markers can 
be represented in a PLX file. Up to three coordinates markers can be represented 
using the VideoTracker protocol in a single PLX file, along with an additional 
scalar marker.

4.5.11 Exporting as a NEX File

CinePlex Editor can export marker occurrences data along with spike and 
continuous data read in from the original neural data file to a new NEX file. For 
information on mapping from markers to NEX variables, see “Export to NEX” on 
page D-37.
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4.6 Using the Freezing Detector, Levels Editor and Zones Editor

This section explains how to use the tools that CinePlex Editor provides for 

• Detecting animal freezing behavior—See Section 4.6.1, “Using the Freezing 
Detector” on page 119

• Identifying times during which a measured scalar parameter meets a specific 
user-defined level—See Section 4.6.2, “Using the Levels Editor” on 
page 130.

• Identifying times during which a specified coordinate marker entered and left 
a defined zone—See Section 4.6.3, “Using the Zones Editor” on page 134

4.6.1 Using the Freezing Detector

You can use the Freezing Detector in CinePlex Editor to detect animal “freezing” 
behavior and insert marker occurrences for each set of freezing episodes.

Understanding how the Freezing Detector works

An active, normally behaving animal might stop moving for a period of time 
(freeze) due to anxiety or fear or a specific stimulus. With the Freezing Detector 
function, you can define parameters that enable the system to detect and display 
periods of animal freezing behavior. You can average the Motion Measure, set the 
freezing threshold, span gaps between closely spaced events, then generate 
markers around the freezing episodes that result. Multiple sets of detected 
freezing episodes can be created with varying parameters, reviewed, modified if 
needed, and saved for future use in the CPJ project file.

Note: The Motion Measure is the normalized contour difference of the animal’s body 
computed on a frame-by-frame basis.The Freezing Detector averages 
(smooths) the Motion Measure data within a user-specified time window 
(Averaging Wnd parameter) and compares the averaged motion data to a 
user-specified threshold value and minimum freeze duration value. 

Note: Motion Measure data can be created during a CinePlex Studio recording (or re-
recording) session only with the Object Contour tracking method. See Section 
5.7, “Object Contour Tracking” on page 161 for information about this tracking 
method.

See also “Examples of Freezing Detector settings and results” on page 127 
following the procedure.
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Opening and using the Freezing Detector dialog box

1 To open the Freezing Detector dialog box, from the Tools menu, click 
Freezing Detector.

The Freezing Detector dialog box opens.
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2 In the Scalar Marker To Use menu, select the type of file you want the 
system to use to obtain the Motion Measure data. (See the image below.)

If the project file (CPJ file) that you created (see Section 4.1.1, “Creating a 
Project File” on page 84) includes an AVI and PLX pair, and if Motion 
Measure was recorded in the AVI file and sent to the PLX file, you can use the 
Motion Measure data from either of these files. (The Motion Measure data will 
be identical in these AVI and PLX files.) In this case, the Freezing Detector 
dialog box droplist displays these options as shown in the image below. 
Select AVI Motion or PLX Motion.

If the project file also includes a DVT file with Motion Measure data recorded, 
you can use the Motion Measure data from this DVT file. In this case, the 
Freezing Detector dialog box droplist displays all of these options as shown 
in the image below. Select AVI Motion, PLX Motion or DVT Motion.

Note: For the Freezing Detector function to be used, the AVI, DVT or PLX 
file you select must contain Motion Measure data, as explained earlier 
in this section.
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3 Click the Add button. The Define New Marker dialog box opens.

Note: The Type area of the dialog box (above) is grayed out because the 
system recognizes that you are creating a freezing episodes marker.

Every marker you create will automatically be displayed in the Markers and 
Input from Marker Selected windows. If you select the Show checkbox, the 
marker will be displayed in the Activity window also. 

4 Use the options in this dialog box to set parameters that affect how the system 
detects and displays data in the Freezing Detector dialog box:

• Name—Enter a name for this set of freezing markers, for example, 
Freezing Episodes #1.

• Comment—Optional text field.

• Associated Keystroke—A single letter that you will use if you want to 
manually create a freezing marker.

• Display—The color to associate with the freezing marker (for easier 
identification in the display), and a Show checkbox to specify whether the 
marker will be displayed in the Activity window.

• Event IDs—The start and end identifiers for each freezing episode.

5 Click OK.
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The new Freezing Episode appears in the Freezing Detector dialog box. 
A typical display is shown in the image below.

The Freezing Detector dialog box displays the following data:

• Black triangle in the left margin of the dialog box (see the red 
highlighting in the diagram, above)—Click on a row in the table to select it; 
the triangle in the left margin shows that the row is selected, and the 
graph displays the data for the selected row.

• Color—The user-specified color associated with the marker. You can 
change a color by clicking on it and selecting a new color from the 
droplist.

• Threshold value (in the table) and horizontal line (in the graphical 
display)—In the above image, the horizontal red line is set to the user-
defined threshold for Freezing Episodes #1. You can raise or lower this 
threshold by clicking and dragging the horizontal line with the PC mouse 
or by double clicking the Threshold value in the table and typing a new 
value.

Note: The image below shows an example of changing a parameter value 
by double clicking it and entering a new value. In this example, the 
user has entered a new value for the Averaging Wnd in the second 
row of the table:
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• Averaging Wnd (Window)—The time period, in seconds, over which the 
system averages the animal’s movement. You can change this value by 
double clicking the number in the table and typing a new value. The 
averaging calculation smooths the motion data during the specified time 
period. A larger window provides more smoothing effect than a smaller 
window. The Averaging Wnd size can be adjusted between 0.1 and 10.0 
seconds (default 0.5 seconds).

• Min Freeze Time—The minimum time duration that the animal’s 
movement must be less than the user-defined Threshold to be considered 
a freezing episode; if this time duration is exceeded, a freezing episode 
has occurred and the system generates a freezing marker instance. You 
can change this value by double clicking the number in the table and 
typing a new value. The Min Freeze Time can be adjusted between 0.1 
and 10.0 seconds (default 2.0 seconds).

• Show Original Data—If this checkbox is selected, the window displays 
the original motion measure data (the amount of positional change by the 
center of gravity of the animal from one video frame to the next) along 
with the averaged (smoothed) freezing measure data.

• Max Value and Min Value and graphical display—This area plots the 
freezing measure data and the original Motion Measure data (if the Show 
Original Data checkbox is selected). It also displays the maximum and 
minimum numerical values of the graphical data.

• Merge Episodes—If you select this checkbox, the system merges two 
freezing episodes into a single episode even if there is a short active gap 
between the freezing episodes (see Gap Sizes to Merge, below). You 
can select/deselect this checkbox by clicking on it.

• Gap Sizes to Merge (used only if the Merge Episodes checkbox is 
selected)—Specifies the active gap size, which is the time, in seconds, 
during which the animal’s averaged motion data can exceed the 
Threshold value between freezing episodes and still identify the two 
freezing episodes as a single merged episode. You can change this value 
by double clicking the number in the table and typing a new value. The 
gap size can be adjusted between 0.1 and 10.0 seconds (default 0.2 
seconds).
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• Add button—Opens the Define New Marker dialog box, which allows 
you to add another Freezing Episodes marker.

• Delete button—Deletes the selected row in the table.

• Center Level button—Changes the Threshold value to the average of the 
Max Value and Min Value of the plotted data. In the first image below, the 
Show Original Data checkbox is selected, and the Center Level line 
shows the mean of the Min Value and Max Value for the original data. In 
the second image, the checkbox is deselected and only the averaged 
data for the selected row is plotted; in this case, the Center Level line 
shows the mean of the Min Value and Max Value for the averaged 
(smoothed) data.
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Generating new Freezing Episodes results in the Activity window

6 Click the Generate for All Levels or Generate for Selected Level button to 
generate new freezing marker occurrences in the Activity window.

The Generate for All Levels button generates new results for all freezing 
episodes rows in the table. The Generate for Selected Level button 
generates new results only for the selected freezing episodes row in the table 
(that is, the row with the triangle appearing in the left margin of the row).
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Examples of Freezing Detector settings and results

The two images below show the same data. In the first image, the Show 
Original Data checkbox is selected; in the second image, it is not selected:
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The images below show two sets of freezing calculations for the same data. 
For Episodes #1, Averaging Wnd is set to 0.50 second; for Episodes #2 it is 
set to 8.00 seconds. Note that the averaged (smoothed) data is different for 
these two cases, even though the original motion data is the same:
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The first image below shows two sets of freezing episodes for the same data. 
For Episodes #1, the Min Freezing Time is set to 2 seconds; for Episodes #2 
it is set to 6 seconds. The second image shows a portion of the Activity 
window after the Generate for All Levels button is pushed. Note that freezing 
episodes with a shorter freeze time (< 6 seconds) are marked only for the 
Episodes #1 function (red) line, not the Episodes #2 function (green line):
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4.6.2 Using the Levels Editor

You can use the Levels Editor to define Level Interval markers and insert marker 
occurrences for them. Level Interval marker occurrences indicate the time 
intervals during which the values of a Scalar marker satisfied some condition. 
You may use the Levels Editor to set up the conditions, apply the conditions to a 
specific Scalar marker, and generate occurrences of the selected Level Interval 
marker or markers.

Level Interval markers are like Interval markers, but they are extended to store 
additional information that defines a condition. This additional information 
appears with the Level Interval marker definition in the CPJ file. The occurrence 
of a Level Interval marker is always tied to the values of the occurrence of a 
Scalar marker.

For the examples in this section, the Motion Scalar marker is used, but you can 
use the Level Interval marker with any Scalar marker.

To use the Levels Editor

1 On the Tools menu, click Levels Editor or click the Edit Levels button on the 
toolbar.

The Levels Editor dialog box opens.

2 To define a new Level Interval marker, click Add. 

The Define New Marker dialog box (see “Define New Marker” on page D-39) 
opens to enable you to customize the general properties of the new Level 
Interval marker. 
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3 Define the new marker and click OK to close the Define New Marker dialog 
box.

 A new row appears in the Level Intervals box.

4 Double click on the parameters in the table to specify the levels you want for 
this marker. (The parameters become editable when you double click on 
them.) 

For each Level Interval, you can specify either a one-level or two-level setting. 
When one level is used, N/A appears in the Oper field. When two levels are 
used, a logical operator is placed between the two levels (AND or OR is 
selected in the Oper field). 
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In this example, a marker will be generated when the actual value of the 
animal’s motion is above 151.

In this example, a marker will be generated when the actual value of the 
animal’s motion is between 151 and 297.
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5 You can define additional Level Interval markers by following the same 
procedure as in Step 2 through Step 4. In the following example, two different 
Level Interval markers are specified. The graph displays the levels for the 
row that is selected in the table.

Generating new Level Intervals results in the Activity window

6 Click the Generate for All Levels or Generate for Selected Level button to 
generate new Level Interval marker occurrences in the Activity window.

The Generate for All Levels button generates new results for all Level 
Interval rows in the table. The Generate for Selected Level button generates 
new results only for the selected Level Interval row in the table (that is, the 
row with the triangle appearing in the left margin of the row).
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4.6.3 Using the Zones Editor

You may use the Zones Editor to define Zone Interval markers and generate 
marker occurrences for them. To open the Zones Editor dialog box, on the Tools 
menu, click Zones Editor (or click the Edit Zones button on the toolbar):

Zone Interval Markers

Zone Interval marker occurrences indicate the time intervals during which a 
Coordinate marker occurrence remains inside a Zone that is defined. You may use 
the Zones Editor dialog box to define the Zones, to search for the times when the 
specified Coordinate marker entered and left the defined Zones, and generate 
Zone Interval marker occurrences.

Zone Interval markers are Interval markers, but they are extended to store 
additional information that defines a Zone. This additional information appears 
with the Zone Interval marker definition in the CPJ file. A Zone is an ordered list 
of coordinates that are connected with line segments, to form a closed Zone. Zone 
Interval marker occurrences are always tied to the values of the occurrence of a 
Coordinates marker.

The coordinate system for all Coordinate markers, and therefore also for all Zone 
definitions, range from (0,0) to (1023,767), with (0,0) representing the lower left 
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corner of the image. If the video resolution is other than 1024x768, which is 
usually the case, the coordinates are linearly mapped onto the video.

To use the Zones Editor

1 On the Tools menu, click Zones Editor.

The Zones Editor dialog box opens.

2 To define a new Zone Interval marker, under the Zone Intervals area click 
Add. 

The Define New Marker dialog box (see “Define New Marker” on page D-39) 
opens to enable you to customize the general properties of the new Zone 
Interval marker. 

3 Define the new marker and click OK to close the Define New Marker dialog 
box.

 A new row appears in the Zone Intervals box.

Note: Immediately after you create a new Zone Interval marker, Zones 
Editor enables you to click in the video window to set the X and Y 
Coordinates of the Selected Zone. The box directly above the video 
then contains this text:

Left-Click on the view to add a new coordinate; Right-Click to end

4 Move the mouse pointer into the Zones Editor video area. 

The mouse pointer changes to crosshairs and the current pointer location 
coordinates appear under X and Y in the Coordinates of the Selected Zone 
area. 
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5 Move the pointer to the desired location for the first coordinates of the 
selected Zone. Click to add the first coordinates. 

The first set of coordinates appear as line 1 in the Coordinates of the 
Selected Zone box and line 2 indicates the current pointer position. 

Note: As you move the mouse pointer, a line follows it from the first 
coordinates to its current location. The current location always 
appears as a small circle with a white interior. 

6 Move the pointer to the desired location and click again to add the second set 
of coordinates, and so on. Stop entering coordinates when the next set would 
be the starting point. 

7 Click the right mouse button.

The Zones Editor automatically closes the Zone by making the last coordinate 
the same as the first coordinate.

You may select a point at a vertex of a selected Zone Interval by clicking on a line 
in the Coordinates of the Selected Zone box. The point you select appears with 
a >> in the leftmost column box and as a small circle with a white interior in the 
video area.

After you have defined the Zones, you may generate Marker occurrences just for 
the selected Zone Interval marker, or for all Zone Interval markers by clicking 
Generate Selected or Generate All.
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4.7 CinePlex Editor How-Tos

This section contains suggested procedures for several common operations in 
CinePlex Editor. These procedures are by no means meant to be an exhaustive list 
of what can be done with CinePlex Editor, nor are they intended to be a 
presentation of the only possible way to achieve any desired end result.

Note: The following procedures assume a project has already been created and that 
it is currently open. For details on how to create CinePlex projects, see Section 
4.2.2, “Setting Up a New Project” on page 87.

4.7.1 Printing

Several windows in CinePlex Editor support rudimentary printing. To print a 
specific window, click in the window so the title bar is highlighted. If the window 
supports printing, the Print and Print Preview items on the File menu are 
available. The Input and Scalar windows do not support printing.

4.7.2 Denoting Interesting Behavior In the Video

A basic use for CinePlex Editor is to introduce a new marker occurrence into the 
data each time an animal or other subject in the video performs an action that is of 
interest in an experiment. For example, perhaps a neuron is suspected to be 
associated with a rat deciding to get a drink of water. You might test this 
hypothesis by introducing a time marker into the data whenever the rat drinks his 
first sip of water, as shown by the video. Then it would be desirable to perform a 
peri-event analysis against this new event in NeuroExplorer® to see if any 
neurons are associated with the first sip.

The procedural approach here is to define a new Time-only marker in CinePlex 
Editor, then enter marker occurrences whenever the rat starts to sip water. 
Initially, we rough in all the marker occurrences during one continuous pass 
through the video, then we go back and adjust each marker occurrence to be as 
accurate as possible. Then this information is saved to a NEX file, from which we 
can easily load it into NeuroExplorer for analysis.

Denoting interesting behavior in the video

1 Define a new Time-only marker as described in Section 4.2.4, “Defining a 
New Marker” on page 92. Label it “First Sip.” Assign a keystroke to it that is 
easy to press quickly.

2 Click Play. Adjust the Faster and Slower settings to a comfortable speed to 
view the video, which balances the desire to get through the video quickly 
against the risk of missing the behavior should it occur too quickly to spot. 

3 Use the Zoom In and Zoom Out buttons at the bottom of the Activity window 
to adjust the time range such that, should the sip behavior be spotted in the 
video view, a key on the keyboard can be hit before the time of the first sip 
scrolls out of the Activity window.

4 In the Input window, at Keystroke, click Insert (You could just as easily use 
the Left-click or Button input methods here.). CinePlex Editor is now armed 
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to enter new occurrences of the new marker when pressing that marker's 
associated key.

5 Click Rewind. Click Play. Position a finger over the associated keystroke for 
the “First Sip” event.

6 When the sip behavior is observed, quickly press the key associated with the 
“First Sip” marker. Accuracy is not important at this point; fine-tuning will come 
later. Go through the entire video.

7 Now, lets go back through and adjust the time of the “First Sip” marker 
occurrences to be more accurate. We will use the Find function to quickly 
locate our marker occurrences. In the Input window, after Keystroke, click 
Find.

8 Rewind the video file, then press the assigned key for the “First Sip” marker. 
This causes the system to jump to the first marker occurrence. Use the left 
and right arrow keys on the keyboard to look at each frame of the video to 
decide where the sip actually occurs. 

9 In the Activity window, drag the marker occurrences to the correct time. To do 
so, press and hold the SHIFT key, then click near the tick mark for the marker 
occurrence. Drag the tick mark to the desired time and release the mouse 
button.

10 To save the data, on the File menu, click Export to NEX, and if desired, 
select the appropriate What to Export checkboxes. Click Export! to write the 
file.

4.7.3 Invalidating Artifact Waveforms

Artifact waveforms can occur, for example, because a rat rapidly shakes its head. 
This behavior can easily be spotted in the video view, and it generally produces a 
cluster of spikes and large voltage deviations in a continuous data channel. It is 
desirable to invalidate all spike waveforms that occur during each head-shaking 
episode, and save the data to a new PLX file that does not contain those 
invalidated waveforms. This file can then be loaded into Offline Sorter™ and 
sorted.

The procedural approach here is to define a new Interval marker, whose 
occurrences start and end when the head-shaking episodes start and end. We then 
use this Interval marker to invalidate the spike waveforms that occur within the 
head-shaking episodes. We then save the data to a new PLX file minus the 
invalidated spike waveforms.

Invalidating artifact waveforms

1 Define a new Interval marker (see Section 4.2.4, “Defining a New Marker” on 
page 92). Label it “Head Shake”. Make sure that the new marker is the 
currently-selected marker.

2 In the Channels window (see “Channels Window” on page D-17), click Show 
for the spike and continuous channels that are the best indicators of when this 
artifact occurs, which makes them appear in the Activity window. 

3 Use the Zoom Out button at the bottom of the Activity window to expand the 
time range as much as possible, which helps to examine the file quickly. 
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However, do not expand the range so far that the artifact cannot be spotted 
should it occur. 

4 In the Input window, at Left-Click, click Insert (Or use the Left-click or 
Button input methods here). CinePlex Editor is now armed to enter new 
occurrences of the new marker when pressing that marker's associated key.

5 Starting at the beginning of the file, click Play. If it doesn't make the behavior 
too difficult to spot as it scrolls by, increase the speed of the playback so that 
the file can be reviewed quickly.

6 When the head shake behavior is observed, quickly press SPACEBAR to 
pause the playback. Use the left and right arrows to single-step the frames to 
verify the head shake and decide when the head shake behavior begins and 
ends.

7 In the Activity window, left-click at the starting and ending times of the head 
shake episode. This inserts new marker occurrences of the “Head Shake” 
marker.

8 Press SPACEBAR to resume playing. Repeat Steps 6, 7, and 8 for each head 
shaking episode until the end of the file is reached.

9 From the Tools menu, click Interval Operations. Select the “Head Shake” 
marker from the Interval Marker to Use list. Click Invalidate Waveforms 
that occur within the Intervals. Click OK. 

10 Now all of the spikes that occur within the head shake episodes have been 
invalidated. To hide invalidated spikes in the Activity window, open the right-
click menu and click Hide Invalidated Spikes.

11 To save the data, from the File menu, click Export to PLX. Verify that the 
Export invalidated spikes checkbox is clear (the default). If desired, check 
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or clear the Write? checkboxes for any markers that should be exported or 
not exported into the new PLX file. Click Export! to write the file.

4.7.4 Entering Tracker Coordinates

Suppose that it is desirable to track the movement of some subtle feature on the 
video image. Something that CinePlex Studio cannot track automatically, like the 
position of the tip of a rat's tail.

The procedural approach here is to define a new Coordinates marker, and use the 
Video window to enter—by mouse click—the coordinates that populate the new 
marker. Then, you can use the Interpolate Missing Occurrences tool to fill in 
the in-between frames.

Entering tracking coordinates

1 Define a new Coordinates marker (see Section 4.2.4, “Defining a New 
Marker” on page 92). Label it “Tail Position”.

2 In the Input window, after Left-Click, click Insert. CinePlex Editor is now 
“armed” to create a new occurrence of the “Tail Position” marker whenever 
clicking in the Video window.

3 Decide how often coordinates need to be entered. The default case is to enter 
a Coordinates maker occurrence for each and every video frame. However, 
this means that the video must be advanced frame-by-frame, which can take 
a long time to do the tracking for an entire experimental run. If less accuracy is 
acceptable, it is possible to configure CinePlex Editor automatically to 
advance N video frames each time a coordinated is entered by clicking. This 
means that a “Tail Position” coordinate is entered only every Nth frame, but 
transversing the file occurs N times faster. From the Tools menu, select 
Options, and click the General tab in the Options dialog box. Type the value 
of N into the Number of Frames to Advance During Click-To-Add edit box. 
The default is N = 1, which enters a coordinate for every video frame.

4 Click Play, then Pause, then Rewind to return to the beginning of the file. 
This ensures that CinePlex Editor is ready to take new coordinates.

5 In the Video window, click at the position of the tip of the rat's tail. CinePlex 
Editor enters a new marker occurrence, and advances N video frames.

6 Repeat Step 5 until all the data needed has been gathered.

7 When finished, in the Input window, at Left-Click, click Select to “disarm” 
CinePlex Editor.

8 It is possible to generate automatically new “Tail Position” marker occurrences 
for the skipped frames by interpolating the coordinates between the ones 
entered. This is similar to “key-frame” animation techniques. CinePlex Editor 
interpolates the coordinates mathematically with no regard for the video 
images—the interpolated positions may or may not match the actual 
positions of the rat's tail on the skipped video frames. To perform this 
operation, from the Tools menu, select Interpolate Missing Occurrences; 
for more information, see “Interpolating missing occurrences” on page 113. 
From the Marker list, select Tail Position. Because we want coordinates for 
every frame, in the Timestamp Determination area, click Use Frame 
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Marker Times. Click OK to close the dialog box and enter the tracking 
coordinates.

4.7.5 Repairing Tracking Coordinates

Suppose that CinePlex Studio is used to track an LED mounted to the headstage 
on a rat. Occasionally, the cable from the headstage can get between the LED and 
the camera, so the position data for the LED is missing in some frames. Or, 
suppose something caused the tracker to produce bad coordinates for a few 
frames, possibly caused by some light leaking into the experimental setup that 
confused the tracking algorithms.

In either case, the procedural approach is to put CinePlex Editor into a state 
where the video is advanced frame-by-frame and enter new or replacement 
tracker coordinates by clicking in the Video window at the desired location. 

Repairing tracking coordinates

1 In the Markers window, select the Coordinates marker to repair. Click Show. 
To minimize confusion during the procedure, clear Show for other Coordinate 
markers (if present).

2 For the following procedure to work, the Coordinates markers must be aligned 
to the Frame marker times by using the Snap-to Marker Occurrences dialog 
box, for more information, see “Snap-To Marker Occurrences” on page 111. 
Follow the procedure outlined in that section to align the Coordinate markers 
to the Frame markers.

3 Locate a section of time that has bad or missing values for the selected 
Coordinate marker that needs to be repaired. Pause the playback at the first 
frame with bad or missing coordinates.

4 From the Tools menu, click Options, and in the Options dialog box click the 
General tab. Make sure that the selection in the Number of Frames to 
Advance During Click-To-Add box is 1 (the default). Also, from the Animate 
menu, select Lock To Video Frames.

5 In the Input window, at Left-Click, click Insert. This “arms” CinePlex Editor 
to enter new (or replace existing) marker occurrences when clicking the left 
mouse button in the Video window.

6 Position the mouse cursor where the new (or replacement) coordinate needs 
to be and click.

The position is entered (or updated) and the video automatically advances by 
one frame.

7 Repeat Step 6 until all the coordinates are entered or repaired. Move the file 
forward to the next episode of bad tracking coordinates and repeat.

8 When finished, from the File menu, click Save. You may save and export the 
new or updated positions like any other marker data.

4.7.6 Simple Place Cell Analysis

Suppose it is suspected that a certain neuron seems to fire only when the rat is in 
his nest. As a procedural approach to test this hypothesis, a new Zone Interval 
marker could be defined that defines the boundaries of the rat's nest. The 
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generated occurrences of this marker represent the intervals during which the rat 
was in its nest. NeuroExplorer could then be used to search for correlations 
between neural firing rates and this interval.

1 Advance the video until a frame shows where the outline of the desired Zone 
(the nest) is clearly visible.

2 Define a new Zone Interval marker (see Section 4.5.1, “Defining Markers” on 
page 98). Label it “Rat In Nest”. In the Define New Marker dialog box, click 
Generate Occurrences to open the Zones Editor dialog box (see “Zones 
Editor” on page D-50).

3 In the Coordinates of the Selected Zone area, click Add and then click the 
left mouse button repeatedly in the video window in order to define the outline 
of the nest. Before completely closing the contour, click the right mouse 
button, which closes the contour.

4 In the Coordinates Marker to use list, select the appropriate Coordinates 
marker, and click Generate Selected. This generates occurrences of the new 
“Rat In Nest” marker. Click Done to close the Zones Editor dialog box.

5 To inspect the “Rat In Nest” intervals, use the Find Marker Occurrences 
dialog box (see Section 4.5.5, “Operating with Marker Occurrences” on 
page 108) to quickly advance through all the occurrences of the “Rat In Nest” 
marker. It is also possible to use the Marker Occurrences window to remove 
any undesirable “Rat In Nest” occurrences.

6 From the File menu, click Export to NEX (see Section 4.7.2, “Denoting 
Interesting Behavior In the Video” on page 137) to write the data to a NEX file 
for subsequent analysis. The “Rat In Nest” marker shows up as an interval 
variable in NeuroExplorer.



Plexon Inc

CinePlex Behavioral Research System Version 3 143

Chapter 5 
Recording Positional Data with CinePlex 
Tracking Option

5.1 Introduction to the CinePlex Tracking Option ...................................................... 144

5.2 Setting Up Cameras and the User Interface ....................................................... 146

5.3 Navigating the Studio Main Window.................................................................... 146

5.4 Understanding Tracking Windows and Arenas ................................................... 147

5.5 Defining the Arenas............................................................................................. 152

5.6 Selecting the Tracking Mode and Tracking Settings ........................................... 156

5.7 Object Contour Tracking...................................................................................... 161

5.8 LEDs In Darkness with LED Tracking ................................................................. 176

5.9 LEDs In Darkness or Light with Extended Tracking of Color Markers Mode....... 180

5.10 Extended Tracking of Color Markers In Light .................................................... 181

5.11 Tracking Color Markers (Legacy Capability)...................................................... 187

5.12 Calibrating the Arena Dimensions..................................................................... 194

5.13 Recording Synchronized Video Tracking and Neural Data ............................... 194

5.14 Monitoring the Video During a Recording Session............................................ 202

5.15 Recording Video without Neural Data (Used for Animal Training)..................... 202

5.16 Video Playback and Rerecording In Studio Files (Offline) Mode....................... 203

5.17 Additional File-processing Tools........................................................................ 203

5.18 Using the Extractor............................................................................................ 203

 



144 CinePlex Behavioral Research System 

5 Recording Positional Data with CinePlex Tracking Option 

5.1 Introduction to the CinePlex Tracking Option

This chapter describes the CinePlex® System Tracking Option, the experimental 
applications for which it can be used, and how to use it. The Tracking Option 
extends the capabilities of CinePlex Studio by enabling the computation and 
recording of positional data. The Tracking Option requires the CPT V3 license in 
addition to the CPX V3 (Studio/Editor) license.

The general procedure for using the Tracking Option is:

1 Position the camera(s) so that the desired physical experiment area is within 
the field of view of the camera

2 Define the shape of the arena for each camera

3 Select the tracking mode to be used - Object Contour, LEDs, Color 
Markers, or Extended Tracking of Color Markers

4 Set the parameters for the selected tracking mode

5 Perform a calibration of the dimensions in the arena

6 Set the location where the recorded files will be saved

7 Save the settings and layout

8 Synchronize the CinePlex and OmniPlex® Systems for recording

9 Start recording from the OmniPlex System

10 Stop recording at the OmniPlex System

11 If desired, retrack coordinate data in CinePlex Studio offline mode

12 If desired, rerecord synchronized files with CinePlex Editor

You can configure CinePlex Studio to capture video only (Audio Video 
Interleaved [AVI] files), track positions only (digital video tracking [DVT] files), 
capture video and track positions simultaneously, or create no files.

The tracking function can also be used in offline mode with existing pre-recorded 
files. In offline mode the tracking parameters can be set to values that are 
different than those used during the original recording, if any, and the system will 
retrack the video based on the new settings (see Section 5.16, “Video Playback 
and Rerecording In Studio Files (Offline) Mode” on page 203).

The CinePlex Studio default window layout will be sufficient for most instances. 
However, to load, change or save a window layout, see Appendix E-Navigating 
the Plexon User Interface.

Use the flowchart below to choose the concepts and procedures in this chapter 
that apply to your experiment.
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5.2 Setting Up Cameras and the User Interface

The procedures for setting up cameras and the user interface are the same as those 
used for the Tracking Option. See Chapter 3, Recording Video with CinePlex 
Studio.

5.3 Navigating the Studio Main Window

See the section Section 3.2, “Navigating the Studio Main Window” on page 29 
for a basic description of the Studio main window, where you can view and 
modify CinePlex Studio settings before starting the recording session. 

When the Tracking Option is present, there are additional toolbar options and 
panes, as shown in the image below.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.
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5.4 Understanding Tracking Windows and Arenas

This section explains how the CinePlex System manages the video processing 
load by using system-generated tracking windows and user-defined arenas.

5.4.1 System-generated Tracking Windows

The system generates tracking windows to limit the processing and analysis of 
video data to a small portion of the video image, typically to the body contour of 
the animal or the color markers or LEDs mounted on the animal. This reduces the 
overall CPU load and allows tracking more colors. Tracking windows also reduce 
problems with unwanted parasite objects (for example, reflections). 

Tracking windows are displayed as yellow rectangles in the video display, as 
shown in the image below.

Tracking windows can be made to appear by selecting the Tracking Window 
checkbox in the Visualization area of the Tracking pane, as shown in the image 
below.

Note: In Object Contour mode, the area will be labeled Whole Body Visualization. In 
LED mode, it is labeled LED Visualization, and in Color Markers mode it is 
Marker Visualization.
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The system automatically sets the size of the tracking window to cover the whole 
object. Each object (whole animal, LED, or marker) has its own tracking window. 
The tracking window is repositioned automatically. A history of an object’s 
movement is used to predict its next position. If the object disappears because of 
occlusion by a cable or other means, its tracking window is moved according to 
the speed and movement direction in its most recently detected frames. If the 
system is tracking multiple LEDs or markers in single animal mode, the system 
will also use the positions of the found LEDs or markers to predict the position of 
the one that disappeared. If the object is not found after a certain number of 
frames, the size of the tracking window will be increased. If the object is not 
found within two seconds, the system switches to search in the whole frame (or 
within the arena, if an arena shape has been defined).

5.4.2 User-defined Arenas

You can define an arena for each camera image. Arenas reduce problems with 
unwanted reflections and parasite objects outside of the working area.

For accurate tracking, you should ensure that the ratio of the object size to the 
arena size is such that the system will be able to track the object. If the ratio is too 
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small (image size of the object less than a few pixels) the system will not be able 
to distinguish the object from noise. If the ratio is too large (more than 1/4 of the 
video image) the system will not track the object.

Using the tools provided by CinePlex Studio and the Tracking Option, you can 
draw an outline of the experimental arena over the video image. Once this outline 
is drawn, Studio ignores objects outside of the arena when processing the images. 
This results in lower CPU usage and reduces false object detections due to 
reflections and shadows. It also allows the experimenter to exclude areas of the 
image that have no relevance to the experiment. Arena tools allow drawing 
circles, ellipses, rectangles, and freehand objects. Arena logical operations 
(AND, OR, NOT, XOR) allow combining multiple arena shapes to produce a 
single complex arena shape.

Example - Using Arenas to Exclude Reflections 

The following drawings show two examples of arenas (red rectangles) - one for 
LED tracking mode and one for Object Contour tracking mode. In each case, the 
reflections outside the arena are ignored by the CinePlex System.
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Example - Using Arenas to Exclude Background Objects or Colors 

If a background object (or background color) might interfere with the tracking 
function, the object (or color) can be removed from the arena. This will allow the 
system to track the animal correctly. 

This image shows an animal to be tracked along with a background object of 
approximately the same color. The background object is larger than the animal 
and the system is tracking the background object (the red cross hair is centered on 
the object and the tracking window [yellow rectangle] is surrounding the object). 

To avoid this situation, the experimenter can use one or both of the following 
tools:

• Define a specific arena shape in which to track

• Use background subtraction (discussed elsewhere in this chapter)
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This image shows a defined arena (in green) that the system will use to track the 
animal. The arena excludes the background object, therefore the system will 
never lock onto the object by mistake.

Modifying Arenas In Offline Mode

If you transfer an AVI file to an offline analysis computer on which CinePlex 
Studio is installed, that file can be retracked with new or changed arenas.

Note: The standalone computer must have minimum memory, processor 
and instruction set to run CinePlex Studio efficiently. These 
requirements for offline operation are CinePlex Version 3 software 
and a license key that enables the desired capability. However, it is 
important to determine that the computer on which the installation will 
be done meets the minimum system requirements. In general, this 
means a computer has a dual core Intel processor operating at better 

than 3 GHz with 3 GB of memory, and an NVIDIA® GeForce® 9600 
GT or better video card. Requirements that are more current are 
available from Plexon support (support@plexon.com).
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5.5 Defining the Arenas

This section explains how to define an arena for each camera, beginning with 
Camera 1. One arena is allowed per camera.

Adding the Arena for Camera 1

1 In the Scenes tab for Camera 1, click the Add arena (+) button.

A Scenes settings pane is displayed, and the toolbar now displays active 
icons for shapes and logical operators. 

Note: If additional CinePlex System options (for example, CinePlex Basic 
Behavior Option and/or CinePlex 3D Option) are installed, the 
window might contain additional tabs and toolbar icons. This chapter 
focuses only on the CinePlex Tracking Option.

Logical operators:
Union shapes (OR), Intersect shapes (AND), 
Subtract shapes (NOT), XOR shapes (Exclusive OR)

Shapes:
Circle, Ellipse, Rectangle, Polygon
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2 One or more shapes can be added to the arena. To draw a shape, click the 
desired shape on the toolbar (Circle, Ellipse, Rectangle, or Polygon). For a 
circle, ellipse or rectangle, left-click and hold the mouse on a desired point on 
the image and move the mouse to size the arena. 

Note: For a freehand polygon, click the left mouse button over desired 
points that will be the nodes of the polygon, and use a right-click to 
close the polygon. The shape can be moved or resized by left-clicking 
and dragging.

3 Multiple shapes can be drawn and logically combined to create an arena with 
a complex shape. After the first shape is drawn, draw a second shape as 
follows:

• Click on the logical operator that will combine the first and second 
shape.

• Then click on the icon for the second shape and draw the second shape.

• To view the combined shape more clearly, click on the Fill checkbox to 
select it.
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The images below show examples of combined arena shapes. Tracking will 
only occur in the shaded regions. 

Union shapes Intersect shapes

Subtract shapes XOR shapes
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Arenas drawn from several shapes do not need to be contiguous (as was the 
case in the examples above). The image below shows an arena that contains 
noncontiguous shapes. Tracking will only occur in the shaded regions.

4 If desired, use the logical operator and shape icons multiple times to add and 
join several shapes to accurately define the arena.

5 To delete a shape, select the desired shape in the Arena pane (or in the Video 
pane) and press the Delete key on the computer keyboard. In the images 
below note that the rectangle is selected for deletion.
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Adding Arenas for Additional Camera(s)

6 Repeat Step 1 through Step 5 for any additional camera(s) to be used in the 
experiment.

5.6 Selecting the Tracking Mode and Tracking Settings

This section assists you in selecting the tracking mode to use for the experiment. 
It also explains the purpose of two of the settings common to all tracking modes: 
Threshold and PLX buttons.

5.6.1 Tracker Toolbar

The Tracker toolbar (shown below) allows you to select the desired tracking 
mode.When one of the tracking modes is selected, the system tracks the position 
of subject(s) in the video images, in real time, and delivers the tracked position 
coordinates to the OmniPlex® System. 

5.6.2 Understanding the Tracking Mode Options

The tracking modes are listed below. 

Note: Only one tracking mode can be active at a time. Tracking modes cannot be 
combined.

• Object Contour Tracking: In this mode, CinePlex Studio analyzes the 
image to find a whole-body shape that corresponds to the desired object, and 
then computes (and tracks) the center of gravity of the shape. 

• Tracking LEDs: In this mode, CinePlex Studio tracks up to three light 
emitting diodes (LEDs) on the subject or subjects being tracked.

• Tracking Color Markers: This mode of tracking is retained primarily for 
legacy purposes, for experimenters who have been using this mode and wish 
to continue doing so. It can be used in experiments requiring a small number 
of distinct reflective colors (typically up to five colors in a typical arena) with 

Object Contour  
Tracking 

Tracking LEDs 

Tracking  
Color Markers 

Extended Tracking 
of Color Markers 
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good lighting. It is possible to track more than 5 colors, but only if the arena 
lighting is sufficient. 

• Extended Tracking of Color Markers: This is the recommended mode of 
color markers tracking for most applications. In this mode, CinePlex Studio 
tracks up to 12 reflective colors (tape or paint, for example) on the subject or 
subjects being tracked. The actual number of trackable colors depends on the 
colors themselves, their relative sizes, and the lighting within the arena.

5.6.3 Guidelines for Selecting the Tracking Mode

This section assists you in selecting the tracking mode to use for the experiment, 
and optimizing tracking parameters to suit the needs of the experiment.

The table below provides an overview of the recommended tracking mode to use 
under various conditions.

In general, for a given experimental setup, only one tracking mode is optimal. 
The following guidelines help to determine which tracking mode to use.

• In general, the best tracking results occur when light-emitting diodes (LEDs) 
are attached to the animal. This is due to:

— The relatively small size of the objects being tracked

— The high intensity of colors against a dark or partially lit background

TIP
Extended Tracking of Color Markers
For new experiments, Plexon strongly recommends using the 
Extended Tracking of Color Markers mode rather than the 
Color Markers tracking mode.

Tracking Device to be 
Used on the Animal

Are LEDs the 
Brightest Spots in 

Arena?
Recommended Tracking Mode to Use

No LEDs. 
No colored markers

Not Applicable Object Contour

LEDs Yes LED or 
 Extended Tracking of Color Markers

LEDs No  Extended Tracking of Color Markers

Colored markers Not Applicable  Extended Tracking of Color Markers
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• The easiest way to use LEDs is to mount them directly on the animal 
headstage. Plexon offers headstages with LEDs mounted on them, such as the 
headstage shown in this drawing.

• To track not only position but head direction, use two or three LEDs. 

• For LED tracking, the system finds the brightest spots on the image, and 
determines their positions in the color space. LED tracking mode is 
recommended when LEDs are to be tracked, and they are the brightest spots 
on the image and the rest of the image is dark. Check the Pure Colors option 
to cause the system to recognize Plexon standard red, green, and blue LED 
colors automatically. Otherwise, select the colors to track.

• Object Contour Mode can only track the “center of gravity” of one animal’s 
contour, therefore, Object Contour mode cannot be used with LEDs or 
multiple animals.

• If the experiment requires Motion Measure, which can be used for studies of 
freezing behavior, use Object Contour mode.

• If the animals are multicolored, especially with high-contrast colors (for 
example, Long Evans rats), Object Contour mode works best with a 
contrasting background color, such as red.

• Object Contour mode is more sensitive to changes in background and lighting 
conditions compared to the other tracking modes.

• In general, more effort is required to configure Object Contour mode to 
obtain optimal tracking results than is required for either LED or Extended 
Reflective Colors modes. This is because slight variations in background and 
lighting can cause the animal’s contour to vary slightly, even if the animal is 
not moving.

5.6.4 Understanding the Threshold Setting

All tracking modes have a user-configurable Threshold parameter that is used in 
the calculation the system performs to locate and track an object. The result of the 
calculation depends on [1] the contrast between the tracked object and the 
background, and [2] the Threshold value set by the user. For a general 
understanding of how the Threshold value affects tracking, see Section 5.7.2, 
“Setting the Threshold” on page 164. That section presents the Threshold concept 
from the point of view of Object Contour tracking mode, but the discussion 
applies to all tracking modes.
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5.6.5 Sending Tracking Data to the OmniPlex System

The CinePlex System stores tracking data on the host computer in AVI and/or 
DVT files, as specified by the user. In addition, you can specify that the tracking 
data (X, Y coordinates as a function of time) from Camera 1 be sent to the 
OmniPlex System. The OmniPlex System incorporates this tracking data into the 
PLX files, which also contain the neural data. The procedure for sending tracking 
data from CinePlex to OmniPlex is included in the recording procedure, Section 
5.13, “Recording Synchronized Video Tracking and Neural Data” on page 194.

To configure the CinePlex System to send tracking data to OmniPlex, click the 
appropriate PLX button(s) for Camera 1 in the CinePlex Studio configuration 
pane. The diagram below shows an example of PLX buttons. When a PLX 
button is selected, it turns orange; when it is not selected, it is clear.

The following conditions apply to the process of sending tracking data from 
CinePlex to OmniPlex:

• Data can be sent for Camera 1 only.

• Data can be sent in online (“Cameras”) mode only, not in offline (“Files”) 
mode.

• Data can be sent for up to three LEDs or colored markers. (Only three of the 
PLX buttons can be active simultaneously.)

The procedure for sending data is as follows:

1 Start the OmniPlex Server and PlexControl.

2 Start data acquisition in OmniPlex by pressing the Start Recording button on 
the PlexControl toolbar. (This step also causes the OmniPlex System to begin 
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sending timing signals to the CinePlex System. Without this step, CinePlex 
cannot send data to OmniPlex.)

3 Start CinePlex Studio.

4 Verify that “Cameras” is selected in the Studio pulldown menu and that a 
camera image is displayed for Camera 1. (It is acceptable if other camera 
video images are also displayed, but Camera 1 is required.)

5 In CinePlex, load a settings file that contains tracking, or configure tracking. 
Ensure that at least one PLX button is pressed.

6 Arm CinePlex Studio (press the “A” arming button in the Studio toolbar).

Note: At this point, there is no tracking data being sent from CinePlex to 
OmniPlex. In the armed condition, CinePlex is waiting for a start 
signal to be sent from OmniPlex. The SPK - Activity pane in 
PlexControl shows no data on the CPX1 line.

7 Start recording by pressing the Start Recording button in PlexControl (Studio 
recording starts also). Studio starts sending the coordinate data to OmniPlex, 
and the SPK - Activity pane in PlexControl shows the synchronized data 
stream (see the blue data lines in the image below). Scroll to the bottom of the 
Activity window to show the CPX1 data row.

8 Stop recording by pressing the Stop Recording button in PlexControl (Studio 
recording stops also.)

Note: At this point, there is no tracking data being sent from CinePlex to 
OmniPlex, because CinePlex is once again in the armed condition. 
The SPK - Activity pane in PlexControl shows no data on the CPX1 
line.

9 You can start and stop recording as many times as desired. When recording 
starts, tracking data will flow from CinePlex to OmniPlex. When recording 
stops, tracking data will not flow.

10 If you disarm CinePlex (by clicking the “A” arming button, tracking data will 
flow again from CinePlex to OmniPlex.

Note: Plexon recommends a short test recording to verify the data stream is 
being sent. The SPK - Activity pane in PlexControl should show the 
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presence of the data stream, similar to that shown in the PlexControl 
image above. 

5.6.6 Tracking Parameters - List of Configuration Procedures

The following sections contain procedures that configure the tracking parameters 
for specific experimental applications. Select the appropriate procedure for your 
experiment: 

• Section 5.7, “Object Contour Tracking” on page 161

• Section 5.8, “LEDs In Darkness with LED Tracking” on page 176

• Section 5.9, “LEDs In Darkness or Light with Extended Tracking of Color 
Markers Mode” on page 180

• Section 5.10, “Extended Tracking of Color Markers In Light” on page 181

• Section 5.11, “Tracking Color Markers (Legacy Capability)” on page 187

5.7 Object Contour Tracking

Object Contour tracking records coordinate data for the movement of an animal 
within an experimental arena without requiring LEDs or reflective color markers 
to be attached to the animal. 

In Object Contour tracking mode, the system compares the color of the animal 
with the background color and any background objects. The image below shows 
a dark colored animal to be tracked on a light colored background and without 
any background object in the window. The background’s light color is uniform 
and provides a good contrast to the animal’s color.

TIP
Tracking Data - Add it in real-time or add it later
If the PLX button for the desired tracking data is pressed before the 
start of recording, as explained in the procedure above, CinePlex 
sends the tracking data to OmniPlex in real-time. If you forget to 
press a particular PLX button before starting recording, or want to 
press different PLX button(s) later, CinePlex Editor can be used to 
replay the PLX and AVI files, and overlay the coordinate data.
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The image below shows an example of a well defined animal contour generated 
by the CinePlex System.
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5.7.1 Configuring Parameters for Object Contour Tracking

Perform these steps to select and configure Object Contour tracking.

1 Place the animal in the camera field of view.

2 At the camera lens, adjust the zoom, focus, and iris settings for the best 
picture quality. For additional guidance on camera setup and video quality, 
see Section 3.1, “Setting Up Cameras and the User Interface” on page 26.

3 To select the Object Contour tracking mode, click the appropriate icon on the 
Tracker toolbar.

4 Click the Tracking tab to display the tracking parameters. In the Whole Body 
Visualization group check Contour and Fill Contour so that the objects 
found by the system are visible.

5 In the video image, view the contour(s) of the object(s) that the system is 
tracking. If the contour of the tracked object is not well defined, follow the 
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instructions in one or both of the following sections to obtain good tracking 
results:

• Section 5.7.2, “Setting the Threshold” on page 164

• Section 5.7.3, “Object Contour Mode Advanced Functions - Overview” on 
page 166

6 After the Tracking parameters are set as desired, click the Save Settings 

button ( ) on the toolbar, or, on the File dropdown menu, click Save 
Settings:

5.7.2 Setting the Threshold

CinePlex Studio can locate an object of a specified color by the color contrast 
between the desired color and the threshold setting. If the animal has good 
contrast relative to the arena image, and the background is uniform (that is, there 
are no other objects with similar contrast), adjust the Threshold setting in the 
Object Contour Tracker area to fill the whole image of the animal.

Note: If the background is not uniform or does not have good contrast with the 
animal, setting the Threshold parameter might not be sufficient for tracking. If 
this condition exists, perform the procedure in Section 5.7.5, “Background 
Subtraction” on page 169 to remove the background from the video.

The Threshold is set in the Object Contour Tracker group.
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The image below shows an example of a well defined animal contour.

Use the guidelines below to adjust the Threshold setting.

If the threshold setting is too low, the image could be similar to the one shown 
below. It will probably be necessary to experiment with the setting to obtain the 
optimal value.

If the size of the found target object is larger than 1/4 of the frame area, there will 
be a red blinking message on the bottom of the screen notifying that the threshold 
is probably too low and both the Arm and Record buttons will be disabled.

After the Tracking parameters are set as desired, on the File menu, click Save 

Settings, or click the Save Settings button ( ) on the toolbar.
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5.7.3 Object Contour Mode Advanced Functions - Overview

For some experimental arrangements, adjusting the Threshold setting is not, by 
itself, sufficient to obtain the desired tracking results. Additional adjustments 
may be needed. Object Contour mode includes optional advanced functions to 
handle special circumstances in the experimental environment. These functions 
are accessed in the Tracking pane.

Use one or more of the following procedures to improve tracking:

• Section 5.7.4, “Detail Filtering Adjustment” on page 167

• Section 5.7.5, “Background Subtraction” on page 169

• Section 5.7.6, “Close Contour Option” on page 173

• Section 5.7.7, “Motion Measure Option” on page 175
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5.7.4 Detail Filtering Adjustment

Use Detail Filtering to remove small features of the image that distort the 
tracking results. For example, a long tail on a target animal can skew the centroid 
calculation; cables attached to the target can also skew the results. The Detail 
Filtering adjustment parameter, which has a range of 1 - 10, can remove 
progressively larger features. Use the lowest setting that provides adequate 
results for the experiment.

To set the Detail Filtering Adjustment value

1 In the Properties window Object Contour Tracker area, click Show Contour, 
Fill Contour and/or Find All Objects checkboxes, and view the video image.

2 Select Detail Filter in the Contour Treatment pulldown menu.
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3 Click Detail Filter and set the slider to 2.

4 Observe the effect on the image. Set the Detail Filter slider to lowest setting 
that removes the undesirable features from the target image.

5 After the Tracking parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.
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5.7.5 Background Subtraction

If a background object (or background color) might interfere with the tracking 
function, the system can be configured to ignore the object (or colored area). This 
will allow the system to track the animal correctly. 

This image shows an animal to be tracked along with a background object of 
approximately the same color. The background object is larger than the animal 
and the system is tracking the background object (the red cross hair is centered on 
the object and the tracking window [yellow rectangle] is surrounding the object). 

To avoid this situation, the experimenter can use one or both of the following 
tools:

• Use background subtraction (discussed in this section)

• Define a specific arena shape in which to track (discussed elsewhere in this 
chapter)
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Example - Using Background Subtraction to Exclude Background 
Objects 

This image shows the background object with nothing else in the window. You 
can capture the image of this window to use for background subtraction.

This image shows the background object and the animal together after the user 
has configured the background subtraction function. Note that the system is 
tracking the animal, as indicated by the positions of the red cross hair and yellow 
rectangle and the contour around the animal.
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Example - Using Background Subtraction to Exclude a Low-Contrast 
Background Color

Background subtraction will allow you to do body tracking even when there is a 
low color contrast between the animal and background, a condition which is seen 
in the following image.

Example - Using Background Subtraction with a Multicolored Animal

You will be able to track multicolored animals using Plexon’s special algorithm 
of background subtraction. In this case be sure that all colors contrast with the 
background color. You can use different background colors to try to improve the 
quality. For example, a brick red background works well for Long-Evans rats. 
Note that the contour encloses the complete animal
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To apply the Background Subtraction option

1 In the Object Contour Tracker area, ensure that the Contour and Fill 
Contour checkboxes are selected (so the object contour can be viewed in the 
Video pane later in this procedure).

2 Remove the animal from the tracking area.

3 Capture background image by clicking the Camera icon. The Use 
Background control will activate so that it may be clicked.

4 Check the Use Background checkbox (see diagram above). Checking this 
box configures the system to subtract the background image from the video.

Note: Pressing the eye icon brings up a window containing the latest 
background image. Pressing the scissors icon deletes the latest 
background image.

5 Replace the animal in the tracking area.

6 Adjust the Threshold (see diagram above) so the animal is detected and the 
animal’s outline is filled in the Video pane (see Section 5.7.2, “Setting the 
Threshold” on page 164).

7 After the Tracking parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.
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5.7.6 Close Contour Option

The Close Contour capability causes the tracker to merge multiple objects in near 
proximity to each other into a single object. This can occur, for example, when a 
cable passes between the animal and the camera. Adjust the setting so that a 
single object is displayed. The image below is taken before the Close Contour 
setting is applied.

To apply the Close Contour option

1 Select Close Contour in the Contour Treatment pulldown menu.
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2 Adjust the Close Contour setting until the image contour is closed.

The image below is taken after the Close Contour setting is applied.

3 After the Tracking parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.
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5.7.7 Motion Measure Option

CinePlex Studio Motion Measure is an Object Contour mode option that can be 
used for studies of an animal’s freezing behavior. Motion Measure is the 
normalized contour difference of the animal’s body computed on a frame-by-
frame basis.

Note: The Motion Measure option must be included during a CinePlex Studio 
recording or re-recording session if you plan to analyze the data with the 
CinePlex Editor Freezing Detector function. See Section 4.6.1, “Using the 
Freezing Detector” on page 119.

If the Motion Measure checkbox is selected, CinePlex Studio writes the motion-
measurement data for each video frame to the AVI and DVT files. If the PLX 
button beside the Motion Measure checkbox is selected, CinePlex also writes the 
data to the OmniPlex System.

To apply the Motion Measure option

1 On the Object Contour Tracker menu, double-click the Motion Measure 
checkbox to enable Motion Measure.

2 Click on the PLX button, if desired, to write Motion Measure data to the 
OmniPlex System. (The PLX button turns orange when selected.)

3 After the Tracking parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.
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5.8 LEDs In Darkness with LED Tracking

This section configures the CinePlex System to track colored LEDs in darkness 
with the LED tracking mode selected. Up to three different colored LEDs can be 
tracked.

In darkness, the LEDs are the brightest spots in the window, therefore, the LED 
tracking mode is excellent for this condition. The image below shows three LEDs 
being tracked in darkness.

5.8.1 Configuring Parameters for LED Tracking

Perform these steps to select and configure LED tracking.

1 Place powered LEDs in the camera field of view.

2 At the camera lens, adjust the zoom, focus, and iris settings for the best 
picture quality. For additional guidance on camera setup and video quality, 
see Section 3.1, “Setting Up Cameras and the User Interface” on page 26.

3 To select the LED tracking mode, click the appropriate icon on the Tracker 
toolbar.

4 Click on the Tracking tab in the Dynamic Configuration pane to view the 
Tracking parameters.

5 In the LED Visualization group check Contour and Fill Contour so that the 
objects found by the system are visible. These selections are common to all 
LEDs used in the experiment.



CinePlex Behavioral Research System 

Version 3 177

6 Check the Pure Colors checkbox in the LED Tracker area. Checking this box 
causes the standard red, green and blue LED colors to appear in the LED 
Colors area in the Tracking configuration pane.

Note: In Pure Colors mode, software is optimized for the red, green and/or 
blue LEDs supplied by Plexon. 

7 Check each color to track in the LED properties area (LED 1, LED 2 and/or 
LED 3).

8 For each color checked in Step 7, check the PLX button, if desired, to send a 
copy of the tracking coordinate data to the OmniPlex System. (The PLX 
button turns orange when selected and clear when deselected.)

9 Change the Threshold (common to all LEDs) so that the correct objects are 
filled and outlined on the Video window. Their color crosses (representing the 
centers of gravity) should be centered on the correct objects.

10 If pure colors do not give good results, use the pick-up tool to select the color 
from the video (see "Using the Color Pick-up Tool with LED Tracking" below). 
Adjust the Threshold as needed.

11 After the Tracking parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.
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5.8.2 Using the Color Pick-up Tool with LED Tracking

This procedure explains how to use the color pick-up tool to adjust Color 1, Color 
2, or Color 3 to match an existing color of an LED on the animal.

LED color shade selection is possible, but requires precision in the pixel selection 
process. This is because an LED image is a hot white center surrounded by pixels 
of varying shades of color. You must click on one of the pixels of the desired 
color, but not white.

1 To use the color pick-up tool on a specific LED, click on the Color Selection 
box for the color that is to be adjusted.

2 The image below shows a sample video window before clicking the Color 
Selection box.

3 In the Video window a square area surrounding the cursor displays as a 
magnified window. Move the magnified window over the area to be shown in 
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the Color Selection box. The image below shows the magnified cursor 
window in the lower left of the diagram - note the digitization of the area.

4 Position the crosshair over a representatively colored pixel. The Color 
Selection box displays the color of the pixel directly under the crosshair. The 
image below shows a red pixel under the magnified area.

Note: Be sure that the pixel is the dominant color of the LED, and not the 
white center of the LED.

5 Click the pixel.

6 The color of the corresponding color box in the properties window will be 
changed to that of the clicked pixel.

7 Change the Threshold (common to all LEDs) so that the correct objects are 
filled and outlined on the Video window. Their color crosses (representing the 
centers of gravity) should be centered on the correct objects.

Note: For a general discussion of Threshold values, see Section 5.7.2, 
“Setting the Threshold” on page 164.
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8 If the cursor does not track accurately with the threshold set to optimum, 
change the color or adjust the sharpness and saturation. 

9 Repeat the steps in this section for any additional camera(s) to be used in the 
experiment.

10 After the Tracking parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.

5.9 LEDs In Darkness or Light with Extended Tracking of Color 
Markers Mode

The CinePlex System can track colored LEDs in darkness or light with the 
Extended Tracking of Color Markers mode selected.

In darkness, the LEDs are the brightest spots in the window, therefore, the 
Extended Tracking of Color Markers mode works well for this condition. The 
system treats the LEDs as if they were reflective colors. The image below shows 
three LEDs being tracked in darkness.

In light, the LEDs might (or might not) be the brightest spots in the window. If 
the LED colors have sufficient brightness and contrast with respect to the 
background, Extended Tracking of Color Markers works well for this condition. 
The image below shows three LEDs being tracked in light.
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Note regarding use of the color pick-up tool with LEDs

With the color pick-up tool, LED color shade selection is possible, but requires 
precision in the pixel selection process. This is because an LED image is a hot 
white center surrounded by pixels of varying shades of color. You must click on 
one of the pixels of the desired color, but not white.

To configure tracking of LEDs with Extended Tracking of Colors mode

Follow the same procedure as with Section 5.10, “Extended Tracking of Color 
Markers In Light” on page 181.

5.10 Extended Tracking of Color Markers In Light

This section configures the CinePlex System to track reflective colored markers 
in light with the Extended Tracking of Color Markers mode selected. Up to 12 
different colored markers can be tracked.

The image below shows three reflective markers being tracked.
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5.10.1 Enabling Extended Tracking of Color Markers In Light

Perform these steps to select and configure Extended Tracking.

1 Place the colored targets in the camera field of view.

2 At the camera lens, adjust the zoom, focus, and iris settings for the best 
picture quality. For additional guidance on camera setup and video quality, 
see Section 3.1, “Setting Up Cameras and the User Interface” on page 26.

3 To select the Extended Tracking of Colors mode, click the appropriate icon on 
the Tracker toolbar.

4 Click on the Tracking tab for Camera 1 in the Dynamic Configuration pane to 
view the Tracking parameters.

5 In the Marker Visualizations group check Contour and Fill Contour so that 
the objects found by the system are visible. These selections are common to 
all color markers used in the experiment.

6 In the Marker Colors and Additional Marker Colors areas, click the 
checkboxes to select the colors to be tracked. 
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7 For each color checked in Step 6, check the PLX button, if desired, to send a 
copy of the tracking coordinate data to the OmniPlex System. (The PLX 
button turns orange when selected and clear when deselected.)

8 Follow the procedure in "Using the Color Pick-up Tool with Extended Tracking 
of Reflective Colors" (below) to select the specific colors to track.

5.10.2 Using the Color Pick-up Tool with Extended Tracking of Reflective 
Colors

This procedure explains how to use the color pick-up tool to adjust any of the 
tracked colors (Color 1 through Color 12) to match an existing color of a 
reflective color marker on the animal.

1 To use the color pick-up tool on a specific color, click on the Color Selection 
box for the color that is to be adjusted.

2 The image below shows a sample video window before clicking the Color 
Selection box.

3 In the Video window a square area surrounding the cursor displays as a 
magnified window. Move the magnified window over the area to be shown in 
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the Color Selection box. The image below shows the magnified cursor 
window in the lower left of the diagram - note the digitization of the area.

4 Position the crosshair over a representatively colored pixel. The Color 
Selection box displays the color of the pixel directly under the crosshair. The 
image below shows a red pixel under the magnified area.
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5 Click the pixel.

6 The color of the corresponding color box in the properties window will be 
changed to that of the clicked pixel.



186 CinePlex Behavioral Research System 

5 Recording Positional Data with CinePlex Tracking Option 

7 Click the checkbox for Fill Contour in the Marker Visualizations area (if not 
already selected) so that the image of the selected object is seen in the video 
image.

8 Repeat Step 1 through Step 7 for the other colors that will be tracked in the 
experiment.

9 Work with the Tolerance parameters (in the following section) to improve 
tracking efficiency.

5.10.3 Improve Tracking Efficiency with Tolerance Parameters

1 If necessary to improve tracking, adjust the H, S and V tolerances so there 
are no Intersects among the various colors.

2 Change the H, S and V Tolerance setting so that the correct object is filled 
and outlined on the Video window. The crosshair should be centered on the 
correct object.

Note: Do not change the Adjust HSV settings manually. These settings 
were adjusted automatically by the system when you clicked the 
colored pixel in the earlier step.

3 If the above steps do not provide accurate visualization of the objects that 
need to be tracked, or do not eliminate all the Intersects, consider making 
some or all of the following additional adjustments and changes: 

• Use different marker colors, especially if two of the colors being used in 
the experiment are similar to each other.

• Increase the lighting level in the experimental area, if possible.

• Reduce the number of color markers being used in the experiment.

• Increase the gain on the camera (although this will also increase noise).

Note: The above list is intended as a general guide. If you need additional 
information on these adjustments, contact Plexon support.
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4 After completing the previous steps, verify that the configured CinePlex Studio 
system looks similar to the following image, in which the system is set up to 
track three colors.

5 Repeat the steps in this section for any additional camera(s) to be used in the 
experiment.

6 After the Tracking parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.

5.11 Tracking Color Markers (Legacy Capability)

This section configures the CinePlex System to track an animal with Color 
Markers tracking mode selected, and with any of the following experimental 
configurations:

• LEDs in darkness

• LEDs in light

• Reflective colored markers in light

Note: This mode of tracking is retained for legacy purposes only, for experimenters 
who have been using this mode and wish to continue doing so. In this mode, up 
to 5 colors can be tracked in the typical arena. It is possible to track more than 
5 colors, but only if the arena lighting is sufficient. For new experiments, Plexon 
strongly recommends using the Extended Tracking of Color Markers, as 
described elsewhere in this chapter.

The images below show LEDs in darkness, LEDs in light, and reflective markers 
(respectively) being tracked.



188 CinePlex Behavioral Research System 

5 Recording Positional Data with CinePlex Tracking Option 



CinePlex Behavioral Research System 

Version 3 189

5.11.1 Enabling Color Markers Tracking Mode

Perform these steps to select and configure Color Markers tracking mode.

1 Place the colored targets in the camera field of view.

Perform these steps to select and configure Color Markers tracking mode.

1 To select the Color Markers tracking mode, click the appropriate icon on the 
Tracker toolbar.

The Tracking pane for the selected tracking mode displays in the Static 
Configuration pane.

2 In the Visualization group check Contour and Fill Contour so that the 
objects found by the system are visible. These selections are common to all 
color markers used in the experiment.

3 Check the Default Colors checkbox in the Marker Properties area.
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4 Check the color to track by clicking the corresponding checkbox.

5 If any settings need to be changed for a particular color, click on the ‘+’ for that 
color.

6 Adjust the Threshold of the selected color (see diagram below) so that the 
correct object is filled and outlined on the Video window and its color cross is 
properly centered.

Note: If working with default colors, the Threshold should be moved to 
lower values to provide stable tracking.

Note: For a general discussion of Threshold values, see "Setting the 
Threshold" (below).

7 If the default colors do not give good results, select the color from the video. 
To do this, use the method described in Section 5.10.2, “Using the Color Pick-
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up Tool with Extended Tracking of Reflective Colors” on page 183. Adjust the 
Threshold higher to find and track the object.

8 Repeat Step 5 through Step 7 for each color selected.

9 After the Tracking parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.

5.11.2 Setting the Threshold

CinePlex Studio can locate an object of a specified color by the color contrast 
between the desired color and the threshold setting. If the marker has good 
contrast relative to the animal, adjust the Threshold setting in the Marker 
Colors area to fill the whole image of the animal.

The Threshold is set in the Marker Colors group.

Use the guidelines below to adjust the Threshold setting.
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If the threshold setting is very low, the image could be similar to the one shown 
below. It will be necessary to experiment with the setting to obtain the optimal 
value.

If the size of the found target object is larger than 1/4 of the frame area, there will 
be a red blinking message on the bottom of the screen notifying that the threshold 
is probably too low and both the Arm and Record buttons will be disabled.

If the threshold is low, the center of gravity crosshair will exhibit jitter. Click the 
Fill Contour checkbox to view the contour that the system is tracking. The image 
below shows an example. There are several parasite objects that are being tracked 
in addition to the desired marker.

Try to set the threshold so that the number of parasite objects is as few as 
possible. 

There is an additional tool to use to check whether the threshold is set too low. To 
see all objects, click the Fill All Objects checkbox. As shown in the image 
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below, the system is tracking the correct object, but it is also wasting bandwidth 
analyzing a large number of parasite objects.

Note: The Fill All Objects function (which displays the blue objects inside the green 
rectangle in the above image) is automatically disabled when the recording 
starts, and these objects are not displayed during recording.

Increase the threshold to reduce the number of parasite objects. The image above 
shows the tracked object (in green), but the image also contains a large number of 
parasite objects (in blue). After you increase the Threshold value, there should be 
fewer parasite objects. The image below shows very few parasite objects and 
effective tracking of the desired object.

Increasing the threshold does not work in all cases. If the threshold is too large, 
the target object will be smaller.
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After the Tracking parameters are set as desired, on the File menu, click Save 

Settings, or click the Save Settings button ( ) on the toolbar.

5.12 Calibrating the Arena Dimensions

In many experiments, it is useful to calibrate the video image so that sizes, 
positions and velocities are reported in the desired units of measure instead of 
pixels. See Section 3.3, “Calibrating the Arena Dimensions” on page 30 for the 
procedure.

5.13 Recording Synchronized Video Tracking and Neural Data

This section explains how to record video and tracking data that is synchronized 
with neural data from the OmniPlex System. This procedure requires starting and 
stopping the CinePlex Studio video recording process remotely from the 
OmniPlex System. This method of triggering the recording ensures that:

• The timestamps in the CinePlex and OmniPlex files are derived from the 
same clock

• The CinePlex and OmniPlex file start times and stop times are synchronized

• The CinePlex frame numbers, coordinate data and timestamps are 
synchronized

Simultaneous starting, stopping, pausing, and resuming of the neural data and 
video files is essential in helping the researcher correlate the behaviors captured 
in the video with the observed neural activity.

Although you may manually start, stop, pause, and resume recording an AVI file 
at any time in CinePlex Studio by simply clicking the appropriate toolbar buttons, 
this method will not record synchronized files, because it produces video files 
that do not have the same start time as the corresponding neural data files.

5.13.1 Recording Procedure

Perform these steps to record synchronized video and neural data.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.

CAUTION
Lighting Conditions
If lighting conditions change enough during recording that ‘objects 
too large’ or some other condition occurs, the position data may be 
meaningless.
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1 Ensure that the system is connected as described in Appendix A-Cabling 
Guide so that the clock and control signals can be sent from the OmniPlex 
System to the CinePlex Studio components.

Note: For more information on setting up and running the OmniPlex Server 
and PlexControl, refer to the OmniPlex instructions. 

2 At the OmniPlex System chassis, turn the power on and start the OmniPlex 
Server and PlexControl.

3 If not already done, configure the OmniPlex System.

4 Click the Start Data button in the PlexControl toolbar so that neural data 
acquisition begins, and the neural data appears in PlexControl display.

5 Double-click the CinePlex Studio icon. Wait for the CinePlex Studio 
application main window to appear on the monitor.

Note: If Studio does not detect the OmniPlex clock, an error message will 
appear. If it does, see Appendix F-Troubleshooting.

6 Verify that “Cameras” is selected in the Studio pulldown menu and that a 
camera image is displayed for Camera 1. (It is acceptable if other camera 
video images are also displayed, but Camera 1 is required.)

7 If there is an appropriate file containing all the desired CinePlex settings (with 
the tracking function configured), load the file onto the CinePlex System using 

the Load settings icon ( ) on the main toolbar or the File/Load Settings 
menu selection.

8 Click on the Global Config tab in the static configuration pane to display the 
Global Config pane. 

Note: This pane is the first an experimenter will normally use when setting 
up CinePlex Studio, but perhaps not very often after that. It contains 
settings that pertain to the frame rate to use when recording, image 
resolution (quality of recordings to make), compression bit rate, local 
file name, and whether the experiment involves one animal or many. 

9 View the settings in the Global Config pane and modify any that need to be 
changed prior to starting the next recording session:
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10 To browse for the desired file location (where the recorded files will be saved), 
click on the browse icon, which is the rectangle with three dots on the Rec 
Folder row of the Global Config tab.

11 When the Browse for Folder appears, use standard Windows® methods to 
select or create the appropriate folder. The factory default location for the 
Recording folder is C:\PlexonData or D:\PlexonData (if disk D is available).

12 When finished choosing or creating a storage folder, click OK.

Note: The location of the Recording folder is included in the Settings file (if 
you save a Settings file), and is restored when the Settings file is 
loaded. To save settings, click Save Settings on the File menu, or 

click the Save Settings button ( ) on the toolbar.

13 To view the CinePlex Studio time display, select the Source 1 tab in the Video 
1 window, and view the digital video recording (DVR) section. (CinePlex 
Studio maintains a time code that tracks the time elapsed since the last time 
recording began.)

14 In the Timecode options, select the In Video checkbox to include the time. 
Choose a Location and a Format setting to configure the display.
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For example, the following images show the time code in the Upper Left 
location in SSSSS.SSS and HH:MM:SS.SSS format, respectively.
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15 In the Camera area, adjust the controls to obtain an acceptable image on the 
screen. The specific controls vary depending on the camera model. Typical 
adjustments include Gain, Auto White Balance, Brightness, Sharpness 
and Saturation.

Note: You can also use other image quality settings. To evaluate image 
quality settings, manually collect a set of AVI files at different settings 
and use the file mode to determine a minimum acceptable image 
quality setting for the experiment. 

16 In the digital video recording (DVR) area of the Sources pane, select the 
type(s) of output to create - video file (AVI File), text file with digital video 
tracking (DVT File) data, neither or both.

 

17 You have the option to send tracking data from the CinePlex System to the 
OmniPlex System. To send tracking data, click the PLX button(s) in the 
Camera 1 pane for the type(s) of data to be sent. (If no PLX button is 
checked, no data will be sent to the OmniPlex System during the recording 
session.)

Note: When a PLX button is selected, it turns orange; when it is not 
selected, it is clear.

TIP
Reducing blurs and color streaks in the video
If the experimental subject moves quickly, blurs and color streaks 
can appear in the video. Reduce or eliminate these problems by 
increasing the shutter speed. For more information, see “Shutter” 
under Section 3.2.3, “Source Pane Settings” on page 30.

CAUTION
Save the AVI File
It is strongly recommended that you save an AVI File for every 
experimental run, even if you are sending data directly from 
CinePlex to OmniPlex. (The AVI File is the default output type.) The 
AVI file is the originally recorded video of the experiment, and it can 
be retrieved and analyzed again. If you deselect the AVI File 
checkbox, the original video will not be saved. 

TIP
Timestamps, frame numbers and tracking data—DVT File
The system will generate a digital video tracking (DVT) file if you select the 
DVT File checkbox. The DVT file will have frame numbers, timestamps and 
tracking coordinates.
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The following conditions apply to the process of sending tracking data from 
CinePlex to OmniPlex:

• Data can be sent for Camera 1 only.

• Data can be sent in online (“Cameras”) mode only, not in offline (“Files”) 
mode.

• Data can be sent for up to three LEDs or colored markers. (Only three of 
the PLX buttons can be active simultaneously.)

18 (Optional) If the arena dimensions have not yet been calibrated, the 
calibration can be done now. See Section 3.3, “Calibrating the Arena 
Dimensions” on page 3-30 for details.

19 Repeat Step 13 through Step 16 for any other cameras connected to the 
system.

20 From the CinePlex Studio toolbar, click the “A” arming button. A yellow 
flashing cassette icon appears on the status bar.

Note: At this point, there is no tracking data being sent from CinePlex to 
OmniPlex. In the armed condition, CinePlex is waiting for a start 
signal to be sent from OmniPlex. The SPK - Activity pane in 
PlexControl shows no data on the CPX1 line.

21 From the PlexControl toolbar, click the Start Recording icon. If PlexControl 
prompts for a file name, enter it.

PlexControl starts recording and displays status information about the neural 
data file on the PlexControl status bar; for information on the PlexControl 
status, see the OmniPlex System instructions.

CinePlex Studio automatically starts recording and displays information about 
the video file in the CinePlex Studio status bar.

The Studio status bar will display the amount of free space remaining on the 
drive selected.

Note: The system automatically checks that there is at least 10 GB of free 
disk space on the PC before it starts recording a file. The file size can 
grow to fill the space available, except that the system automatically 
stops recording the current file when the available disk space has 
been reduced to 10 GB. 
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Studio starts sending the coordinate data to OmniPlex, and the SPK - Activity 
pane in PlexControl shows the synchronized data stream (see the blue data 
lines in this image):

Note: Plexon recommends a short test recording to verify the data stream is 
being sent. The SPK - Activity pane in PlexControl should show the 
presence of the data stream, similar to that shown in the PlexControl 
image above.

22 To pause recording, click the PlexControl Pause Recording icon. 

PlexControl pauses recording and displays status information about the 
neural data file on the PlexControl status bar.

CinePlex Studio pauses recording and displays information about the video 
file in the CinePlex Studio status bar. The status bar flashes green and gray to 
indicate that the recording is paused.

To resume recording, click PlexControl Pause Recording again.

23 To stop recording, press the Stop Recording button in PlexControl (Studio 
recording stops also.)

PlexControl stops recording to the neural data file, clears the recording 
information from the status bar, and saves the file as specified in Step 21. 

CinePlex Studio stops recording and saves the video file(s) to the location that 
was specified as Rec Folder in the CinePlex Studio Global Configuration 
Pane. CinePlex Studio clears the recording information from the status bar 
and re-arms itself for the next recording session.

When Studio is armed, for efficiency it creates temporary files. When 
recording is started remotely (from OmniPlex), Studio writes to these 
temporary files. When recording is stopped, the temporary files are renamed, 
and new temporary files are opened in anticipation of a new recording 
session. The Studio Messages Pane displays information similar to the 
example below.
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Note: At this point, there is no tracking data being sent from CinePlex to 
OmniPlex, because CinePlex is once again in the armed condition. 
The SPK - Activity pane in PlexControl shows no data on the CPX1 
line.

24 You can start and stop recording as many times as desired. When recording 
starts, tracking data will flow from CinePlex to OmniPlex. When recording 
stops, tracking data does not flow.

25 To disarm CinePlex Studio, from the DVR toolbar, click Arm to clear. The 
status bar returns to the disarmed state.

26 To view the captured video file, browse to the file location and double click to 
open the file.

27 To transfer files to an analysis computer (if different than the recording 
computer), follow standard Windows procedures. 

28 To view the neural and video files together, start CinePlex Editor by following 
the procedures described in Chapter 4, Processing Video Files with CinePlex 
Editor. 

Note: You can also view just the video files by using CinePlex Editor, 

Windows Media Player® or CinePlex Studio on the analysis 
computer.

TIP
Tracking Data - Add it in real-time or add it later
If the PLX button for the desired tracking data is pressed before the 
start of recording, as explained in the procedure above, CinePlex 
sends the tracking data to OmniPlex in real-time. If you forget to 
press a particular PLX button before starting recording, or want to 
press different PLX button(s) later, CinePlex Editor can be used to 
replay the PLX file and overlay the coordinate data.
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5.13.2 File Naming Procedure During and After Recording

During the recording process, CinePlex Studio creates temporary names for the 
AVI files. When the recording is stopped, Studio renames the files.

If there is only one camera connected to the CinePlex System:

• The format of the temporary files is yyyymmddnnn.avi

• The format of the renamed files is PLX_file_name.avi

If there are multiple cameras connected to the CinePlex System:

• The format of the temporary files is yyyymmddnnn_N.avi

• The format of the renamed files is PLX_file_name_N.avi

where:

yyyymmdd is the year, month and day

nnn is a 3-digit number, 001, 002, ... 999 assigned automatically by the 
system

N is the camera number for which the file is created - 1, 2, ...

PLX_file_name is the file name specified by the user on the OmniPlex 
System in Step 21 of Section 5.13.1, “Recording Procedure” on page 194.

Note: If Studio is armed on one day, but the start signal is not received until the next 
day, the temporary filename remains the one for the previous day.

5.14 Monitoring the Video During a Recording Session

The status bar in the CinePlex Studio main window displays information that 
allows the researcher to monitor the video recording process. See the section 
Section 3.5, “Monitoring the Video During a Recording Session” on page 51 for a 
description of this feature. 

5.15 Recording Video without Neural Data (Used for Animal Training)

You can record video and tracking data without neural data. In this case, the 
OmniPlex System is activated only for the purpose of providing the required 
clock for the CinePlex System. This procedure requires activation of the 
OmniPlex data stream (which starts the clock), and then starting and stopping the 
CinePlex Studio video recording process locally on the CinePlex System. This 
method of triggering the recording is typically used during animal training, when 
no neural data is being collected.

See the section Section 3.6, “Recording Video without Neural Data (Used for 
Animal Training)” on page 52 for this procedure. 

Note: In addition to the parameters configured in that procedure, you can also 
configure the Tracking Option parameters. If the Tracking Option is enabled 
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and the DVT file format is selected, the DVT file will contain the tracking 
coordinates.

5.16 Video Playback and Rerecording In Studio Files (Offline) Mode

CinePlex Studio can be used in offline mode to play back and rerecord video 
from existing files. The existing AVI and/or DVT files are the ones recorded 
previously by means of the procedure in Section 5.13, “Recording Synchronized 
Video Tracking and Neural Data” on page 194.

The procedure is the same as presented in Section 3.7, “Video Playback and 
Rerecording In Studio Files (Offline) Mode” on page 59.

5.17 Additional File-processing Tools

The following tools can also be used for processing of files:

• Use the CinePlex Studio Extractor to extract static and dynamic data from a 

Plexon AVI file for analysis with a database program such as Microsoft® SQL 

Server® or data processing tools such as Microsoft Excel®. See "Using the 
Extractor" (below).

• Use CinePlex Editor (or some other method) to match up the AVI file with its 
partner neural data file, or DVT file, or both, and analyze the data. See 
Chapter 4, Processing Video Files with CinePlex Editor.

• You can import and analyze the X, Y position data in PLX files with 

NeuroExplorer®, Version 3.088 or later. For details about NeuroExplorer, see 
www.plexon.com. 

5.18 Using the Extractor

CinePlex Extractor is an offline tool that extracts desired static and dynamic data 
from a Plexon AVI file, placing it into Plexon Settings file format and/or formats 
suitable for use by database programs such as Microsoft SQL Server or data 
processing tools such as Microsoft Excel. See the section Section 3.9, “Using the 
Extractor” on page 70 for the procedure.

When the Tracking Option is installed, the Extractor dialog boxes and output files 
contain positional coordinates in addition to the basic Studio frame number and 
timestamp values. Examples of these dialog boxes and output files are shown 
below.

http://www.plexon.com 
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6.1 Introduction to the CinePlex Basic Behavior Option

This chapter describes the CinePlex® System Basic behavior Option, the 
experimental applications for which it can be used, and how to use it. The Basic 
Behavior Option extends the capabilities of CinePlex Studio and CinePlex 
Tracking Option. The Basic Behavior Option requires the CPB V3 license in 
addition to the CPT V3 (Tracking) and CPX V3 (Studio/Editor) licenses.

6.1.1 General Procedure

The general procedure for using the Basic Behavior Option is the same as that for 
the Tracking Option (see Chapter 5, Recording Positional Data with CinePlex 
Tracking Option), with the additional procedures described in this chapter. The 
additional Basic Behavior procedures include:

• Defining static and dynamic zones of interest within an experimental arena

• Defining zone sequences

• Monitoring objects traversing zones and sequences and generating logical 
and digital events

• Defining behavioral events from one or multiple cameras to generate logical 
events and electrical signals

• Recording and viewing real-time and offline information about behavioral 
events and tracked objects, including such attributes as speed, direction 
(vector), limb angles, presence in particular zones in the arena, proximity to 
other objects, sequence of zones visited.

• Monitoring vectors between objects and creating behavioral events when the 
objects are within/outside of a customer-defined angle and tolerance

• Monitoring animal head direction based on markers or LEDs on a headstage.

• Monitoring animal speeds to create digital events when the speed is over/
under a user-specified threshold

• Accumulating and displaying behavioral event statistics

6.1.2 Terminology

The following terminology is useful in discussing behavior recording and 
tracking:

• Zones: A zone is a defined portion of the arena that has significance in an 
experiment. Many zones can be defined simultaneously. CinePlex Studio 
provides tools that allow you to draw zone outlines on top of the video image. 
These tools operate in the same way as the arena tools, allowing complex 
shapes to be created by means of logical operations. 

Note: Complex zones can be created for either static or dynamic zones; see the 
definitions of static zones and dynamic zones, below.
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• Static Zones: Zones that do not move with respect to the image or the arena 
are referred to as static zones. In general, they are used in object recognition 
experiments. For example, a static zone could be an area the animal should 
avoid to receive a reward or it could be an area the animal must traverse to 
receive the reward. It could even be one of the zones in a sequence of zones 
the animal should traverse. 

• Dynamic Zones: A dynamic zone is a circular area around a marker or LED. 
In general, it is used to detect social interactions among animals. Dynamic 
zones are available for LED tracking mode, Color Markers mode and 
Extended Tracking of Color Markers mode. They are not available in Object 
Contour tracking mode.

• Sequences: A sequence is an ordered list of zones. Many different sequences 
can be defined.

• Events: Logical events can be defined so that, when an animal enters or 
leaves a zone, or completes a sequence, the event becomes true. Many events 
can be specified. Their current states are dynamically displayed in the Event 
Statistics pane. The system can generate electrical pulses or levels (high or 
low) based on logical event states or state changes.

• Combination Events: A combination event is an event that becomes true 
when two or more other events are true. The events used in a combination 
event can be generated from one or multiple cameras. This allows events to 
be generated by simultaneous occurrences in several different images, if 
desired.

6.2 Setting Up Cameras and the User Interface

The procedures for setting up cameras and the user interface are the same as those 
used for the Tracking Option. See Chapter 3, Recording Video with CinePlex 
Studio.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.
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6.3 Navigating the Studio Main Window

See the section Section 3.2, “Navigating the Studio Main Window” on page 29 
for a basic description of the Studio main window, where you can view and 
modify CinePlex Studio settings before starting the recording session. 

When the Tracking Option and Basic Behavior Option are present, there are 
additional toolbar options and panes, as shown in the image below.

6.4 Defining Arenas and Configuring Tracking Parameters

The procedures for defining the arenas and tracking parameters are the same as 
those used for the Tracking Option. See Chapter 5, Recording Positional Data 
with CinePlex Tracking Option.
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6.5 Configuring Zones, Sequences and Events for Basic Behavior

This section explains how to create and configure zones, sequences of zones, 
events and combination events.

You can specify values for behavioral events for tracked objects, including such 
attributes as speed, direction (vector), limb angles, presence in particular zones in 
the arena, proximity to other objects or sequence of zones visited. For example, 
the system can create a digital event when the animal’s speed is over/under a 
user-specified threshold, or the animal is within a user-specified distance of a 
certain point in the arena.

6.5.1 Before You Start

The procedures in Chapter 5, Recording Positional Data with CinePlex Tracking 
Option are required for configuring an arena for each camera. The arena must be 
configured and the Tracking Option must be configured before a zone can be 
created. The Basic Behavior Option is built on the Tracking Option.

6.5.2 Overview of Procedure

The procedure consists of the following tasks:

• Section 6.6, “Adding Zones (Static and Dynamic)” on page 211

• Section 6.7, “Defining Sequences of Zones” on page 216

• Section 6.8, “Defining Logical Events” on page 219

• Section 6.9, “Defining Combination Events” on page 227

6.6 Adding Zones (Static and Dynamic)

There are two types of zones, static and dynamic. Static zones are created by 
clicking the Static Zone icon and defining the shape, size and location of the 
zone in the video image. Dynamic zones are created by clicking the Dynamic 
Zone icon and selecting the LED or color marker around which to draw it.

Note: See See “Terminology” on page 208 for definitions of static zone and dynamic 
zone. In general, static zones are associated with static objects in the arena 
and dynamic zones are associated with objects attached to the animal.
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6.6.1 Adding a Static Zone

1 On the Scenes tab click the Add static zone to current arena  icon. 

The parameters are displayed for the new Static Zone.
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2 Select the drawing tool that makes the most sense for the zone that needs to 
be created. 

3 Draw the zone outline over the image corresponding to the first physical zone 
of interest. For the image below a red circle was added.

4 Adjust size and shape so that the complete zone, and nothing else, is 
enclosed by the outline. For the image below, the circle was adjusted to fit 
around the clock by moving and adjusting the circle by the handles on the 
yellow square.

5 If a complex zone is desired, select a different drawing tool if needed, and the 
logical operator to be applied. 

Note: Remember that complex zones can be created by applying logical 
operations to additional shapes as they are added to the zone. These 
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logical operations are selected from the Scenes toolbar: 

For a detailed description of the logical operators, see Section 5.5, 
“Defining the Arenas” on page 152.

The image below shows an example of a complex static zone.

 

6 Repeat Step 1 through Step 5 for each additional zone to be defined.
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6.6.2 Adding a Dynamic Zone

Note: Dynamic Zones are not available for the Object Contour Tracking option.

1 On the Scenes tab click the Add dynamic zone to current arena  icon. 

The parameters are displayed for the new Dynamic Zone.
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2 In the Available Objects row, select the specific marker or LED on which the 
dynamic zone will be centered.

3 If necessary, adjust the values for the Time Threshold and Radius 
parameters.

4 Repeat Step 1 through Step 3 for each additional zone to be defined.

6.7 Defining Sequences of Zones

Note: Before defining sequences of zones, two or more zones must be defined. 

1 After two or more zones have been added, use the Sequences tab.

TIP
To view all panes in the main window, reset to default layout 
If some of the panes are not visible in the main window, it may be 
helpful to restore the default screen layout. From the Window 
dropdown list, select Layout, then Reset to Default Layout.
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2 Click the Add new sequence icon to add a sequence. 

A new sequence is added to the pane.

3 Click the Add zone to selected sequence icon to add a zone to the 
sequence.

A zone is added to the sequence.

4 Select available zones from the drop down list for the new sequence. 

The selected zone is displayed in the Zone 1 setting.
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5 To add a second zone, repeat Step 3 and Step 4.

The selected zone is displayed in the Zone 1 setting.

6 Repeat these steps for each additional sequence to be defined.
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6.8 Defining Logical Events

Logical events can be defined as TRUE when an animal enters or leaves a zone or 
completes a sequence, or when a specified parameter (the angle between two 
vectors, the animal’s speed or the animal’s head direction) is within a specified 
range.

1 In the Events tab, select the Add new tracking event icon to create an 
Event.

2 In the Target row, select the type of Target behavior to be associated with the 
event.

The available parameters vary according to the type of Target selected. 

The available Targets depend on the type of tracking:

• For Object Contour Tracking, the Targets listed in the dropdown are 
Zone, Sequence and Speed.

• For LEDs, Markers, and Extended Markers, the Targets listed in the 
dropdown are Zone, Sequence, Speed, Angle and Head Direction.

See the specific procedure for each type of Target:

• Section 6.8.1, “Events Based on a Zone” on page 220

• Section 6.8.2, “Events Based on a Sequence of Zones” on page 222

• Section 6.8.3, “Events Based on an Angle” on page 223

• Section 6.8.4, “Events Based on Speed” on page 225

• Section 6.8.5, “Events Based on Head Direction” on page 226
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6.8.1 Events Based on a Zone

1 Select a Zone.

2 Define the Condition.

The Present in Zone condition is dependent on the Time Threshold 
parameter that was set in the dynamic zone panel (Section 6.6.2, “Adding a 
Dynamic Zone” on page 215).Specifically:

• An object is considered present in a zone only when the zone wait time 
(the value of the Time Threshold parameter in the dynamic zones panel), 
in consecutive frames, has been satisfied. 

• An object is considered absent from a zone in the first frame its 
coordinates are not in the zone.
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Note: (The meaning of “object” is explained in the Available Objects 
discussion in the next step.)

3 In the Available Objects row, select a tracked object to traverse the specified 
zone.

The event will become TRUE when the conditions are satisfied. At that point, 
the event count will be incremented and times and track lengths in the Event 
Statistics will be extended.

4 Event statistics can be viewed in the Event Statistics pane of the main 
window.
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6.8.2 Events Based on a Sequence of Zones

1 Select a Sequence.

2 In the Available Objects row, select a tracked object to traverse the specified 
sequence of zones.

The event will become TRUE when the conditions are satisfied. At that point, 
the event count will be incremented and times and track lengths in the Event 
Statistics will be extended.

3 Event statistics can be viewed in the Event Statistics pane of the main 
window.
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6.8.3 Events Based on an Angle

This section explains how to define and specify values for behavioral events 
based on the angle between two vectors. The event is generated and recorded 
when the objects are within or outside of a user-defined angle and tolerance. For 
example, an event could be generated when the animal’s front leg is bent more 
than a certain angle. 

The procedure for creating an angle-based event involves defining connections 
between pairs of markers (or LEDs) and then defining an angle between a pair of 
connections. In the example shown below, one connection is defined from the red 
marker to the green marker, and a second connection is defined from the red 
marker to the blue marker. Then the angle of interest (Angle Value) is specified as 
the angle those two connections, in degrees.

1 Add connections by clicking on the + icon in the Add/Remove Connections 
row.
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2 Define two or more connections. In the example below, the user is defining 
four connections.

3 Specify the threshold angle Value (degrees) and the additional parameters in 
the Event group. In the example below, if the Angle is less than 60 degrees 
for at least one frame (the Time Threshold), the event becomes TRUE.

The Color selection (optional) defines the color the system will use to 
highlight the event in the Event Statistics frame, provided that the event 
becomes TRUE.

The Available Objects selection (optional) instructs the Event Statistics to 
display the track length of the selected object during the time that the event is 
TRUE.
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When the event becomes TRUE, the event count will be incremented and 
times and track lengths in the Event Statistics will be recomputed and 
updated.

4 Event statistics can be viewed in the Event Statistics pane of the main 
window.

6.8.4 Events Based on Speed

1 Specify the Target as Speed.

2 Specify the speed (Value) and the Time Threshold and Condition, plus any 
additional parameters as needed in the Event group.In the example below, if 
Marker 1 moves faster than 10.0 cm/s for 5 frames the event becomes TRUE.

Speed is recorded in pixels/second unless the camera is calibrated.

The Color selection (optional) defines the color the system will use to 
highlight the event in the Event Statistics frame, provided that the event 
becomes TRUE.

The Available Objects selection specifies the object to be tracked. The Event 
Statistics panel displays the track length of the selected object during the time 
that the event is TRUE.
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When the event becomes TRUE, the event count will be incremented and 
times and track lengths in the Event Statistics will be recomputed and 
updated.

6.8.5 Events Based on Head Direction

This section explains how to define and specify values for behavioral events 
based on the animal’s head direction as determined with markers or LEDs on the 
headstage. For example, an event could be generated when the animal’s head 
faces toward the feeding station (within a certain number of degrees).

1 In the Event tab, specify the tolerance (in degrees) and specify the markers or 
LEDs that identify the beginning and end of the head.
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2 Specify the object of interest. In the example below, the feeder location is 
identified as Marker 3.

The meaning of these parameters is explained in the following diagram:

6.9 Defining Combination Events

1 Use the Combination Events tab.

Note: When two or more video sources are available, combination events 
can be created using events from multiple cameras. This is helpful, 
for example, for triggering an event when an animal is occupying a 
volume that has a different projection in each source. In the example 
below, the Combination Events tag is located in the Global 
Configuration pane; however, if desired, it can be repositioned in 
other panes, for example, the Video1 pane.
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1 Click the Add new combination of tracking events icon. 
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2 Select the logical operation to use.

3 Select each event in the sequence from the drop down list of available events.

The system generates an entry in the Formula line based on the Operation 
and Event(s) that the user selected in the above steps.
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4 If desired, an Event Combination can contain other Event Combinations, as 
shown in the following example.
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6.10 Specifying Digital Outputs

You can specify creation of digital outputs for a logical event or combination 
event. Up to 24 different digital outputs can be specified, any of which can be 
pulsed, high, or low when the event occurs (i.e., when the event becomes TRUE).

Note: Digital outputs can be transmitted to external devices if the digital output (DO) 
unit is installed. (It is included with the Basic Behavior Option.) The DO unit 
connects to a USB port on the host PC. (Be sure to restart the CinePlex Studio 
application after connecting the USB cable.) The DO unit is shown below.

1 For events, open the Events tab.
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2 To specify that a digital output is sent when an event occurs (becomes 
TRUE), select the desired output line from the drop down list associated with 
the event. The output line numbers correspond to the line numbers shown in 
the side view of the DO unit (see the photograph of the DO unit, above).

3 For event combinations, open the Combinations Event tab.
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4 To specify that a digital output is sent when a combination event occurs 
(becomes TRUE), select the desired output line from the drop down list 
associated with the combination event.
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6.11 Calibrating the Arena Dimensions

In many experiments, it is useful to calibrate the video image for each camera so 
that sizes, positions and velocities are reported in the desired units of measure 
instead of pixels. See Section 3.3, “Calibrating the Arena Dimensions” on 
page 30 for the procedure.

6.12 Recording Synchronized Video Tracking and Neural Data

The procedure for recording video and neural data is the same as that used for the 
Tracking Option. See Chapter 5, Recording Positional Data with CinePlex 
Tracking Option.

6.13 Monitoring the Video During a Recording Session

The status bar in the CinePlex Studio main window displays information that 
allows the researcher to monitor the video recording process. See the section 
Section 3.5, “Monitoring the Video During a Recording Session” on page 51 for a 
description of this feature.

6.14 Recording Video without Neural Data (Used for Animal Training)

You can record video, tracking and basic behavior data without neural data. In 
this case, the OmniPlex® System is activated only for the purpose of providing 
the required clock for CinePlex. This procedure requires activation of the 
OmniPlex data stream (which starts the clock), and then starting and stopping the 
CinePlex Studio video recording process locally on CinePlex. This method of 
triggering the recording is typically used during animal training, when no neural 
data is being collected.

See the section Section 3.6, “Recording Video without Neural Data (Used for 
Animal Training)” on page 52 for this procedure. 

Note: In addition to the parameters configured in that procedure, you can also 
configure the Tracking Option and Basic Behavior Option parameters. 
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6.15 Displaying Behavioral Event Statistics

To open the event statistics pane, select Event Statistics from the View pulldown 
menu.

The images below are examples of event statistics displays for sequence-based 
and angle-based events.

6.16 Video Playback and Rerecording In Studio Files (Offline) Mode

CinePlex Studio can be used in offline mode to play back and rerecord video 
from existing files. The existing AVI and/or DVT files are the ones recorded 
previously by means of the procedure in Section 6.12, “Recording Synchronized 
Video Tracking and Neural Data” on page 234.

The procedure is the same as presented in Section 3.7, “Video Playback and 
Rerecording In Studio Files (Offline) Mode” on page 59.

6.17 Additional File-processing Tools

Additional tools can be used for processing of files. See Section 5.17, “Additional 
File-processing Tools” on page 203.
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6.18 Using the Extractor

CinePlex Extractor is an offline tool that extracts desired static and dynamic data 
from a Plexon AVI file, placing it into Plexon Settings file format and/or formats 
suitable for use by database programs such as Microsoft® SQL Server® or data 
processing tools such as Microsoft Excel®. See the section Section 3.9, “Using 
the Extractor” on page 70 for the procedure. 

When the Tracking Option and Basic Behavior Option are installed, the Extractor 
dialog boxes and output files contain positional coordinates and behavioral 
events data in addition to the basic Studio frame number and timestamp values. 
Examples of these dialog boxes and output files are shown below.
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A.1 Overview

This appendix is explains how to cable the Plexon CinePlex®/OmniPlex® 
System.

Plexon® hopes that this procedure solves cabling issues for most installations. 
Plexon welcomes feedback as to how to improve the experience. Please contact 
Plexon support (support@plexon.com or +1-214-369-4957) with comments.

The diagram below provides an overview of the required connections.

A.2 Required Cables

This section lists the cables required for connections between the CinePlex 
System and the OmniPlex System, and connections between the CinePlex System 

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.
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and the cameras. (The cables listed here are in addition to those needed for 
normal OmniPlex System operation, such as the cable that carries OmniPlex 
control and neural data.)

For installations that use one or two cameras without a CinePlex 
Trigger Controller unit

The following cables are used if one or two cameras are installed and there is no 
CinePlex Trigger Controller unit in the system.

• Universal timing cable between the TIM Cable Adaptor and the Access IO 
Adaptor (CinePlex DIO). 

• Trigger cable(s) from the CinePlex Access IO Adaptor to the video camera(s).

• FireWire cable(s) from the FireWire card in the host PC to the video 
camera(s). 

Note: Plexon supplies the Trigger and FireWire cables bundled together with plastic 
tie wraps. This combination is referred to as a Combination Cable on the 
following pages.

• Optional cable from a USB port on the computer to the Digital Output unit 
(for customers purchasing the Basic Behavior option).

For installations that use up to four cameras with a CinePlex Trigger 
Controller unit

The following cables are used if one or more (up to four) cameras are installed 
and there is a CinePlex Trigger Controller unit in the system.

• Universal timing cable between the TIM Cable Adaptor and the CinePlex 
Trigger Controller.

• Trigger Controller cable between the CinePlex Trigger Controller and the 
Access IO Adaptor (CinePlex DIO).

• Trigger cable(s) from the CinePlex Trigger Controller to the video camera(s).

• FireWire cable(s) from the FireWire card in the computer to the video 
camera(s).

Note: Plexon supplies the Trigger and FireWire cables bundled together with plastic 
tie wraps. This combination is referred to as a Combination Cable on the 
following pages.

• Optional cable from a USB port on the computer to the Digital Output unit 
(for customers purchasing the Basic Behavior option).

A.3 Cabling Procedure

This procedure explains how to connect the CinePlex/OmniPlex System cables.

1 Make sure that there is no power present at the connectors on the back of the 
host PC before connecting the combination Trigger and FireWire camera 
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cable(s). Otherwise, the camera(s) could be damaged. To remove power from 
the connectors on the host PC, simply shut down the host PC from the 

Windows® Start menu.

The following steps refer to diagrams that appear later in this appendix. Please 
refer to the applicable diagram(s) when performing these steps. Use either Step 2 
or Step 3, as applicable to the configuration of the system.

2 For installations that use one or two cameras without a CinePlex Trigger 
Controller unit: Connect the Plexon supplied Universal Timing Cable and the 
Sync Start Wire between the OmniPlex System and the Host PC.

3 For installations that use up to four cameras with a CinePlex Trigger 
Controller unit: Connect the Plexon supplied Universal Timing Cable and the 
Sync Start Wire between the OmniPlex System and the Host PC.

4 Attach the combination Trigger and FireWire camera cable(s).

5 Connect all of the other cables for the system as shown in the diagrams.

A.4 Cabling Diagrams and Connection Details

This section contains pictorial representations of the cabling for several typical 
CinePlex/OmniPlex System setups:

• CinePlex/OmniPlex System with One Video Camera on page A-5

• CinePlex/OmniPlex System with Two Video Cameras on page A-6

• CinePlex/OmniPlex System with Three Video Cameras on page A-7

• CinePlex/OmniPlex System with Four Video Cameras on page A-8

Please contact Plexon with questions about the setup if it differs substantially 
from those represented.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.
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A.4.1 CinePlex/OmniPlex System with One Video Camera
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A.4.2 CinePlex/OmniPlex System with Two Video Cameras
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A.4.3 CinePlex/OmniPlex System with Three Video Cameras
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A.4.4 CinePlex/OmniPlex System with Four Video Cameras
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A.5 CinePlex/OmniPlex System Cable Images

IO Wire for CinePlex Trigger Controller
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A.6 CinePlex Trigger Controller - Required for Three Or Four Cameras
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A.7 Close-up Images of CinePlex/OmniPlex System Cables Installed

A.7.1 Connections to OmniPlex System

A.7.2 Connections to Video Camera

CinePlex/OmniPlex System 
Adaptor 

Universal Timing Cable 
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A.7.3 Connections to Computer

One Video Camera
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Two Video Cameras
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Three Video Cameras

Rear view of host PC:

Front of CinePlex Trigger Controller with Connections for Three Cameras
:

I/O Cable 
Timing Cable from OmniPlex 

FireWire Cables 
to Cameras (3) 

Trigger Cables 
to Cameras (3) 
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Four Video Cameras

Rear view of host PC:

Front of CinePlex Trigger Controller with Connections for Four Cameras
:

I/O Cable 
Timing Cable from OmniPlex 

FireWire Cables 
to Cameras (4) 

Trigger Cables 
to Cameras (4) 
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B.1 Overview

This appendix provides details of camera and lens setup and usage. It is intended 
to assist the scientist in preparing the cameras and lenses for his or her 
experiment.

In any experiment where video is required, there is a physical area of interest in 
which it would be meaningful to record video. This area of interest can be a 
simple enclosure, a maze, a geometrical track, or any other area needed for the 
experiment. For video recording of behaving animals, this area of interest is 
known as the arena. The arena shape and size are critical in determining the lens 
used and the distance from the camera to the arena. Colors used and target 
visibility are also extremely important.

The sections that follow this introduction provide information about camera and 
lens selection, arena layout, and camera installation.

Plexon® hopes that this procedure solves these issues for most installations. 
Plexon welcomes feedback as to how to improve the experience. Please contact 
Plexon support at support@plexon.com or +1-214-369-4957 with comments.

B.2 Available Cameras

For CinePlex® Version 3, Plexon currently offers several AVT cameras and 
several lenses, both varifocal and zoom. The camera types are as follows: 

• AVT Stingray (Type 1/2 CCD)

• AVT Guppy (Type 1/3 CCD)

• Pike (Type 1/3 CCD)

The setup of the camera, lens selection and distance from the experimental arena 
are discussed in the following section.

B.3 Camera Positioning and Lens Selection

This section provides a systematic procedure for determining the position of the 
camera and selecting the lens to use in an experimental arena.

Investigators may find that they need to compromise arena size and/or camera 
distance to accommodate the physical limitations of the camera/lens 
combinations. The limiting factors are that the lens must be able to focus the 
arena image and that the arena image should fill the screen. If the camera’s 
distance to the arena is fixed, the arena size must be kept within certain limits for 

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.

mailto:support@plexon.com
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best results. Alternatively, if the arena size is fixed, the distance between the 
camera and arena must be kept within limits for best results.

1 Determine Optimal Arena Setups

Use the charts below to determine if a particular lens can be used with the 
current experimental setup. The area between the green and blue lines in the 
charts represents arena size and camera distance combinations that are 
acceptable for best results.

2 Determine the distance from the camera to the arena in meters

This distance should be as far as possible from the arena, while still close 
enough to allow the zoom function to fill the sensor with the arena image. Be 
sure to allow space for camera mounting. Find that distance on the X-axis 
(Camera Distance) of the Standard Varifocal chart.

3 Determine the size of the arena in meters

Imagine a circle, square or 4:3 rectangle drawn around the arena, completely 
enclosing it. The Arena Size in the charts above is the diameter of the circle, 
the side of the square, or the longer side of the 4:3 rectangle. Find that size on 
the Y-axis (Arena Size) of the Standard Varifocal chart.

4 Determine if the arena size and camera distance are optimal

If the (X,Y) position specified by the Camera Distance and Arena Size is in the 
area between the Green and Blue lines, the setup should yield optimal results 
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when the camera is zoomed appropriately. It is not necessary to proceed. The 
Standard Varifocal lens will work. 

If the (X,Y) position specified by the Arena Size and Camera Distance is NOT 
in the area between the Green and Blue lines, the setup is sub-optimal. The 
image will be smaller than desirable, larger than desirable, or out of focus.

5 If the position is not optimal, try the steps above on the chart for the Zoom 
lens

If this lens yields an optimal result, contact Plexon to obtain the lens. If not, try 
adjusting Arena Size and Camera Distance to find an optimal combination 
with one of the lenses.

6 If an optimal result cannot be obtained using this procedure, contact Plexon 
for other lens possibilities

Note: The charts are derived from calculated numbers. Small variations in 
lens and camera manufacturing can result in as much as 10% 
variation.

B.4 Experiment Design

B.4.1 Field of View

The field of view (what the sensor of the camera sees) depends on the distance 
between the camera and the surface and the angles of view of the lens that is used 
with the camera. The cameras supplied by Plexon generate screen images with 
the following geometries, depending on the camera model:

• images that are rectangular, 4 units wide by 3 units high, as shown by the 
diagram below. This aspect ratio corresponds to the sensor image size of 640 
by 480 pixels or 320 by 240 pixels.

• images that are square, with sensor image size of 320 by 320, 640 by 640 or 
960 by 960 pixels.

The example that follows in this section is based on a 4 by 3 rectangular 
geometry.

Orient the camera to the experimental area to take maximum advantage of the 
rectangular field of view. As shown in the following illustration, the 4:3 ratio 
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corresponds to a horizontal dimension (H) that is 1.33 times the vertical 
dimension (V).

When the camera is placed so that it is directed towards the experimental area, it 
has a horizontal angle of view and a different vertical angle of view because of 
the aspect ratio described above. The image producing sensor in the camera is 
also rectangular in the same proportion. So the ideal experimental layout will 
have a rectangular 4:3 arena with the camera aligned so that its longer 
(horizontal) sensor dimension is parallel to the arena’s long side. Actual arenas 
may not be 4:3 rectangles, but in all cases, best results will be obtained when the 
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longest dimension of the arena is parallel to the longer sensor dimension of the 
camera.

When the camera and lens are viewed as shown in the image below, the long axis 
of the sensor is in the horizontal plane. This axis should be parallel to the longest 
dimension of the experimental area.

The table below shows the horizontal and vertical angles of view that correspond 
with maximum and minimum zoom of the camera, using the standard lens as an 
example. Other lenses will differ.

The best way to avoid optical distortions is to set the lens at Maximum Zoom and 
move the camera far enough away from the experiment that the maze, cage, track 
or other setup is completely imaged This is the optimum height. The figure below 
illustrates the parameters for a field of view estimate (maze size).

normal lens)

Maximum zoom 
(minimum angle and 

area covered)

Minimum zoom 
(maximum angle and 

area covered)

Horizontal 30 degrees 83 degrees

Vertical 22 degrees 61 degrees
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The formula to calculate the optimum height (H) of a camera over a square maze 
of side L (or a circular maze of diameter L) is:

If the maze is round or square, use the Vertical Maximum zoom angle (or 22 
degrees for the normal lens). If the maze is rectangular, use the Horizontal 
Maximum Zoom angle (30 degrees for the normal lens).

B.4.2 Colors

In contour tracking, to achieve the best tracking accuracy, choose colors with 
maximum contrast. For example, if the target animal is white, choose black or 
another dark color for the arena floor. Likewise, if the target is dark-colored, 
choose a bright white or other light color for the floor. For multi-colored animals 
like Long-Evans rats, red has been shown to have good contrast to the animal’s 
fur colors. It may be necessary to experiment to determine the best background 
color in individual situations.

In all tracking modes, use materials with solid colors as floors, if at all possible. 
Avoid floor materials with patterns or textures.

B.4.3 Visibility

Unless otherwise required, the design of the arena should ensure that the target is 
completely visible to the camera in all areas. If the target is partially obscured by 
overhangs or other obstacles during its travel around the arena, the centroid 
calculations that determine target position and orientation can be affected.

B.5 Camera Installation

B.5.1 The Plexon Camera Mounting Kit and Accessories

For repeatable, reliable video recording, the video camera(s) must be mounted 
stably and securely with respect to the experimental area. Cameras that vibrate or 
move can result in not just partial recordings or blurred images, but also in 
inaccurate position metrics, event triggers at undesired times, and, worst of all, 
non-repeatable experimental trials.

B.5.1.1 Plexon Mounting Kit

The Plexon mounting kit consists of both purchased and Plexon manufactured 
parts. It is included with CinePlex Version 3 and later cameras. The parts have 
been selected to apply in most of the situations encountered while doing CinePlex 
installations. Note that because of the general nature of the kit, not all parts will 
be used in all cases. In addition, there will be some cases where a particular 
installation will require that the customer purchase some additional parts locally.

H L

2

2
--- 
 tan

---------------------=



B  Optimizing Camera and Lens Usage for the Experiment 

B-8 CinePlex Behavioral Research System 

1 Mounting Bracket (Plexon 07-05-M-01)

2 Sandwich Plate (Plexon 07-05-M-02)

3 Three Arm Phenolic Knob (small) - 1/4”-20 (3 ea.)(McMaster Carr 
57715K16)

4 Three Arm Phenolic Knob (large) - 3/8”-16 (McMaster Carr 57715K83)

5 Quick Change Mounting Assembly (Bogen-Manfrotto)

a  Rectangular Plate Adaptor (323)

b  Rectangular Plate (200PL)

B.5.1.2 Customer Supplied Parts as needed

The mounting kit does not include the small parts required for securing the 
mounting bracket to the desired surface. In those cases the customer will need to 
acquire the needed parts locally. Depending on the nature of the surface; screws, 
bolts, wall anchors, adhesive, or other items may be needed for a particular 
experimental setup. The customer should acquire these as needed.

1

3

4

2

5
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B.5.1.3 Optional Mounting Accessories

Some experimental setups may require hard-to-find parts over and above those 
supplied in the Plexon Mounting Kit. Plexon has some optional parts available 
that can help provide secure mounting in many non-typical situations. See pages 
X and Y for some examples using these optional accessories.

1 Camera Mounting Plate 3x6” (Plexon 07-03-M-01)

2 Stud 036-014 (1/4”-20 m x 1/4” 20 f)(Bogen Manfrotto 036-014)*

3 Stud 036-038 (3/8” m x 3/8” f)(Bogen Manfrotto 036-038)*

1

2
3

4
5
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4 Stud 037 (1/4”-20 m x 3/8” m)(Bogen Manfrotto 037)*

5 Stud 066 (1/4”-20 f x 2/8” f)(Bogen Manfrotto 066)*

6 Ball Head - Micro (Bogen Manfrotto 482)*

7 Ball Head - Mini w/ RC2 (Bogen Manfrotto 484RC2)*

8 Ball Head - Compact w/ RC2 (Bogen Manfrotto 486RC2)*

* Starred optional items are available from:

• Plexon - please contact the Plexon salesperson

• Online - search for “Manfrotto” and the item number from many sources such 
as:

— http://www.amazon.com/

— http://www.ritzcamera.com/

— http://www.bhphotovideo.com/

• A local professional camera or video store

B.5.2 Bracket Mounting Choices to Make

First, choose where the camera should be mounted. Common choices are shown 
below:

B.5.2.1 Above the Experiment

1 Ceiling mount

CAUTION ABOUT TRIPODS
Note specifically that tripod mounting of the camera is NOT RECOM-
MENDED. This is because tripod adjustments, particularly leg locking 
mechanisms, can loosen and become unstable. Tripods can also be 
jostled or moved easily since they are generally not secured to a sur-
face.

6 7 8
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2 Top of enclosure

a  Inside of enclosure with room for cables

b  Above the enclosure through an opening

c  Inside of cage with room for cables

B.5.2.2 From the side of the Experiment

1 Wall mount

2 Side of enclosure

a  Inside of enclosure with room for cables

b  Outside of enclosure through an opening

c  Inside of cage with room for cables

B.5.2.3 Below the Experiment

1 Up through a glass or cage floor to view the undersides of animals or for birds 
in perches

2 Floor mount aimed up an animals in the air or above the floor

3 Below enclosure

a  Inside of enclosure with room for cables

b  Below the enclosure through an opening

c  Inside of cage with room for cables

B.5.2.4 Bracket Attachment Methods

Then, choose the most appropriate method of attaching the camera mounting 
bracket to the desired location.
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1 On a surface of a wall or ceiling over 0.4 in (1 cm) thick, use one of the fol-
lowing methods or devise a custom method.

a  Customer provided screws through the three threaded holes in the bracket 
into the wall. Wall anchors should be used as necessary.

b  Customer provided bolts through the three threaded holes in the bracket 
into a wooden surface. Pilot holes can be drilled, if needed, using the 
sandwich plate as a template.

c  Customer provided adhesive or epoxy to glue the surface of the mounting 
bracket containing the three threaded holes to the surface.

2 On a cage:

a  Place the sandwich plate on the outside of the cage, then

b  Insert the three small knobs through the sandwich plate holes and through 
openings in the cage, then
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c  Thread the three small knobs into the threaded holes in the mounting plate.

3 On a wall or surface under 0.4 inches (1 cm) thick:

a  Drill three 9/32” (7 mm) holes using the sandwich plate as a template, then

b  Insert the three small knobs through the wall into the threaded holes in the 
mounting plate.
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B.5.3 Installing the Camera

Procedure for Camera Installation

1 Power down all system components - computer, MAP, etc.

2 Select the bracket attachment method suitable for the experiment and install 
the mounting bracket. Make sure that the mounting bracket is firmly attached 
and stable.

3 Install the rectangular plate adaptor on the mounting bracket using the large 
phenolic knob. For most applications, the point of large lever should be 
pointing away from the experiment when secured. Tighten finger-tight.

4 Make sure that the large lever on the plate adaptor is in the open position and 
ready to accept the plate. If the large lever cannot be moved easily, move the 
small brass level to the unlock position, and try again.

5 Remove any cables from the camera, if present.

6 Attach lens to camera by screwing it on finger-tight.
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7 The tripod adaptor should already be attached to the camera - if not, do so at 
this time.

8 Attach the rectangular plate to the camera tripod adaptor. For most 
applications, the lens should be oriented in the position labeled “2 LENS”. use 
the attached wire loop to finger-tighten the camera and then fold the loop 
down.

a Position “1 LENS” shown below

b Position “2 LENS” shown below
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9 Snap the camera/plate combination into the plate adaptor that is already 
attached to the mounting bracket. Note that there is only one possible 
orientation. The large lever will snap closed. Move the small brass lever to the 
lock position. Make sure that the large lever cannot be unlocked.

1 Attach the FireWire cable(s) to the camera(s). Use the FireWire socket 
labeled “1” in the photo.

2 Connect the other end(s) of the camera FireWire cable(s) to the FireWire 
board in the computer. The cable for Camera 1 should be connected to Port1 
or Port2 on the FireWire board. If  there is a second camera, it should be 
connected to Port3 or Port4. Tighten the screws so that each plug is secure in 
its socket.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.

1 2
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3 Now connect the trigger cable(s) to the BNC connector on the AccesIO 
adaptor on the computer. If there are two cameras, a BNC T-adaptor will also 
be required.

4 Make sure all other system cables are attached as required. Apply power to 
all components, bring up the MAP Server and Sort Client and press the Start 
button on Sort Client. Bring up CinePlex and ensure that video is present. If 
not, go to the Troubleshooting section of the CinePlex manual and work 
through those procedures until a picture is present. If unable to get a picture, 
please contact Plexon support.

5 Loosen the large phenolic knob holding the camera/plate assembly to the 
mounting bracket and adjust the camera orientation until the experimental 
area is centered. Then tighten the large phenolic knob. It may also be 
necessary to repeat Step 8 with the camera in the “1 Lens” position of more 
adjustment latitude is needed.

6 Adjust the camera zoom until the experimental area fills the viewable image. If 
this is not possible the camera may need to be moved closer to or further 
away from the experiment. This can be done by selecting a different hole in 
the mounting bracket for the adaptor plate attachment. If there is space 
available, the mounting bracket may even be moved to the other side of its 
mounting surface. If a satisfactory view is still not possible, contact Plexon 
support for additional lens options.

7 Adjust focus, and iris as needed for a good image.

B.5.3.1 Mounting Options for Multi-camera Systems

Place each camera as needed to record its area of interest. Make the choices 
required for each position. Install each camera using the procedure.

Port 1      Port 2        Port 3         Port 4

Camera
To To

Camera

Port 1

Port 2

Port 3

Port 4
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B.5.4 Examples Using Optional Accessories

Some difficult mounting situations require the use of some of the optional 
mounting accessories mounted shown earlier. Here are some examples.

1 Using the optional Mini Ball Head between the camera and the mounting 
plate.

2 Using multiple ball heads to achieve difficult angles.
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3 Using the Plexon camera mounting plate together with a ball head and stud 
037 to achieve an offset camera mount at a difficult angle.

B.5.5 Camera Removal

Procedure for Camera Removal

1 Power down all systems.

2 Remove all cables from the camera.

3 Move the small brass level to the unlock position if not already there.

4 Place a hand on the camera to catch it as it releases.

5 Move the large lever to the unlock position.

6 Catch the camera and place it in a safe location.

B.6 CinePlex Screen Capture

It is possible to record the operation of CinePlex as well as other applications by 
the use of a screen capture program, such as Camtasia StudioThe procedure 
below describes how to use a screen capture program to record the activities on 
the computer screen. For illustrative purposes, the procedure describes the use of 
Camtasia Studio. The procedure for using other screen capture applications 
would be similar.
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1 From the Start->All Programs menu, locate the screen capture program and 
open it.

2 From the Camtasia Recorder Capture->Input menu select what to record.

3 Ensure Camtasia Recorder is minimized and hit the F9 key when ready to 
record.

4 When finished recording, hit the F10 key. A dialog box will appear to allow 
naming of the recorded file and also to decide where to store the file.

5 The recorded file will be saved as an AVI file in the directory specified and the 
file will be presented for viewing immediately after saving.
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C.1 Types of Messages

This appendix lists the system messages that the CinePlex® Studio software 
displays in reaction to current conditions and certain user actions. Messages are 
displayed in the Messages pane of the CinePlex System main window.

Informational messages are called simple messages, and the more urgent 
messages are called critical messages.

C.2 How to Use Messages

Messages provide a convenient flow of information to the user, and alert you to 
problems occurring within the CinePlex System. Therefore, messages can be 
useful for monitoring and troubleshooting the system. For information on 
correcting specific problems, see Appendix F-Troubleshooting.

C.3 CinePlex Studio Simple Messages

The table below lists the CinePlex Studio simple messages. In most cases, it is 
not necessary for you to take action when a simple message is displayed.

Note: In this table, [...] and <N> refer to text and numeric strings, respectively. These 
strings can differ for each instance of the message.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.

Table 1: CinePlex Studio Simple Messages

Message # Message Text

C100 CinePlex Studio version [...] Starting...

C101 Current date:

C102 Date changed. Current date: [...]

C103 Current display frequency

C104 Display frequency successfully changed to <N> Hz

C107 Factory default settings loaded

C108 File opened for View

C109 File closed for View

C110 Cameras reset

C111 Frame resolution changed
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C112 Loaded settings were created for a different resolution. Arena, zones and calibration 
(if present) are properly resized.

C113 Startup settings loaded from [...]

C114 Settings loaded from [...]

C115 Background image loaded from [...]

C116 Settings stored in the file [...]

C117 Background image stored in the file [...]

C118 Play file started

C119 Event Combinations view presented

C120 Video view presented

C121 Recorder Properties view presented

C122 Area Properties view presented

C123 Messages view presented

C124 Previous video configuration is not applicable due to hardware changes or absence 
of Rasputin or OmniPlex key

C125 Video configuration has been automatically reset to One File

C126 The layout loaded contains panels incompatible with the current license. These 
panels are removed.

C127 Remote start received and discarded

C128 Remote stop received and discarded

C129 Remote pause received and discarded

C130 Video configuration has been automatically set to connect all available cameras 
according to the license

C132 Video configuration has been automatically set to One File

C133 Video configuration has been automatically reset to Camera 1

C135 Armed for remote control - DVR control by Plexon NDAQ is now enabled

C136 Remote control disabled - DVR control by Plexon NDAQ is now disabled

C137 Recording [...] started by Plexon NDAQ

C138 Recording [...] paused by Plexon NDAQ

C139 Recording [...] resumed by Plexon NDAQ

Table 1: CinePlex Studio Simple Messages (Continued)

Message # Message Text
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C140 Recording [...] stopped by Plexon NDAQ (<N> dropped frame(s), <N> MQU)

Note: MQU = maximum queued units. For a description of MQU, see “Monitoring the 
Video During a Recording Session” on page 3-51.

C141 Recording [...] started locally

C142 Recording [...] stopped locally (<N> dropped frame(s), <N> MQU)

C143 Recording [...] paused locally

C144 Recording [...] resumed locally

C145 Tracking switched to Object Contour mode

C146 Object Contour tracking stopped

C147 No LEDs are active. The objects for dynamic zones will be switched to N/A.

C148 Tracking switched to LED mode

C149 LED tracking stopped

C150 Can not switch to LED mode, since tracking license is not detected

C151 Tracking switched to Reflective Colors mode

C152 Reflective Colors tracking stopped

C153 Can not switch to Reflective Colors mode, since tracking license is not detected 

C154 Recording [...] stopped due to missing license key

C155 Tracking stopped due to missing license

C156 No markers are active. The objects used in dynamic zones will be switched to N/A.

C157 Recording folder changed to [...]

C158 Recording [...] stopped since file size on FAT32 drive cannot exceed 4GB (<N> 
dropped frame(s), <N> MQU)

C159 Recording [...] stopped due to low disk space (<N> dropped frame(s), <N> MQU)

C160 End of File. Can not start recording

C161 End of File. Can not start playing

C162 Camera framerate changed to <N>

C163 Wizard opened

C164 Wizard finished

C165 CPX Studio window size reduced by Shrink button

C166 CPX Studio window size restored by Expand button

Table 1: CinePlex Studio Simple Messages (Continued)

Message # Message Text
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C167 Date has changed since the last file was recorded. The file number reset to 001

C168 Can not add sequence due to missing license key

C169 Tracking settings ignored since missing license

C171 Tracker Properties view presented

C172 New shape added to Arena

C173 New shape added to Zone

C174 Shape #<N> deleted from Arena

C175 Shape #<N> deleted from Zone

C176 Tracking Events view presented

C177 Event Statistics view presented

C178 Output lines for the loaded tracking events ignored since no digital output device 
found

C179 All shapes deleted from Arena

C180 All shapes deleted from Zone

C181 Temporary AVI file [...] renamed to [...]

C182 Renaming temporary AVI file [...] failed

C183 Temporary DVT file [...] renamed to [...]

C184 Renaming temporary DVT file [...] failed

C185 Standalone recording [...] started

C186 Standalone recording [...] stopped (<N> dropped frame(s), <N> MQU)

C187 Recording time zero [...] received from OmniPlex Server

C188 File N activated

C189 File N closed

C190 Zone Sequences view presented

C191 Standalone recording [...] paused

C192 Standalone recording [...] resumed

C193 Video Properties view presented

C194 Previous video configuration was [...]

C195 Switched to Camera mode

C196 Camera N started

Table 1: CinePlex Studio Simple Messages (Continued)

Message # Message Text
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C197 Camera N stopped

C198 Switched to File mode

C199 Camera settings for camera <N> have been applied to all available cameras

C200 View with 3D calibration settings presented

C201 3D data view presented

C202 3D calibration started

C203 3D calibration finished successfully

C204 3D calibration failed

C205 3D calibration interrupted and not ready

C207 Video Edit view presented

C209 3D settings ignored since missing 3D license

C211 Initializing CinePlex

C212 Initializing cameras at start

C213 Disconnected from IP address

C214 Connected to IP address

C215 View with 3D settings presented

C216 Extended Color Markers tracking stopped

C217 Tracking switched to Extended Color Markers mode

C218 3D calibration failed: there are cameras without reference frame

C219 Temporary DV3 file [...] renamed to [...]

C220 Renaming temporary DV3 file [...] failed

C221 3D settings ignored due to mismatch between number of cameras used for this 
calibration and number of available sources

C222 No calibration data present

C223 Tracking settings ignored since they are incompatible with the current license

C224 Screen saver and power management disabled

C225 Screen saver and power management enabled

Table 1: CinePlex Studio Simple Messages (Continued)

Message # Message Text
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C.4 CinePlex Studio Critical Messages

The table below lists the CinePlex Studio critical messages. In most cases, it is 
important for you to take action (or revise your previous action) when a critical 
message is displayed.

Note: In this table, [...] and <N> refer to text and numeric strings, respectively. These 
strings can differ for each instance of the message.

Table 2: CinePlex Studio Critical Messages

Message # Message Text

C898 MAP and CinePlex Studio out of synch.

C900 Clock signal not detected

C901 Clock signal detected

C902 Recording [...] stopped due to loss of clock OR RECORDING STOPPED AND/OR 
DISABLED! CLOCK or TRIGGER SIGNAL NOT DETECTED!

C904 Current CinePlex Studio does not support this version of settings file. Try to read 
another file.

C905 Can not be armed for remote recording before arena definition is finished

C906 Apparently Adobe Acrobat Reader is not installed on this system

C907 Cannot find the manual at: [...]

C908 Error code <N> has occurred while trying to open [...].

C999 Polygon can not have less than 3 points.

C910 Can not create self-intersecting polygons.

C911 Recording folder doesn’t exist. Please choose another one.

C912 Saved layout does not exist

C913 Unable to load the requested layout! The default layout applied

C914 Can not be armed for remote recording until Wizard is exited.

C915 Can not start recording until Wizard is exited.

C916 Can not add new zone: number of zones of interest can not exceed 100.

C917 Can not add new zone: the boundary of the last existing zone is not defined.

C918 The number of shapes in arena can not exceed 100.

C919 The number of shapes in zone can not exceed 100.

C920 Overlapped zones are not allowed in sequence

C921 Can't delete selected zone since it is used for generation of tracking event(s). Modify 
the event(s) first.

C922 Can't delete selected zone since it is used in sequence(s). Modify sequence(s) first.
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C923 The number of events can not exceed 100.

C924 Can't delete the last remaining shape from the selected zone since it is used for 
generation of tracking event(s). Modify the event(s) first.

C925 Can not be armed for remote recording due to missing license key

C926 Can not add event since LED or Marker tracking mode is not selected.

C927 Can not add event since no LEDs selected.

C928 Can not add event since no markers selected.

C929 Can't delete selected sequence since it is used for generation of tracking event(s). 
Modify the event(s) first

C930 Unable to save current layout

C931 Can not add event combination since tracking mode is not selected.

C932 Can not add event combination since no single events are defined.

C933 Can not add new event combination since not all events for the last combination are 
defined.

C935 Can't uncheck selected LED since it is used for generation of tracking event(s). 
Modify the event(s) first.

C936 Can't uncheck selected marker since it is used for generation of tracking event(s). 
Modify the event(s) first.

C937 Can not add event since tracking mode is not selected.

C938 Can not add event since no LEDs selected

C939 Can not add event since no markers selected.

C940 No Rasputin or OmniPlex key found. Switching to offline mode

C941 Access I//O board is not found, but cameras are detected. Switch to test mode? 
Clicking YES will switch Studio to the test mode. Otherwise Studio will start in offline 
mode.

C942 Access I//O board is not found. Switching to test mode

C943 Access I//O board is not found. Switching to offline mode

C944 No clock signal from Plexon NDAQ, but cameras are detected. Switch to test mode? 
Clicking YES will switch Studio to the test mode. Otherwise Studio will start in offline 
mode.

C945 No clock signal from Plexon NDAQ. Switching to test mode

C946 No clock signal from Plexon NDAQ. Switching to offline mode

C947 Recording is stopped, since recordings longer than 1 min are not allowed in test 
mode

Table 2: CinePlex Studio Critical Messages (Continued)

Message # Message Text
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C948 Can not add new sequence since the previously added sequence contains no zones.

C949 Can not add new sequence since the last zone in the previously added sequence is 
undefined.

C950 The number of sequences can not exceed 100.

C951 Can't delete selected sequence since it is used for generation of tracking event(s). 
Modify the event(s) first.

C952 Can not add new zone to the current sequence since the last zone in the sequence 
is undefined.

C953 Sequence can not contain more than 100 zones.

C954 Can not add new zone to the current sequence since no zones is defined.

C955 Files opened have different compression. Record, Play, Pause and Stop will be 
disabled.

C956 Files opened have different frame rate. Record, Play, Pause and Stop will be 
disabled.

C957 Can not open the same file twice.

C958 Start and end point of head direction vector should be different.

C959 Start point of head direction vector and end point of reference vector should be 
different.

C960 Can't associate selected LED with event since this LED is associated with dynamic 
zone used for generation of this event. Select another LED.

C961 Loading startup settings from [] failed because this version of settings file is not 
supported by Current version of CinePlex Studio

C962 Current Cineplex Studio does not support this version of settings file. Try to read 
another file.

C963 Loading last saved settings file [...] failed because the file is missing. Factory default 
settings have been applied

C964 Settings loading failed because file [...] is missing.  Factory default settings have 
been applied

C965 No settings file to load. Factory default settings have been applied

C966 Can not start recording due to missing license key

C967 Can not start recording since disk information can not be retrieved

C968 Can not start recording. File number can not exceed 999. Delete or rename video 
(*.AVI and *.DVT) files in the recording folder and try again

C969 Can not start recording due to low disk space.

C970 Can not add arena due combination to missing license key

Table 2: CinePlex Studio Critical Messages (Continued)

Message # Message Text
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C971 Can't associate dynamic zone with selected LED since this LED is used for 
generation of event associated with this zone. Select another LED.

C972 Can't associate dynamic zone with selected Marker since this Marker is used for 
generation of event associated with this zone. Select another Marker.

C973 Only Motion JPEG RGB files are accepted. Record, Play, Pause and Stop will be 
disabled.

C974 Files opened have different frame resolution. Record, Play, Pause and Stop will be 
disabled.

C975 Only resolution 640x480 or 320x240 is supported. Record, Play, Pause and Stop will 
be disabled.

C976 CinePlex only supports MJPEG or Plexon MPEG4 AVI files. Try another file.

C977 Video frame width must be a multiple of 16. Record, Play, Pause and Stop will be 
disabled.

C978 Video frame height must be a multiple of 8. Record, Play, Pause and Stop will be 
disabled.

C979 CinePlex Studio has not been connected as a Client since SortClient is not running. 
No coordinate data will be recorded in .PLX file

C980 CinePlex Studio has not been connected as an OmniPlex Client since PlexControl is 
not running. No coordinate data will be recorded in .PLX file

C981 CinePlex Studio has not been connected as an OmniPlex Client since CinePlex.dll is 
absent or damaged

C982 Display resolution is not enough to run all available cameras even in 320x240 
resolution. Number of cameras to use is reduced to fit the display resolution.

C983 Connections should be different.

C984 Connection points must be different.

C985 Open socket failed

C986 No network connection found

C987 Cannot connect to selected node.

C988 Cannot apply calibration: Number of cameras in the calibration file less than number 
of active cameras. Please try different calibration file or deactivate cameras.

C990 Camera switched to 320x320 resolution because of multi-camera license. One-
camera license required to run 960x960 resolution for this camera.

C991 Cannot have resolution exceeding 320x320 because of multi-camera license. One-
camera license required to run 960x960 or 640x640 resolution for this camera.

C992 Video signal detected

Table 2: CinePlex Studio Critical Messages (Continued)

Message # Message Text
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C993 Video signal not detected

C994 This CinePlex Studio (N camera license) requires minimum w x h screen resolution 
or higher

C995 Cannot write to the file. The file might be opened by other application. Please close 
the file first

C996 This CinePlex Studio (N camera license) cannot accept W x H frame resolution

Table 2: CinePlex Studio Critical Messages (Continued)

Message # Message Text
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D.1 Overview

This appendix contains detailed reference information about menus, toolbars, 
dialog boxes, and windows for CinePlex® Editor. By default, the Welcome To 
CinePlex Editor dialog box appears when CinePlex Editor starts. This dialog 
box provides streamlined access to operations that are also available under the 
File menu. 

• Start a New CinePlex Project - This button starts the New Project 
Wizard, which assists in setting up a new CinePlex project. See “New 
Project” on page D-28.

• Open an Existing CinePlex Project - This button opens a file browser 
that allows selection of an existing CPJ file.

• Open the Selected Recent CinePlex Project - This button operates on 
the list box of the most recently used CPJ files. Select one and click Open the 
Selected Recent CinePlex Project to load that project. Alternately, double-
click the project CPJ file in the list box to open it.

You can choose whether or not the welcomes dialog box appears after CinePlex 
Editor is started; to prevent the dialog box from appearing, click Do not show 
this dialog box on startup. To have the dialog box reappear, from the Tools 
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menu, click Options, click the Display tab, and select Initially show 'Welcome 
To CinePlex' Dialog Box.
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D.2 Main Window

This section describes the CinePlex Editor Main window as shown below.

D.2.1 Video Window

The Video window by default is in the upper-right corner of the main window.

D.2.1.1 Function

The Video window displays the current frame of the video file. If the timecode 
and/or filename were inserted into the video, they are also displayed.

Video WindowMenu and Toolbar

Markers 
Window

Input 
Window

Channels 
Window

Activity 
Window

‘__’ Marker Occurrences Window
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D.2.1.2 Features

Features of the Video window include:

• Customizable Window - You can customize the user interface. CinePlex 
Editor features a docking window architecture (see “Windows” on page E-6) 
that enables you to

— float individual windows to any location

— dock windows to various positions

— close windows as needed 

— resize windows by clicking and dragging the splitter bars that divide 
them.

• Resizable Video - By default, the Video window stretches or shrinks the 
native video resolution (typically 640 X 480) to match the size of the Video 
window. You may also configure it to always show the video at its native 
resolution regardless of the size of the Video window by unchecking the 
Resize Video to Fit Window item on the right-click menu.

• Coordinate Marker Crosshairs - If coordinate markers are present with 
their Show checkboxes selected, the coordinates in effect for the current 
video frame appear as crosshairs superimposed over the video image. The 
crosshairs appear in the display color set for the coordinate marker. The range 
for coordinates is always (0,0) to (1023,767) with (0,0) being in the lower-left 
corner, regardless of the video resolution. Before plotting the crosshairs, 
CinePlex Editor scales the marker coordinates to the video resolution. Also, 
the coordinates that appear in the Video window are always those that are 
relevant for the frame in the display—not necessarily the selected marker 
occurrences. That is, if different coordinate marker occurrences are selected 
in the Marker Occurrences window, in general it does not change the 
coordinate crosshairs shown in the Video window. Note that if coordinates 
have not been computed or supplied for a frame, the values for the prior frame 
are used.

• Grid Lines - You have the option of showing grid lines overlaid on the video 
and also determining the spacing and color of the grid lines.

• Tails - While the video plays, it is possible to show the crosshairs with a tail 
line that shows the coordinate positions of previous frames. The length and 
width of this tail may be configured. By default, the tail changes color 
according to the age of the points. The tail color results from a blending of the 
marker color with another specified color; the blending amount increases for 
older points. If a Fade-to Color similar to the background color of the video 
is chosen, a fading effect is created that makes the tail appear to fade away. If 
the current time frame is rapidly advanced by using either the find functions 
or the Activity window scroll bar, CinePlex Editor can produce a confusing 
display for the rendered tails. In this case, from the right-click menu, select 
Clear Tails to erase the tail. Also, you may draw a complete version of the 
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tail by selecting Show Complete Tail from the right-click menu. The Show 
Complete Tail feature is useful, for example, for determining the locations 
visited by the tracked animal. If the mouse pointer is moved outside of the 
Video window, the complete tail is erased. This menu item shows a line 
connecting the coordinates for all marker occurrences for the Coordinates 
marker, as shown in the following image:

D.2.1.3 Video Right-click Menu

The right-click menu allows changing of the behavior of the window, which 
includes controlling the tail rendering and stretching the video. Click the right 
mouse button to open the right-click menu for the Video window: 

• Resize Video To Fit Window - When checked, this item resizes the video 
to fit the Video window. When unchecked, the video appears at its native 
resolution regardless of the size of the Video window.

• Clear Tails - Clicking this item clears the tails from the video window if the 
Render Tails checkbox has been set on the Video View Properties dialog 
box.

• Show Complete Tail - Clicking this item shows the complete tail from the 
whole video file if the Render Tails checkbox has been set on the Video 
View Properties dialog box.

• Properties - Clicking this item opens the Video View Properties dialog 
box. The properties are discussed below.
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— Resize Video to Fit Window - This item stretches or shrinks the video 
to fit the size of the Video window. If not checked, the video is shown 
at its native resolution of 640x480 pixels.

— Rendering - This area contains items that controls how the video is 
presented in the Video window:

– Coordinate Marker Crosshairs Size – This item controls the size 
of the crosshairs drawn at the current Coordinates marker position.

– Draw Grid Lines – This item draws a grid of lines over the Video 
window. 

– Spacing – This item controls the spacing of the grid lines, which 
appear in Coordinates marker units of (0,0) to (1023,767).

– Color – This item controls the color of the grid lines. Select a color 
from the drop-down list.

— Tails - This area contains items that control the appearance of the 
tracking tell tails:

– Render Tails – This item toggles on or off the rendering of the tails 
that show previous Coordinates marker positions. 

– Length – This item controls the length of the tails, which is 
measured by the number of previous positions that appear in the 
window. 

– Line Width – This item controls the width of the line used to draw 
tails, which is measured in marker occurrences.

– Fade – This item controls whether or not the tail fades away.

– Fade-to Color – This item controls the color to which the tails 
fade. Fading occurs as follows:
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The color drawn at point p in the tail, where p = 0 for the current position and p 
= L (Length) for the oldest position is:
the rendered color at p = (p/L) x FC + (1-(p/L)) x DC
where
DC = display color for the current Coordinates marker
FC = Fade-to Color

— Previous Position Dots Along Tails – This area contains the items that 
control the rendering of the small dots that indicate the previous 
positions:

– Color – This item controls the color of the small dots at the 
coordinates of previous marker occurrences. 

– Size – This item controls the size in marker occurrences of the 
small dots at the coordinates of previous Coordinates marker 
occurrences. 

– Draw Every – This item controls a factor that only draws a dot at 
every Nth previous position.

– The image below shows a segment of the Video window with larger 
previous-position dots and Draw Grid Lines enabled.
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D.2.2 Activity Window

In many ways, the Activity window is the heart of CinePlex Editor. The default 
docking position is at the bottom of the main window. This truncated view shows 
each important item or area in the Activity window. 

D.2.2.1 Function

The Activity window displays markers and marker occurrences against their 
associated timelines.

D.2.2.2 Features

This section describes the various elements in the Activity window as shown in 
the illustration above.

• Channel Zoom Controls - The vertical zoom buttons appear at the left 
side under the top banner of the Activity window, as the image below shows. 
Click + to vertically zoom in on the display so that fewer time-lines appear, 
but each time-line is taller. This is the equivalent of selecting Zoom In to 

Show Fewer Time-lines from the right-click menu. Click – to zoom out, 
which is the equivalent of selecting Zoom Out to show More Time-lines 
from the right-click menu. You can also vertically scroll the time-lines in any 
of the following ways:

— If the mouse has a wheel, by rotating it. This works when the mouse 
pointer is positioned anywhere inside the Activity window.

Channel Zoom Controls

Time Range Zoom Controls
Marker and Unit Labels

Time Range Scroll Bar

Times of Unit Firings

Marker Times

Current File Position
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— By pressing the PAGE UP or PAGE DOWN keys

— By dragging in the vertical direction in the label area 

• Marker and Unit Labels - A label for each time-line appears on the left 
side of the Activity window. You can resize the label area by dragging the 
dividing line between it and the rest of the window. By default, CinePlex 
Editor selects the Automatically Adjust Label Area Width item in the 
right-click menu, which means that the dividing line continually adjusts so 
that the labels fit into the label area. To keep the size of the label area 
constant, click to clear the Automatically Adjust Label Area Width item in 
the right-click menu; this means the beginning of larger marker names can get 
truncated. If the divider line is dragged, CinePlex Editor automatically clears 
the Automatically Adjust Label Area Width item.

• Time Range Zoom Controls - The bottom of the Activity window 
contains the Zoom Out button, the Zoom In button, and the scrollbar for 
expanding, contracting, and moving the time range displayed by the Activity 
window. Each end contains boxes showing the current minimum and 
maximum extents of the displayed time range in seconds. 

• Time Range Scroll Bar - Use the scroll bar at the bottom of the display to 
move the time span of the display. When the scroll bar is moved, the video 
frame that appears in the Video window is always updated to remain 
synchronized with the Activity window.

• Times of Unit Firings, Marker Times - The central area of the Activity 
window shows the times of marker occurrences and unit firings as colored 
tick marks that are arranged along horizontal time-lines. By default, CinePlex 
Editor provides a horizontal time-line on the display for each marker or spike 
channel whose Show column is checked in the Markers window or the 
Channels window. The color of the marker ticks results from the display-
color setting in the Markers window. The colors of the tick marks on the time-
lines for spike channels correspond to the unit classification of each spike. 
You can set the colors to associate with each unit; to do so, from the Tools 
menu, select Options and click the Colors tab. Also, if their respective Show 
column in Channels window is checked, CinePlex Editor provides line traces 
on the display for continuous data channels. To improve clarity, the Activity 
window devotes twice as much vertical space to the continuous data channels 
than it does to the marker or spike channels. You can drag the dividing line 
that separates the central area from the top banner. You can also drag a 
selected marker occurrence to a different time. To drag a marker occurrence 
to a new time, hold down the SHIFT key, click the marker occurrence, and 
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drag it to a new time. For Interval-type markers, the start and end times may 
be independently adjusted. For more information on the Activity window, see 
“Selecting and Editing Marker Occurrences” on page 114. When CinePlex 
Editor is appropriately configured, click the mouse in the Activity window to 
perform the following actions:

— Select the marker occurrence for the currently selected marker nearest 
in time (default). Double click to select a new current marker.

— Add a new marker occurrence

— Change the timestamp of an existing marker occurrence

• Current File Position - The top banner contains the now triangle, which 
denotes and displays the current time (or current file position). The current 
time indicator (now triangle) is the white triangle in the following image. The 
current time (t) in seconds appears to the left of the triangle, and the current 
video frame (F) number appears to the right of it. By default, CinePlex Editor 
positions the triangle in the center of the Activity window, but it can be 
dragged to a new location in the top banner. This causes the Activity window 
to display an asymmetric range for the activity surrounding the triangle. For 
example, from 1 second before to 3 seconds after the triangle position. You 
can control the time range shown. The range surrounds the current time, 
which is denoted by the small triangle at the top of the display. The text next 
to the triangle shows the current time (in seconds) and the current frame 
number. You can click and drag the current time triangle to a different 
position within the window of time shown.

D.2.2.3 Activity Right-click Menu

The Activity window has many options that can be controlled by using the right-
click menu.
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• Automatically Adjust Label Area Width - This item causes the dividing 
line between the labels on the left and the central portion of the view to 
automatically adjust to accommodate the longest marker name.

• Show Unsorted Spikes - Selected by default, this item shows tick marks 
for unsorted spikes in the color chosen to represent unsorted spikes, or else 
the spikes do not appear.

• Hide Invalidated Spikes - Selected by default, this item hides tick marks 
for invalidated spikes; clearing this item causes tick marks to appear in a dark 
grey color.

• Show All Units for a Channel on One Time-line - Selected by default, 
this item plots each spike channel with a single time-line, and plots spikes 
with different units from that channel on the same time-line, but with 
different colors according to their unit classification. Clearing this item 
causes each unit to appear on a separate time-line. The channel name plus a 
letter of the alphabet denoting the unit appear as a label for the per-unit 
timelines. That is, if the channel sig001 has two defined units and some 
unsorted spikes and if Show Unsorted Spikes is checked, there are 3 time-
lines for that channel, which appear as sig001U (unsorted), sig001a, and 
sig001b.

• Show Markers Across All Time-lines - Normally, each marker appears 
as its own time-line in the display. Select this item to make each marker 
appear as a vertical line drawn across all of the other channels. This 
arrangement makes it somewhat easier to tell when marker occurrences 
happened with respect to spikes. The following image shows the Activity 
window with the Show All Units for a Channel on One Time-line item 
cleared and the Show Markers Across All Time-lines item selected:

• Show Markers On Top Time-lines - Selected by default, this item shows 
the time-lines for the markers at the top of the view, before the spike or 
continuous channel time-lines. Clearing this item causes the marker channels 
to appear at the bottom. This item is only relevant if the Show Markers 
Across All Time-lines item is cleared.

• Show Line for Each Time-line - This item draws a horizontal line in the 
middle of each time-line.
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• Zoom Out ..., Zoom In to Show Fewer Time-lines - As previously 
discussed, this item shows more or fewer time-lines.

D.2.3 Markers Window

The Markers window is the central location for information about markers. The 
image below shows the Markers window.

D.2.3.1 Function

The Markers window shows a quick overview of the important properties of the 
markers defined in the current project, and it provides easy access to all marker-
related operations.

D.2.3.2 Features

A >> in the leftmost column indicates the currently selected marker. The columns 
in the Markers window show the following information about each marker:

• Name – Shows the name given to each marker.

• Type – Indicates the marker type, as listed in Table D-1 on page 72.

• Count – Shows the number of occurrences of this marker.

• Key – Indicates the keyboard key associated with the marker.

• Show – When selected, this item displays the occurrences of this marker in 
the Activity window, and also in the Video or Scalar windows as appropriate 
for the marker type.

• Display Color – Shows the color used to display occurrences of this marker 
in the Activity, Video, or Scalar windows. Click a marker in the Display 
Color column to open a color selection dialog box, which allows changing 
the display color for a marker. 

D.2.3.3 Markers Right-click Menu

Right-clicking the mouse in the Markers window opens a right-click menu.
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• Define New Marker - This item opens the Define New Marker dialog box.

— Type - In the Type area, select a marker type for the new marker. For a 
description of all marker types, see Table D-1 on page 72. Under most 
circumstances, a new Frame marker cannot be created.

— Name - Enter a unique name for the new marker. Marker names must 
be unique. 

— Comment - This is an optional box in which a free-form comment that 
describes the new marker may be typed.

— Associated Keystroke - This area identifies the keystroke that is 
associated with this marker, which can be used for finding or inserting 
new marker occurrences. CinePlex Editor suggests an unused key; 
click Change to open the Assign Key dialog box and select a different 
key. When the dialog box appears, press the key to associate and click 
OK.

Note: Only single-keystrokes (not CTRL- or ALT- key combinations) can be 
associated with Markers.

— Display - This area identifies the display color and the show setting for 
the marker.
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– Color – This box shows the display color for this marker in various 
windows. You can also set the color directly in the Marker window.

– Show – This item toggles the appearance of the Marker in various 
windows. You can also set this item directly in the Marker window.

— Event IDs - This area shows the Event IDs associated with the marker. 
Use these IDs only when this marker is exported to a PLX file. These 
event IDs are the Plexon external event IDs that represent this marker 
in the PLX file. For interval-type markers, a second event ID must be 
specified to represent the end time for the interval. 

Note: These IDs must be unique across all markers. CinePlex Editor suggests an 
unused and unique value for these IDs, so they do not usually require 
immediate attention when the marker is first created. If the data is exported to a 
PLX file, there will be an opportunity to change these event IDs.

Note: You can also click Generate Occurrences to have CinePlex Editor create the 
marker and also automatically populate the new marker with algorithmically-
generated marker occurrences. The available methods for automatically 
populating the marker with marker occurrences varies by marker type; for a 
description, see “Automatically Generating Marker Occurrences” on page 106.

— OK - Click OK to close the dialog box and create the new marker. 

• Edit Selected Marker - This item opens the Edit Marker dialog box.

Note: You can also open the Edit Marker dialog box from the right-click menus in the 
Markers and Marker Occurrences windows.

The marker type cannot be changed for an existing marker. However, it is 
possible to change the following marker items:
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— Name - Enter a unique marker name. Marker names must be unique. 
Duplicates are not accepted during the Add Marker process.

— Comment - Add, add to, or edit a free-form comment that describes the 
marker.

— Associated Keystroke - This area identifies the keystroke that is 
associated with this marker; click Change to open the Assign Key 
dialog box and select a different key. When the Assign Key dialog box 
appears, press the key to associate and click OK.

Note: Only single-keystrokes can be associated with markers. CTRL- or ALT- key 
combinations are not valid.

— Display - This area identifies the display color and the show setting for 
the marker.

– Color – This box shows the display color of this marker in various 
windows. Select a new color from the drop-down list.

– Show – This item toggles the appearance of the marker in various 
windows. Change as needed.

— Event IDs - This area shows the Event IDs associated with the marker. 
These event IDs are used when this marker is exported to a PLX file; 
for more information, see Event IDs on page D-39. Change the event 
IDs as needed.

• Delete Selected Marker - This item deletes the selected marker and all of 
its occurrences.

• Delete All Highlighted Markers - This item deletes all selected markers 
and all of their occurrences.

• Delete All Occurrences of Selected Marker - This item deletes all of 
the occurrences of the selected marker, but does not delete the selected 
marker.

• Make Copy of Selected Marker - This item copies the selected marker to 
the clipboard.

• Set As Top Row - Sets the highlighted items in the Show or Display Color 
columns to the same value or color as the topmost value. 

• Randomize Display Colors - Sets random colors for all of the Display 
Color items.
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D.2.4 Input Window

D.2.4.1 Function

The Input window consists of an area of option buttons (left side of window) and 
an array of marker buttons (right side of window). The option buttons control the 
operation occurring with keystrokes, the marker buttons, or the left mouse button.

D.2.4.2 Features

The Input window includes selections for the following three actions:

• Keystroke – You can bind a keystroke to the current marker, which can be 
used to Find the next occurrence of the marker or Insert a new occurrence of 
the marker.

Note: If CinePlex Editor is in looping mode (see “Understanding Looping” 
on page 98), the search for the next marker occurrence wraps around 
the end of the file and continues the search at the beginning.

• Button – Specific marker buttons appear in the array on the right side of the 
Input window. Click a marker button to Find the next occurrence of the 
marker or Insert a new occurrence of the marker.

• Left-Click – This item refers to a click of the left mouse button in the 
Activity window. Select finds the nearest occurrence of the selected marker. 
Insert inserts a new occurrence of the selected marker at the time 
corresponding to the mouse pointer position when the left mouse button is 
clicked.

D.2.5 Channels Window

D.2.5.1 Function

The Channels window displays all of the channels in the neural data file and their 
associated properties.
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D.2.5.2 Features

The columns in the Channels window list the following information for each 
channel:

• Name – Shows the name of the channel

• Type – Indicates the type of channel, either spike or continuous

• Count – Shows the number of spikes for spike channels, or the number of 
samples for continuous channels

• Show – When selected, shows the spikes or continuous data from that 
channel in the Activity window

• Unsorted, Unit a, b, c, ... – Indicates the number of spikes in the channels 
that are unsorted, or that belong to Unit a, Unit b, etc.

Note: By default, if the Show checkbox is clear, any continuous data channels in the 
neural data file do not appear in the Activity window.

D.2.5.3 Channels Right-click Menu

Clicking the right mouse button will open a right-click menu with the following 
items:

• Show All Channels With Spikes - Clicking this item resets the window 
to show all channels with spikes.

• Un-Show All Channels - Clicking this item resets the window to hide all 
channels.

• Show Only Selected Channel - Clicking this item resets the window to 
only show the selected channel.

• Set As Top Row - Clicking this item sets selected columns to the same 
value as the same columns in the top row.
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D.2.6 File Info Window

The File Info window does not appear by default. To open the File Info window, 
from the View menu, select File Info View. 

D.2.6.1 Function

The File Info window shows various items of information about the neural data 
files and video files that are currently loaded into CinePlex Editor.

D.2.6.2 Features

The File Info window contains the following items:

• CinePlex Project File - This area contains information about the currently 
opened CinePlex project file.

— File Name: - This item contains the name of the project file.

— Comment: - This editable item contains comments about the project 
file.

• Video Data File - This area contains information about the currently opened 
video data file.

— File Name: - This item contains the name of the video data file.

— Time & Date (from file): - This item contains the time and date that 
the video data file was last modified.
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— Video Size: - This item contains the resolution of the video data file. 
Default is 640 X 480.

— Frame Rate: - This item contains the frame rate of the video data file. 
Default is 30 frames per second.

— Number of Frames: - This item contains the total number of frames in 
the video data file.

— Has Timestamps: - This item indicates if the frames are timestamped 
or not.

• Neural Data File - This area contains information about the currently 
opened neural data file.

— File Name: - This item contains the name of the neural data file.

— Time & Date (from header): - This item contains the time and date 
that the neural data file was last modified.

— Comment: - This item contains comments about the neural data file. 
This field is not editable in the File Info window.

— File Size (bytes): - This item contains the size of the neural data file in 
bytes.

— Experiment Length (sec): - This item contains the duration of the 
experiment in seconds.

— Format Version: - this item contains the format version of the file.

— Channels: - This item contains the total number of channels.

— Data Type: - This item contains the data type. Values are Single or 
Trodal.

— Timestamp Frequency (Hz): - This item contains the frequency at 
which the timestamps are created. Default is 40,000 Hz.

— A/D Frequency (Hz): - This item contains the analog-to-digital 
frequency. Default is 40,000 Hz.

— Total Number of Waveforms: - This item contains the total number of 
waveforms in the neural data file.

— Cont. Channels: - This item contains the number of continuous 
channels.

— Peak Voltage (mV): - This item contains the peak voltage of the 
signals in millivolts.

— A/D Resolution (bits): - This item contains the analog-to-digital 
resolution in bits. Default is 12.

— Total Number of Units: - This item contains the total number of 
occurrences for all channels.



CinePlex Behavioral Research System  

Version 3 D-21

— Number of Channels with Units: - This item contains the number of 
channels that have units.

— Avg Units per Active Chan: - This item contains the ratio of Total 
Number of Units to Number of Channels with Units.

D.2.7 Audio Output Window

The Audio Output window is hidden by default. To open the Audio Output 
window, hover the mouse over the Audio tab of the sidebar tabs at the right side 
of the screen, select Audio Output from the View menu, or click the Audio 
Output View button on the toolbar. The image below shows the Audio Output 
window.

D.2.7.1 Function

The Audio Output window controls CinePlex Editor’s ability to play a sound 
through the computer’s audio system when Markers or neural spikes occur during 
data playback.

D.2.7.2 Features

The columns of the Audio Output window include:

• Name - This column contains the name of each marker.

• Type - This column contains the type of each marker.

• Count - This column contains the number of occurrences of each marker.

• Play - This column contains a checkbox that controls whether any sound will 
be played when the Markers or neural spikes of that type pass by the ‘current 
time’ marker during animated playback.

• Sound - This column contains a droplist that lists all the available sounds 
that CinePlex Editor can play. If the Play checkbox is checked, the sound 
selected in the Droplist will play when an occurrence of the corresponding 
Marker or neural spike is encountered during playback. The contents of this 
list can be controlled from the Audio tab of the Tools | Options... dialog, see 
“Options” on page D-58.
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D.2.7.3 Audio Output Right-click Menu

The Audio Output Window has a right-click context menu that contains the 
following menu entries:

• Show Units - The Audio Output view can show just one line per neural 
spike channel (the default). In this mode, CinePlex Editor will play the same 
selected sound when any spike occurs on that channel, regardless of the unit 
designation of that spike. When Show Units is checked, each unit on each 
channel gets a separate line, as shown in the above screenshot. In this mode, 
every unit can have a different sound mapped to it and can be independently 
enabled or disabled for playing. This selection is equivalent to checking or 
unchecking the ‘Show Units in the Audio Output Window’ checkbox on the 
Tools | Options | Audio tab.

• Select Sounds - Clicking this item will show the Audio tab on the Tools | 
Options dialog box, which allows loading new sounds from WAV files so that 
they are available for mapping to Markers or Units.

D.2.8 Messages Window

To open the Messages window (hidden by default), hover the mouse over the 
Messages tab of the sidebar tabs at the right side of the screen, select Messages 
from the View menu, or click the Messages View button on the toolbar.

D.2.8.1 Function

The Messages window displays timestamps and application events and is used 
for troubleshooting purposes by Plexon Support.

D.2.8.2 Features

• Time - This column contains timestamps of the events.

• Message - This column contains descriptions of the events.

D.2.8.3 Messages Right-click Menu

Right-clicking the mouse in the Messages window displays the right-click menu.



CinePlex Behavioral Research System  

Version 3 D-23

• Erase - Clicking this item erases all messages from the Messages window.

• Pause - If this item is checked, message logging is paused.

• Show Debug Messages - If this item is checked, then debug messages 
will appear in the Messages window. This can be useful for troubleshooting.

• Select and Copy All - Clicking this item selects all the messages and 
copies them to the clipboard.

• Save Log to File - Clicking this item displays a standard file save dialog 
box and allows the message log to be saved to a file.

• Mail Log to Plexon - Clicking this item will sent the messages log to 
Plexon for troubleshooting. Note that a mail client and associated account 
information must be present on the computer for E-mail to work.

D.2.9 Marker Occurrences Window

The Marker Occurrences window includes an entry for each occurrence of the 
currently-selected marker. The currently-selected marker occurrence appears 
with a > in the first column. Click any marker to make it the currently-selected 
marker. More than one Marker Occurrences window may be opened. The 
window also changes title and columns depending on the marker type of the 
currently-selected marker. 

D.2.9.1 Function

The function of the Marker Occurrences window is to display information about 
all occurrences of the currently selected marker.

D.2.9.2 Features

The features of the Marker Occurrences window will vary according to the type 
of selected marker. A coordinate marker will have the timestamp, an x-
coordinate, and a y-coordinate while an interval marker will have the beginning 
timestamp and the ending timestamp as shown in the images below.
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Scrolling the Activity window or animate time causes the Marker Occurrences 
window to update continually to show the marker occurrences closest to the 
current time.

D.2.9.3 Marker Occurrences Right-click Menu

Right-clicking the mouse in the Marker Occurrences window opens a right-click 
menu.

• Go to Selected Marker Occurrence Time - Clicking this item makes the 
time of the currently-selected marker occurrence the current time. This will 
advance the current frame and reposition the Activity window.

• Add, Edit, and Delete Marker Occurrence Menu Items - The items in 
the section below ‘Go to Selected Marker Occurrence Time’ except for 
“Delete Highlighted Marker Occurrences” are the same as the items on the 
Edit menu. For complete information, see “Edit Menu” on page D-38.

There are three different ways to display marker occurrence data:

• Show Values in Decimal - Clicking this item displays the marker 
occurrence data in normal decimal format.

• Show Values in Hex - Clicking this item displays the marker occurrence 
data in hexadecimal format.

• Show Values as VT Bit Fields - Clicking this item displays the marker 
occurrence data as VideoTracker (VT) bit fields. For more information on VT 
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bit fields, see “Marker Occurrences and the Marker Occurrences Window” on 
page D-73.

• Copy and Select All - These items function as standard Windows® copy 
and select functions.

• Properties - Clicking this item displays the Marker Occurrences View 
Properties dialog box.Clicking this item enables the configuration of marker 
occurrence windows to show the marker occurrences of a specific marker 
instead of the currently selected marker. This capability may be used to 
display marker occurrences simultaneously for different markers on screen.

— Marker To Display - This area contains a drop-down list of markers. 
The currently selected marker appears in the dimmed list box.

— Display Format for Scalar Marker Values - This area contains items 
that control the display format for Scalar markers:

– Decimal – This item displays the Scalar markers in decimal format.

– Hex – This item displays the Scalar markers in hexadecimal format.

– VideoTracker – This item displays the Scalar markers in Plexon 
VideoTracker format.

D.2.10 Scalar Window

Scalar windows do not appear by default in CinePlex Editor. To open a Scalar 
window, from the View menu, select New Scalar View.

D.2.10.1 Function

The Scalar window provides an at-a-glance graphical representation of a scalar 
value as a pointer arrow on a scale.
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D.2.10.2 Features

The Scalar window re-orients itself depending on the size of the view. If the 
Scalar window is tall and narrow, the pointer points horizontally. If the Scalar 
window is short and wide, the pointer points vertically. Like the coordinate 
crosshairs in the Video window, the position of the pointer always reflects the 
value for the selected marker occurrence. The numerical value also appears next 
to the pointer. Like the Marker Occurrences window, there can be multiple Scalar 
windows on the screen at once, with each one showing a different scalar marker. 

D.2.10.3 Scalar Right-click Menu

Right-clicking in the Scalar window displays the following menu:

• Reverse Arrow Direction - By default, the Scalar window re-orients itself 
depending on its size. If the Scalar window is tall and narrow, the arrow is 
horizontal. If the Scalar window is short and wide, the arrow is vertical. By 
default, the arrow points either left or up, but the direction may be reversed by 
selecting Reverse Arrow Direction from the right-click menu. The position 
of the arrow always reflects the value for the selected marker occurrence. As 
shown in the following image, the numerical value of the selected scalar 
marker occurrence also appears at the base of the arrow.

Like the Marker Occurrences window, there can be multiple Scalar windows on 
screen at once, with each one showing a different Scalar marker. 

• Reset Automatic Range Adjustment - By default, CinePlex Editor 
automatically adjusts the range of scalar values to accommodate the range of 
scalar values that appear in the data as new Scalar values become current. You 
can reset the range by selecting Reset Automatic Range Adjustment from 
the right-click menu, which sets the range to dynamically expand based on 
the subsequent values that appear. Alternately, a fixed range may be set in the 
Scalar View Properties dialog box.

• Properties - Clicking the Properties item displays the Scalar View 
Properties dialog box.
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— Marker To Display - This area contains the items that control which 
marker appears in the Scalar window:

– Use Selected Marker – This item displays the current value for a 
new marker in the Scalar window, if the marker is a Scalar type. 

– List box – Clearing Use Selected Marker causes the Scalar 
window to display the values of the Scalar marker that appears in 
the drop-down list, regardless of which marker is selected.

— Layout - The area contains the items that control the appearance of the 
Scalar window:

– Automatic – This item sets the Scalar window to automatically 
switch its layout from horizontal to vertical based on the current 
size of the Scalar window. For example, if the window is taller than 
it is wide, a vertical layout appears, otherwise a horizontal layout 
appears. 

– Horizontal – This item sets the Scalar window to a horizontal 
layout, regardless of the dimensions of the Scalar window.

– Vertical – This item sets the Scalar window to a vertical layout, 
regardless of the dimensions of the Scalar window.

– Reverse Arrow Direction – This item toggles the direction that the 
indicator arrow points between up/down for horizontal layouts and 
left/right for vertical layouts.

— Range to Plot - This area contains the minimum and maximum values 
to show on the scale:

– Automatically Set Range from the Data – This item 
automatically and dynamically adjusts the range as new values are 
encountered in the Scalar marker occurrences. The current range 
being plotted always appear dimmed in the Minimum and 
Maximum boxes. 
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– Fixed Range – This item allows entering specific values for the 
range in the Minimum and Maximum boxes.

D.3 Menus

Menus provide access to CinePlex Editor features, commands, controls, and 
settings. The following sections describe each CinePlex Editor menu in detail. 
You can also use the toolbar buttons to execute many of the commands that 
appear on the CinePlex Editor menus.

D.3.1 File Menu

The following image shows the File menu. 

D.3.1.1 New Project

This item opens the New Project Wizard dialog box which proceeds through the 
necessary steps to set up a new project. In the Welcome To CinePlex dialog box, 
click Start a New CinePlex Project to open the New Project Wizard dialog 
box. Otherwise, from the File menu, click New Project.
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The first box in the New Project Wizard dialog box helps to select filenames. 

Note: Specify a video file or a neural data file, or both.

• Video Data Input File (AVI) - This box allows you to specify a filename 
for the video file. The video file must be an Audio Video Interleave (AVI) 
file. 

• Neural Data Input File (PLX, NEX, DVT) - This box allows you to 
specify a file name for the neural data file. The neural data file can be a 

Plexon data (PLX) file, a NeuroExplorer® NEX file, or a digital video tracker 
(DVT) file.

• CinePlex Project File (CPJ) - This box requires you to specify a filename 
for the CinePlex Project (CPJ) file.

• Browse - This button allows you to open a file selection dialog box. When 
one filename is selected, CinePlex Editor suggests names for the remaining 
unspecified filenames, which are based on the selected filename. 

• Select From Directories - This button opens the Select Video and Neural 
Data Files dialog box, which provides a convenient alternative to Browse, 
where it is possible to display and match pairs of files from two directories. 
The Select Video and Neural Data Files dialog box provides list boxes for 
two different directories. You can use the various features of this dialog box 
to create project files.
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— Video Data Input File (AVI) - This area displays AVI files, file system 
dates, and times. Click the … button to select a different directory for 
the video data files.

— Neural Data Input File (PLX, NEX, DVT) - This area displays PLX, 
NEX, and DVT files, file system dates, and times. Click the … button 
to select a different directory for the neural data files.

— Sort Files by Date - This checkbox is checked by default and causes 
the files to be sorted by date. Click to clear this checkbox to sort by file 
name. 

— Sync Directories - If this checkbox is checked, it forces the two 
directories to be identical, which can save the effort of having to 
reselect the same directory again if the video and neural data files 
happen to reside in the same directory. 

— Neural Data Extensions - These checkboxes allow you to select the 
extensions for the neural data files to appear in the list box.

Whenever a file is selected from one of the list boxes, the dialog box attempts to 
select the file from the other list box that best matches the file selected. This 
feature is very convenient for matching up the files collected using CinePlex 
Studio with their corresponding PLX files, because the file dates and times 
should be nearly the same.

When the correct files have been highlighted in the two directory listings, click 
OK to enter the selected files into the appropriate text boxes in the New Project 
Wizard dialog box. After entering the correct filenames, click Continue >> to 
open the Verify Project Files dialog box.
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The Verify Project Files dialog box provides complete information on the files 
being entered into the project. It lists relevant information for each file type.

• CinePlex Project File - This box lists the project file location and name.

• Video Data File - This box lists the video file location and name.

• Time & Date (from file) - This box shows the date and time (hh:mm:ss) 
when the video file was saved.

• Duration - This box indicates the duration of the video file in seconds.

• Number of Frames - This box lists the total number of frames in the video 
file.

• Frame Rate - This box indicates the frame rate at which the video was 
recorded.

• Resolution - This box shows the resolution of the video in pixels.

• Has Timestamps - This box indicates Yes if timestamps are contained in 
the video file and No if otherwise.

• Format - This box shows the video compression format of the file.

• Neural Data File - This box lists the neural file location and name.

• Date/Time - This box shows the date and time (hh:mm:ss) when the neural 
file was saved.

• Duration - This box indicates the duration of the neural file in seconds.

• Channels - This box lists the number of data channels in the neural file.

• Event Types - This box lists the number of different event types contained 
in the neural file.
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After verifying that the correct files have been selected, click Continue >> to exit 
the Wizard. CinePlex Editor creates the initial project file. 

Note: To have the directories containing the files selected appear as the defaults the 
next time CinePlex Editor starts, from the Tools menu, choose Options, click 
the General tab, and select Use the last directory of the previous session 
as Initial Directory.

Note: Keep the related project (CPJ), neural data (PLX) and video (AVI/DVT) files 
together in the same folder. Then, after you open the CPJ file, the system will 
automatically find the appropriate PLX and AVI/DVT files.

D.3.1.2 Open Project

This item opens a standard Windows Open dialog box to allow choosing an 
existing project file (CPJ) to open.

D.3.1.3 Save Project, Save Project As, and Close Project

These items apply to a CPJ file and it’s related video file and neural data file. 
These commands use standard Windows dialog boxes.

D.3.1.4 Import Markers

This item opens a standard Windows Open file-selection dialog box. When a file 
is selected, CinePlex Editor imports the file to create new markers in the project; 
for more information, see “Importing Markers” on page 115.

D.3.1.5 Export Markers

This item opens the Export Marker Data dialog box. The Export Marker Data 
dialog box includes all the items to set prior to exporting the file. The following 
image shows the default view of the dialog box.
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• Format - This area provides a choice of two file types: Text file or comma-
separated-values (CSV) file. 

• Delimiter to use between values - This dropdown allows you to select 
one of the following delimiters to use between the columns of text (if Text 
File is selected for the format):

— Comma

— Comma, space

— Space

— Semicolon

— Tab 

• Export a Row of Column Headers - This checkbox allows exporting the 
first row as a row of textual labels for each column, which can be helpful 
when you are reading the exported data file.

Note: CinePlex Editor exports marker occurrences for all formats as one occurrence 
per row, and all rows have the same number of entries. The number of entries 
in each row depend on the selections made in the What to Export for Each 
Marker Occurrence area. 

• Which Markers - The default value is Selected Marker only. Selecting All 
Markers causes the occurrences for all markers to be exported.
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• What to Export for Each Marker Occurrence - The selections in this 
area determine which columns appear for each marker occurrence (row). The 
available columns always appear in a fixed order; clearing a checkbox 
removes the column. The available items for export are:

— Marker Name – This item includes the textual name of the marker in 
the exported file. The marker name is generally useful only when 
selecting All Markers to export, otherwise the marker name is the 
same for all marker occurrences when selecting Selected Marker only 
to export.

— Marker Type (Number 1-7) – This item exports a number that 
indicates the type of the marker, as indicated in the following table:

Note: For a complete explanation of the marker types, see “Understanding 
Markers and Marker Occurrences” on page 72.

— Marker Event ID – This item exports the Event ID associated with 
this marker; for more information, see Event IDs on page D-39.

— Marker Event ID 2 - This item exports the second Event ID associated 
with this marker. This item applies only if the marker is an Interval, 
Level Interval, or Zone Interval type.

— TimeStamp - This item exports the time of the marker occurrence. For 
Interval-type events, this is the start time. 

Note: You can export timestamps in units of seconds or in raw clock ticks; see 
“Export TimeStamps in units of”, which follows in this list.

— TimeStamp2 (End Time for Intervals) - This item is only relevant for 
Interval-type marker occurrences and it exports the end time. 

— Value 1 (Scalar value, or X Coordinate) - This item exports different 
things, which depend on the marker type. For Scalar markers, it exports 
the scalar value. For Coordinate markers, it exports the X coordinate 
value. For all other markers, it exports -1.

1 Time-only

2 Frame

3 Interval

4 Scalar

5 Coordinates

6 Level Interval

7 Zone Interval
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— Value 2 (Y Coordinate) - This item exports different things, which 
depend on the marker type. For Coordinate markers, it exports the 
T coordinate value. For all other markers, it exports -1.

— Export TimeStamps in units of – You can export time stamps in one 
of the following units:

– Seconds – This item exports the values for TimeStamp and 
TimeStamp 2 in seconds.

– Clock Ticks – This item exports the values for TimeStamp and 
TimeStamp 2 in raw ticks of the system clock.

• Output File - Type or select the output file name in the File box. Under 
Format, click the Append if existing checkbox to append the marker data 
onto the end of a file that already exists on disk. Otherwise, the existing file is 
overwritten.

CAUTION
Set the Append if existing checkbox correctly
Pay special attention to the Append if existing checkbox. 
If it is checked, the new marker data will be appended to the existing 
file.
If it is unchecked, the new export file will overwrite the current 
export file.
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D.3.1.6 Export to PLX

This item opens the Export To PLX dialog box.

• File - Type an export file name and path, or click Browse and select an 
existing file. 

• Export invalidated spikes - Click this checkbox to export invalidated 
spikes to the PLX file. Invalidated spikes appear with a unit number of 0 
(unsorted).

• Marker Mapping to Event IDs - This list box controls which markers 
appear in the output file and which event IDs represent them. Only Time-
only, Frame, and Interval-type markers appear in this list box; Scalar and 
Coordinates markers must be represented by strobed events. To remove 
individual markers from the output PLX file, click to clear the Write? 
checkbox. You can also change the event IDs by typing a new value in the 
Event ID column. There are two entries in the list box for each Interval-type 
marker, one for the start time and another for the end time.

• What to Export as Strobed Events - Select one of these items to export:

— Original Strobed Events (Passthrough Mode) – Select this item to 
pass unchanged the strobed event data blocks from the original neural 
data file through to the output PLX file. Use this mode when if not 
interested in representing any changes to any Scalar or Coordinates 
marker occurrences in the output file, or if there are not any Scalar or 
Coordinates data to output.
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— Scalar Marker – Select this item to represent the values from a single 
Scalar marker in the strobed events. Select the Scalar marker from the 
list.

— Coordinate Markers – Select one of the following combinations:

– Click LED 1, LED 2, or LED 3 or any combination of these LEDs. 
For each LED, select a corresponding Coordinates marker from the 
drop-down list.

– To export coordinates for the centroid position, click Centroid Pos 
and select a corresponding Coordinates marker from the drop-down 
list.

– To include Motion Measure data, click Centroid Pos and click a 
corresponding Coordinates marker from the drop-down list; then 
click Motion and select a corresponding Scalar marker from the 
drop-down list. For more information on the Motion Measure 
option, see “Motion Measure Option” on page 175.

Note: Select only one of the preceding combinations. If an LED is clicked, 
do not click Centroid Pos. Likewise, do not click Motion without 
clicking Centroid Pos. 

• Export! - Click Export! to close the dialog box and write the new PLX file.

D.3.1.7 Export to NEX

This item opens the Export To NEX dialog box.

• File - Type an export file name and path, or click Browse and select an 
existing file. 

• What to Export - This area includes the following items:

— Frame Markers – CinePlex Editor exports frame markers to the NEX 
file as just another marker variable. To inhibit this, click to clear the 
Frame Markers checkbox.

— Unsorted spike timestamps – CinePlex Editor exports both sorted and 
unsorted spike timestamps to the NEX file by default. To export only 
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the sorted spike timestamps, click to clear the Unsorted spike 
timestamps checkbox.

— Continuous data channels – By default, CinePlex Editor exports any 
continuous channels present in the original neural data file as 
continuous variables to the NEX file. To prevent continuous data being 
written to the NEX file, click to clear the Continuous data channels 
checkbox.

• Export! - Click Export! to close the dialog box and create a new NEX file.

D.3.1.8 Print, Print Preview, and Print Setup

These items are standard Windows print commands. The Print command will 
output the CPJ file to an installed printing device.

D.3.1.9 File list

This section includes up to 10 of the most recently opened files.

D.3.1.10 Exit

This item closes all windows and exits CinePlex Editor.

D.3.2 Edit Menu

The following image shows the Edit menu. 

D.3.2.1 Undo

This item provides multiple undo levels. Operations that change the contents of 
the project file may be undone, but operations that change the user interface 
options or colors cannot be undone.

D.3.2.2 Copy

This item is the standard Windows copy command.
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D.3.2.3 Define New Marker

This item opens the Define New Marker dialog box.

• Type - In the Type area, select a marker type for the new marker. For a 
description of all marker types, see Table D-1 on page 72. Under most 
circumstances, a new Frame marker cannot be created.

• Name - Enter a unique name for the new marker. Marker names must be 
unique. 

• Comment - This is an optional box in which to insert a free-form comment 
that describes the new marker.

• Associated Keystroke - This area identifies the keystroke that is 
associated with this marker, which can be used for finding or inserting new 
marker occurrences. CinePlex Editor automatically suggests an unused key; 
click Change to open the Assign Key dialog box and select a different key. 
When the dialog box appears, press the key to associate and click OK.

Note: Only single-keystrokes (not CTRL- or ALT- key combinations) can be 
associated with Markers.

• Display - This area identifies the display color and the show setting for the 
marker.

— Color – This box shows the display color this marker in various 
windows. The color can also be set directly in the Marker window.

— Show – This item toggles the appearance of the Marker in various 
windows. This item can also be set directly in the Marker window.

• Event IDs - This area shows the Event IDs associated with the marker. Use 
these IDs only when exporting this marker to a PLX file. These event IDs are 
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the Plexon external event IDs that represent this marker in the PLX file. For 
interval-type markers, a second event ID must be specified to represent the 
end time for the interval. 

Note: These IDs must be unique across all markers. CinePlex Editor suggests an 
unused and unique value for these IDs, so they do not usually require 
immediate attention when first creating the marker. If exporting the data to a 
PLX file, there will be an opportunity to change these event IDs.

Clicking Generate Occurrences causes CinePlex Editor to create the marker and 
also automatically populate the new marker with algorithmically-generated 
marker occurrences. The available methods for automatically populating the 
marker with marker occurrences varies by marker type; for a description, see 
“Automatically Generating Marker Occurrences” on page 106.

• OK - Click OK to close the dialog box and create the new marker. 

D.3.2.4 Edit Selected Marker

This item opens the Edit Marker dialog box. An image of the dialog box 
follows:

Note: The Edit Marker dialog box may also be opened from the right-click menus in 
the Markers and _Marker Occurrences windows.

The marker type for an existing marker cannot be changed. However, it is 
possible to change the following marker items:

• Name - Enter a unique marker name. Marker names must be unique. 
Duplicates are not accepted during the Add Marker process.
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• Comment - Add, add to, or edit a free-form comment that describes the 
marker.

• Associated Keystroke - This area identifies the keystroke that is 
associated with this marker; click Change to open the Assign Key dialog box 
and select a different key. When the Assign Key dialog box appears, press the 
key to associate and click OK.

Note: Only single-keystrokes can be associated with markers. CTRL- or ALT- key 
combinations are not valid.

• Display - This area identifies the display color and the show setting for the 
marker.

— Color – This box shows the display color of this marker in various 
windows. Select a new color from the drop-down list.

— Show – This item toggles the appearance of the marker in various 
windows. Change as needed.

• Event IDs - This area shows the Event IDs associated with the marker. 
These event IDs are used when exporting this marker to a PLX file; for more 
information, see Event IDs on page D-39. Change the event IDs as needed.

D.3.2.5 Delete Selected Marker

This item deletes the selected marker and all occurrences of that marker.

D.3.2.6 Copy Selected Marker

This item copies the selected marker to the clipboard.

D.3.2.7 Add New Marker Occurrence

This item opens the New Marker Occurrence window.

Note: CinePlex Editor identifies marker occurrences by their time, thus no two 
marker occurrences can have the same time. Adding a new marker occurrence 
with the same timestamp as an existing marker occurrence replaces the 
existing marker occurrence with the new one; that is, it is overwritten and the 
old data values are erased. Editing an existing marker occurrence by changing 
its timestamp to be the same as another existing marker occurrence replaces 
the existing marker occurrence.
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• Marker - This box shows the marker for which a new occurrence is being 
added. 

• Time - This is time of the new marker occurrence and its related data values. 
The data values depend on the marker type. For example, for Coordinates 
markers, the X and Y data values appear as shown in the image, but for 
Interval markers, start and end times appear.

D.3.2.8 Edit Selected Marker Occurrence

This item opens the Edit Marker Occurrence dialog box.

• Marker - This box shows the marker whose occurrence is being edited. 

• Time - This is time of the marker occurrence and its related data values. The 
data values depend on the marker type. For example, for Interval markers, the 
start Time and End Time appear as shown in the image, but for Coordinates 
markers, X and Y data values appear.

D.3.2.9 Delete Selected Marker Occurrence

This item deletes only the selected occurrence for the marker.

D.3.2.10 Delete All Marker Occurrences

This item deletes all occurrences for the selected marker, but leaves the marker 
itself intact.

D.3.2.11 Keystroke ..., Button Press ..., and Left-Click Inserts Marker

These items determine which user action inserts markers. For information on 
marker insertion, see “Understanding Markers and Marker Occurrences” on 
page D-72.
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D.3.3 View Menu

The following image shows the View menu. 

All the items in this menu open or close a window in CinePlex Editor.

D.3.4 Animate Menu

The following image shows the Animate menu. 

D.3.4.1 Play

This button automatically advances time at a rate determined by the time 
multiplier. Selecting Play when already playing causes a Pause condition.

D.3.4.2 Pause

This button halts the automatic advance of time. Play and Pause are mutually 
exclusive. Press SPACEBAR to toggle between Play and Pause. Selecting Pause 
when already paused resumes play.
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D.3.4.3 Slower

If pressed while playing at any speed, this button slows down the rate of time 
progression by half until the speed is 1/256 of normal. Continued pressing 
reverses the direction and increases the speed.

D.3.4.4 Faster

This button speeds up the rate of time progression by a factor of 2. The UP ARROW 
key and the DOWN ARROW key are equivalent to the Slower and Faster buttons. 
Continued clicking will eventually cause the speed to reach a maximum of 256 
times normal.

D.3.4.5 Reset to 1X Speed

This button sets the rate of time progression to 1X normal speed.

D.3.4.6 Step Backwards

This button advances time to the previous video frame. The LEFT ARROW key is 
equivalent to this button.

D.3.4.7 Step Forward

This button advances time to the next video frame. The RIGHT-ARROW key is 
equivalent to this button.

D.3.4.8 Rewind

This button sets the current time to the time of the first video frame.

D.3.4.9 Reverse

This button reverses the flow of time at the current time rate. If already in reverse, 
it goes forward.

D.3.4.10 Lock to Video Frames

This button advances time by increments of whole frames only. CinePlex Editor 
does not change the current time at all until enough time has elapsed to make a 
new video frame the current frame. Then it sets the current time to be the exact 
time of the frame marker corresponding to that frame. This is the default mode.

Note: A potentially confusing effect occurs when CinePlex Editor is in Frame Locking 
mode. If the video capture was paused during acquisition so that there is a gap 
of time that contains no frame marker occurrences, animation appears to 
freeze at the point where the gap starts until enough time passes such that the 
next video frame is current, which can be much later. Conversely, when 
CinePlex Editor is not in Frame Locking mode, the animation continues 
smoothly through the gap and time advances without regard to video frame 
boundaries. The video frame remains unchanged until the next one is 
encountered.

D.3.5 Looping Menu

The following image shows the Looping menu.
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D.3.5.1 Toggle Looping

This item turns looping on or off for the interval selected in the list. Select this 
option to turn looping on during play back when a specific interval appears that 
should be reviewed. Playback loops from the beginning to the end of the interval. 
Click again to resume normal playback.

D.3.5.2 Select Looping Interval

This item opens the Looping Interval dialog box to allow a looping interval to 
be defined. An image of the dialog box follows:

• Loop over entire file - This is the default selection. CinePlex Editor plays 
the file to the end and restarts from the beginning. 

• Loop over an Interval Marker Occurrence - This selection makes 
CinePlex Editor loop over the time span defined by a specified occurrence of 
an interval marker. When selecting this option, choose the interval marker 
from the drop-down list and then choose the specific occurrence of the 
interval marker to loop over.

— Nearest Occurrence – uses the occurrence nearest to the current time

— Use Selected Occurrence – uses the specific occurrence selected from 
the drop-down list

• Loop over an arbitrary time interval - This selection makes CinePlex 
Editor loop over an arbitrary interval of time specified in the Start and End 
boxes. Use the Looping toolbar controls to control looping parameters; see 
“Looping Toolbar” on page D-68.
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D.3.6 Find Menu

The following image shows the Find menu.

D.3.6.1 Find Marker Occurrences

This item opens the Find Marker Occurrences dialog box to choose which 
marker to find. Either find the selected marker or choose from a dropdown list. 
An image of the dialog box follows:

• Use Selected Marker as Marker To Find - By default, CinePlex Editor 
loads the current marker into the Marker To Find list box. To select another 
marker from the drop list, click to clear the checkbox and select another 
marker in the Marker To Find box.

• Marker To Find - Click to clear the Use Selected Marker as Marker To 
Find checkbox and select a marker from the drop-down list.

D.3.6.2 Find Forward

This item searches forward for the next selected marker. 

D.3.6.3 Find Back

This item searches backward for the next selected marker. 
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D.3.7 Tools Menu

The following image shows the Tools menu. 

D.3.7.1 Freezing Detector Function

See “Using the Freezing Detector” on page 119 for details about this function.

D.3.7.2 Levels Editor

This item opens the Levels Editor window. Use the Levels Editor dialog box to 
define level interval markers and generate marker occurrences for them. An 
image of the dialog box follows:
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• Scalar Marker To Use - This box contains the scalar marker to use for 
generating levels.

• Generate All - This button generates marker occurrences for all the Level 
Interval markers that appear in the Level Intervals box.

• Generate Selected - This button generates marker occurrences for the 
selected level interval, which appears with a >> in the left-most column in the 
Level Intervals box.

Note: Clicking either Generate All or Generate Selected deletes all existing marker 
occurrences for the affected Level Interval markers, and generates a new set of 
occurrences according to the current Scalar marker and conditions.

The graph in the middle of the Levels Editor window shows the values of the 
selected Scalar marker as a function of time. The horizontal range of time that 
appears is always the entire file. The vertical scaling of the plot always adjusts to 
show the full range of the scalar data values. The levels appear as horizontal lines 
on the display, with the above or below setting for each level shown as either 
upward- or downward-pointing arrows on the lines. The number on the left 
indicates whether the line represents Level 1 or Level 2. 

Note: Positioning the mouse pointer inside this portion of the editor causes the scalar 
value corresponding to the pointer position to appear in the edit box at the 
bottom right of the display.

• Level Intervals - This area contains a grid that has a line for each defined 
level interval. Select level intervals by clicking in the grid. Set the condition 
by editing the grid fields. When defining multiple Level Interval markers, 
only the one selected in the Level Intervals box displays. Click any level 
interval to select it. The selected level interval appears with a >> in the 
leftmost column of the grid. The columns shown in the grid are:

— Level Interval Marker – This column contains the name of the Level 
Interval marker. The name can be changed by changing the text in this 
field.

— Color – This column contains the color associated with the Level 
Interval marker. To change the color, click in this field to bring up a 
color selection dialog box.

— The next five columns together define the condition for the Level 
Interval marker. The column arrangement forms a condition statement, 
for example “Above 175 AND Below 200.”

– Abv/Blw – This column contains the above or below indicator for 
the first level. To change the condition, click in this field to open a 
drop-down list and select Above or Below.

– Level 1 – This column contains the numerical value for the first 
level. Type a numerical value in this field or click and drag 
horizontal line 1 on the graph.
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– Oper – This column contains the logical operator between the two 
halves of the condition. The available selections in the drop-down 
list are AND, OR, or N/A. Selecting N/A means that there is only 
one level in the condition; CinePlex Editor ignores the last two 
columns and a second line on the graph does not appear. 

– Abv/Blw – This column contains the Above or Below indicator for 
the second level, which only applies if N/A is not selected.

– Level 2 – This column contains the numerical value for the second 
level, which only applies if N/A is not selected. Type a numerical 
value in this field or click and drag horizontal line 2 on the graph. 

• Add - This button opens the Define New Marker dialog box to add a new 
Level Interval marker.

• Delete - This button deletes the selected interval level.

• Center Lev1 and Center Lev2 - By default, CinePlex Editor sets the level 
intervals to the middle of the display range shown in the graph, which it 
determines from the range of scalar values encountered for the selected Scalar 
marker. Click these buttons to re-position the corresponding level line to the 
center of the view again.

• Done - Click Done to close the editor. CinePlex Editor stores the conditions 
with the Level Interval marker and displays them when the Levels Editor re-
opens.
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D.3.7.3 Zones Editor

This item opens the Zones Editor window. An image of the dialog box follows:

• Coordinates Marker To Use - This box lists the Coordinates marker used 
to define the zone.

• Generate All - This button generates marker occurrences for all the level 
intervals that appear in the Zone Intervals box.

• Generate Selected - This button generates marker occurrences for the 
selected Level Interval marker, which is indicated by the >> in the left-most 
column in the Level Intervals box.

Note: Clicking either Generate All or Generate Selected deletes all existing marker 
occurrences for the affected Zone Interval markers, and generates a new set of 
occurrences according to the current Coordinates marker and conditions.

• Zone Intervals - This area lists all the defined Zone Interval markers. 

— The leftmost column lists the interval number; the selected Zone 
Interval marker appears with a >> in the leftmost column. 

— Zone Interval Marker – This column lists the names of the Zone 
Interval markers. Add or change names by typing in this field.

— Color – This column shows the colors of the zone boundaries. To 
change a color, click the color to open a color selection dialog box.

— Add – This button adds a coordinate to the selected zone. 

— Delete – This button deletes the selected Zone Interval marker.
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• Coordinates of the Selected Zone - This area lists the coordinates of the 
currently selected Zone Interval marker. The zone of a Zone Interval marker 
consists of a list of 2D coordinates (X and Y) that define the closed contour. 
Define these contours by clicking on the screen image (see Add that follows), 
or by individually adding and typing in the coordinate values in the columns. 

— The leftmost column lists the coordinate number; the selected 
coordinate appears with a >> in the leftmost column.

— X – This column contains the X coordinate distance from the lower left 
corner (zero distance).

— Y – This column contains the Y coordinate distance from the lower left 
corner (zero distance).

— Clear - This button completely clears all points from the current zone. 
Click Add to re-enter the zone.

— Add - This button puts the Zones Editor into the click-to-add mode. 
The first left-click in the main window defines the first point in the 
contour, subsequent left-clicks continue to define the contour. A right-
click ends the drawing and closes the contour.

— Edit - This button enables the currently selected point to be re-
positioned. After clicking Edit, move the mouse pointer to the desired 
location on the main window. The contour continually re-adjusts as the 
mouse pointer moves. Left-click to select the new position, or right-
click to cancel the operation and revert to the previous position.

— Delete - This button deletes the currently selected point from the zone 
contour. The contour re-adjusts automatically for the remaining points.

When the Zones Editor dialog box is opened, the main view shows the same 
video frame that CinePlex Editor displays. By default, the zone for the currently 
selected Zone Interval marker appears superimposed on the video frame.

• Show Selected Zone - This is the default setting. It shows the zone for the 
currently selected Zone Interval marker superimposed on the video frame

• Show All Zones - Click this button to see all defined Zone Interval marker 
zones simultaneously.

• Show Complete Tail - Click this button to display a line connecting all the 
positions visited by the selected Coordinates marker. This can help to show 
what effect various placements of the zone boundaries can have when a zone 
is defined.

• Show Grid every - Click this button to superimpose a grid over the video 
image. Enter the grid spacing in the box. 

• Coordinates: X Y - When the mouse pointer moves over the main window, 
the corresponding coordinates of the mouse pointer appear in the X and Y 
edit boxes.



D  CinePlex Editor User Interface 

D-52 CinePlex Behavioral Research System 

• Done - Click Done when finished defining zone intervals.

D.3.7.4 Interval Operations

This item opens the Interval Operations dialog box.

• Interval Marker to Use - From the drop-down list, select a marker of the 
following type:

— Interval

— Level Interval

— Zone Interval

• Operation to Perform Using Interval Marker - In this area, choose one 
of the following operations:

— Invalidate Waveforms that occur within the Intervals – This 
selection invalidates all waveforms that occur within (inclusive) the 
interval marker. CinePlex Editor compares each waveform (spike time) 
in every channel against all occurrences of the interval marker to see if 
it falls within the start and end times. If it does, CinePlex Editor marks 
the waveform as invalid.

— Remove Occurrences within the Intervals, for Marker – This 
selection removes the occurrences of the marker selected from the 
drop-list, from within the intervals. CinePlex Editor compares the times 
of the occurrences of this marker to the selected interval occurrences, 
and removes any occurrences that fall within (inclusive) of any 
interval.

Note: In both cases, CinePlex Editor considers exact matches of the spike timestamp 
to the interval occurrence start or end times to be within the interval. For 
example, if spike time Tspike is inside the interval defined by Tstart and Tend, it 
means that the condition (Tspike >= Tstart) and (Tspike <= Tend) is true.
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— Negate the selected operation – This selection changes either of the 
previous selections to an exclusive function. Selecting Invalidate 
Waveforms that occur within the Intervals invalidates all waveforms 
that do not fall between the start and end times (exclusive) of any 
interval marker occurrences. Selecting Remove Occurrences within 
the Intervals, for Marker removes all occurrences of the selected 
marker that do not occur within the times spanned (exclusive) by any 
interval marker occurrence. The text in the Interval Operations dialog 
changes as follows:

D.3.7.5 Shift Marker Occurrences

This item opens the Shift Marker Occurrences dialog box. An image of the 
dialog box follows:
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Use this dialog box to add a constant offset, which can be negative, to all 
timestamps of a marker. It is useful for aligning neural data with the video data.

• Marker - Select a marker to shift from the drop-down list.

• First Occurrence Time - This is the time that the first occurrence of the 
marker appears.

• Last Occurrence Time - This is the time that the last occurrence of the 
marker appears.

• Range - This is the time span between the first and last occurrences.

• Shift by _ secs - This selection shifts the occurrences by a constant amount. 
Enter the amount of shift directly in the edit box.

• Shift so that first Occurrence is at time _ secs - This selection 
calculates the shift amount by determining how much the first occurrence of 
the selected marker must be shifted to make it equal to the specified time. 
CinePlex then applies this shift amount to all occurrences.

• Shift so that the first Occurrence is at time of Marker - This selection 
shifts the time to that of another marker occurrence. Select the shift-
determining marker from the drop list. 

• Occurrence - Enter which occurrence of the shift-determining marker to 
use by typing its 1-based index into the edit box. 

D.3.7.6 Snap-To Marker Occurrences

This item opens the Snap-To Marker Occurrences dialog box. An image of the 
dialog box follows:

The purpose of the “Snap-To” functionality is to shift the occurrences of one 
marker to match up in time with the occurrences of another marker. However, 
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unlike the Shift Marker Occurrences functionality described on page D-53, the 
“Snap-To” functionality can shift each occurrence by a different amount.

• Marker To Adjust - From the drop-down list, select the marker occurrences 
to match up in time.

• Snap-To Occurrences of Marker - From the drop-down list, select the 
marker occurrence to match up to in time. 

Note: Typically, the Snap-To Occurrences of Marker are Frame marker types, 
which means the Marker To Adjust aligns with the times of the video frames.

The CinePlex Editor algorithm find the best match occurrence of the Snap-To 
Occurrences of Maker entry for every occurrence of the Marker To Adjust 
entry, and makes the Marker To Adjust occurrence time equal to the time of the 
best match occurrence. There are two ways that CinePlex Editor determines the 
best match occurrence of the “Snap-To” marker:

— Snap-to Previous Occurrence – This selection uses the occurrence 
that is just before the time of the occurrence being adjusted. The 
adjustment always reduces the time of the occurrence being adjusted.

— Snap-to Closest Occurrence – This selection uses the occurrence that 
is closest in time to the occurrence being adjusted. The adjustment can 
shift the occurrence being adjusted ahead or behind in time.

• Snap interval start and end times independently - Because interval-
type markers consist of two times (a start time and an end time), they are 
treated differently and they are controlled by this checkbox. When this box is 
checked, CinePlex Editor snaps both the start and the end times to their 
respective best match occurrences. This can change the length of the interval. 
When the checkbox is cleared, CinePlex Editor uses the best match to the 
start time to shift the entire interval. In this case, the end time shifts by the 
same amount as is the start time, so the length of the interval remains 
constant.

D.3.7.7 Interpolate Missing Occurrences

This item opens the Interpolate Missing Occurrences dialog box. An image of 
the dialog box follows:
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• Marker - From the drop-down list, select the marker to interpolate.

• Periodicity - This box displays the periodicity results for the selected 
marker as follows:

— Tolerances for Gaps – For the gap analysis, the average separation 
between markers is determined. If the time gap between any two 
adjacent marker occurrences is not within the Tolerance for Gaps value 
(i.e. between (1-TFG) and (1 + TFG) times the average separation, it is 
marked as a gap.

— pairs – the number of pairs of adjacent times

— avg – the average time difference between pairs in seconds

— stddev – the standard deviation around the average time difference

— min – the smallest time difference encountered in seconds

— max – the largest time difference encountered in seconds

— non-gap avg – the average time difference in seconds when the 
discovered gaps are excluded from the calculation

• Gap Sizes - This box lists of the distribution of skipped occurrences (gaps); 
for example, 0 : nnn indicates the number of number of pairs without a 
missing timestamp between them, 1 : nnn indicates the number with one 
timestamp missing, 2 : nnn indicates the number with two missing 
timestamps, and so on.
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• Timestamp Determination - The area contains the following two 
selections:

— Assume Periodicity – This selection assumes that the data is periodic 
and adds marker occurrences accordingly.

— Use Frame Marker Times – This selection adds missing marker 
occurrences at the frame markers.

• Value Interpolation - The area contains the following two selections:

— Sample-and-hold the previous value – This selection assigns a value 
(or coordinates) to the new marker occurrences added to fill a gap, 
which is the same as the value (or coordinates) of the last pre-gap 
marker occurrence.

— Linear Interpolation – This selection assigns values to the new 
marker occurrences added to fill a gap that are calculated to fall on a 
line connecting the last pre-gap value (or coordinates) with the first 
post-gap value (or coordinates).

If the marker being interpolated is a scalar marker or a coordinates marker, the 
tool can calculate reasonable values to apply to the added marker occurrences by 
using one of two methods:

Generate new Time-only Marker at times for added Occurrences

• Generate new Time-only Marker at times for added Occurrences - 
This selection enables the tool to define and populate a new marker named 
Interpolated X, where X is the name of the marker being interpolated, and 
which has occurrences at the times where interpolated marker occurrences are 
added. In effect, this differentiates the occurrences of the selected marker that 
are generated via interpolation from those that are part of the original data.

How the Interpolation Algorithm Works

The interpolation tool is capable of calculating both the times at which new 
marker occurrences need to be added (that is, where the gaps appear), and for 
Scalar markers and Coordinates markers, what values need to be given to the 
added marker occurrences. Obviously, when finding the times where there are 
gaps, there is an implicit assumption of periodicity in the marker occurrences. 
This may or may not be the case with the marker occurrences for the selected 
marker, but the tool displays information that helps to determine the extent to 
which the periodicity assumption is valid.

When a marker is selected, the algorithm analyses the times of the occurrences 
for that marker, and displays the results in the two list boxes. The algorithm can 
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use or ignore the results of this analysis, depending on the following Timestamp 
Determination selections. The analysis proceeds as follows:

1 Consider each pair of adjacent times for the marker occurrences, and calcu-
late the time difference between each pair. The number of pairs appears in the 
left list box.

2 Find the min, max, average, and standard deviation on the set of calculated 
time differences. Display this information in the Periodicity list box as avg = 
for the average time difference, stddev = for the standard deviation around 
the average time difference, min = and max = for the smallest and largest 
time differences encountered. 

3 Assume that any difference between adjacent occurrences that is larger than 
1.1 times the average time difference constitutes a gap, or a skipped occur-
rence. Using this definition of a gap, compute and display a histogram of the 
sizes of the gaps in the Gap Sizes list box. The 0: line in this list box is to be 
interpreted as the number of timestamp pairs for which there were no gaps or 
missing timestamps between them. The next 1: line is the number of time-
stamp pairs for which there was a gap of 1 missing timestamp between the 
pair, and so on.

4 By ignoring the gaps, compute a new average time difference between 
adjacent, gap = 0 timestamp pairs. Display this as non-gap avg = in the 
Periodicity list box. Whereas the avg = value has factored in the gaps and 
thus produced a larger average time difference, the non-gap avg = has taken 
out the gaps, and so produces a smaller and in many cases more accurate 
estimate of the true periodicity. In effect, this is the periodicity that would be 
seen if it weren't for missing samples (gaps) in the occurrences.

D.3.7.8 Mark All Waveforms As Valid

This item re-validates any waveforms that were invalidated with the Interval 
Operations tool; see “Interval Operations” on page D-52.

D.3.7.9 Options

This item opens the Options dialog box with several tabs as described in the 
following sections.
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D.3.7.9.1 General Tab. 

• Initial Directories for Data Files - This area contains list boxes and 
controls for the initial project directories as follows:

— Initial Directory for Project (CPJ) Files – Type a directory location 
and name or click Browse and select and existing directory.

— Initial Directory for Video Files – Type a directory location and name 
or click Browse and select and existing directory.

— Initial Directory for Neural Data Files – Type a directory location 
and name or click Browse and select and existing directory.

— Always use the same Initial Directories – This selection sets the 
default initial directories to the directories entered.

— Use the last directory of the previous session as Initial Directory – 
This item sets the default initial directories to the directories used for 
the last project.

Note: If you move the original neural data or video files to the same folder on which 
the CPJ file resides, CinePlex Editor will find them automatically when it 
reopens the project file. If you move the original neural data or video files to 
some other location on the hard drive, CinePlex Editor prompts to locate the 
files when it reopens the project file.

• Project File-Save Behavior - When a project file is saved, from the drop-
down menu one may set one of the following default file-save behaviors:
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Note: On this menu, filename-0n means CinePlex Editor defaults to the first unused 
filename and adds a numeric increment 0 (zero) n (digit). For example, Test-01, 
Test-02, Test-03, etc.

• Number of Frames to Advance During Click-To-Add - Type the 
number of frames to advance when adding or editing coordinates in the Video 
or Scalar windows. For more information on Click-To-Add, see 
“Understanding Click-To-Add Mode” on page 101.

• Select Marker Occurrence For Current Time - Select this item to have 
CinePlex Editor automatically select, in the Marker Occurrences window, the 
most appropriate marker occurrence for the current time.

D.3.7.9.2 File Import Tab. 

• Reading Buffer Size - This area contains an input box for the reading 
buffer size setting and an advisory estimate of the amount of space 
waveforms take.

— Reading Buffer Size for data files (MB) – Type a size value for the 
reading buffer in megabytes (MB).

• Continuous Data - This area contains an input box for the size of the 
continuous-data channel buffer and a checkbox that disables the loading of 
continuous-data channels to PLX files.
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— Channel Buffer size for continuous data (MB) – Type a size value 
for the channel buffer in megabytes (MB).

— Disable loading continuous data channels for PLX files – This 
selection inhibits the loading of continuous data channels to PLX files.

— Default Timestamp Frequency (if not specified in loaded file) – If 
the initial neural data file does not specify a timestamp frequency (for 
example, a DVT file), enter a default timestamp frequency in Hz. 

D.3.7.9.3 Latency Correction Tab. For more details on latency correction, see 
“Correcting for Video Latency” on page D-76.

• Automatically compensate for video latency by adjusting Frame 
and Position Markers - this setting is checked by default. This setting 
compensates for the amount of time elapsed between the camera’s capture of 
the image to the computer’s timestamp of the video frame (the video latency). 
If there is data that was analyzed with previous versions of CinePlex Editor, 
there may be timestamp shifts and this setting could be unchecked for that 
data.

— Amount of time to shift Markers - Type the amount of time to shift 
the markers in seconds. The number should always be positive because 
the number is subtracted from the timestamps.

• Automatically snap Position Markers imported from PLX files to 
the previous Frame Marker - this setting is checked by default. This 
setting is applied automatically only when data is initially imported from a 
PLX file.

Note: When CinePlex is being used with Plexon’s MAP system, leaving the MAP on 
overnight could result in excessive latency - much greater than 30 milliseconds. 
If the MAP has been left on overnight, it is better to reset the MAP system.
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D.3.7.9.4 Display Tab. 

• Update Animation Every __ Milliseconds - Type an animation update 
frequency in milliseconds. This is the screen update rate while the video and 
data files play are playing. 

• Initially show ‘Welcome To CinePlex’ dialog box - This selection 
makes the Welcome to CinePlex dialog box appear at startup.

• Initially disable empty Spike Channels - This selection suppresses 
empty spike channels in the Activity window at startup.

• Initially disable Continuous Channels - This selection suppresses 
continuous channels in the Activity window at startup.
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D.3.7.9.5 Audio Tab. 

• Available Sounds - CinePlex Editor ships with a selection of four WAV 
files, and these sounds are available for playback in CinePlex Editor by 
default. However, any WAV file can be used, provided that CinePlex Editor 
knows where to find it on the hard drive. Before WAV file sounds can be 
mapped to Marker or spike occurrences in the Audio Output Window, they 
must be loaded into CinePlex Editor. The Available Sounds section lists the 
Sounds that are currently available for playback. Each sound has a Label that 
shows up in the droplist in the Sounds column of the Audio Output Window, 
and the full path to the WAV file that contains the sound.

• Add - Pressing Add... will show a file selection dialog followed by the Sound 
Selection dialog box which allows entering a Label used to represent that 
sound. Pressing the Play Sound button will play the sound, which is useful 
for previewing.

• Edit - Highlighting an existing sound in the list and pressing Edit... will show 
the Sound Selection dialog box and allow re-selecting the WAV file or 
changing the Label for a sound.
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• Remove - Highlighting an existing sound in the list and pressing Remove 
will remove the sound.

• Play Sound - Highlighting an existing sound in the list and pressing Play 
Sound will immediately play the sound, allowing it to be previewed.

• Reset to Defaults - Pressing the Reset to Defaults button will reset the list 
to contain the four sound files that are shipped with CinePlex Editor.

D.3.7.9.6 Colors Tab. 

• Display Elements - This area contains the following color choices for the 
main display:

HINT
Minimizing number of sounds to play
Computer audio hardware can only mix a certain number of sound 
streams together, so CinePlex Editor can only play about 10 sounds 
simultaneously. Sounds that overlap in time because they are played 
quickly one after the other count as simultaneous sounds. Therefore, 
it is quite easy for CinePlex Editor to overwhelm the audio 
subsystem by attempting to play too many sounds, as Markers or 
neural firings may occur at rates too fast for the audio system’s 
capabilities. When this happens, CinePlex Editor will play as many 
sounds as it can, but there may be gaps in the audio playback. To 
minimize this issue:
a) do not select many units or markers to be played at once. Even a 
single neural channel with a high firing rate can saturate the audio.
b) use WAV files that are as short as possible. In this regard the 
‘neuralclick.wav’ file is ideal, as it can be played very quickly.
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— Background – This is the background color of the Activity window.

— Text – This is the text color in the Activity and Video windows.

— Grid and zero line – This is the color of the grid and zero line in the 
Activity windows.

— Selection – This is the color of selected items in the Video and Activity 
windows.

— Restore Colors to Defaults – Click to restore the display elements to 
their default colors.

• Units - This area contains the color choices for each unit and unsorted 
waveforms.

— Unsorted – This is the color for unsorted waveforms.

— Invalidated - This is the color for invalidated waveforms.

— Unit a: ... Unit p – These are the color selections for up to 16 units.

— Restore Colors to Defaults – Click to restore the unit colors to their 
default colors.

D.3.7.9.7 Printing Options Tab. 

The selections on the Printing Options tab are the same as those on the Colors 
tab. See “Colors Tab” on page D-64
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D.3.8 Window Menu

For more details on the Window menu, see Window Menu, above.

D.3.9 Run Menu

D.3.9.1 PlexUtil

This item launches the PlexUtil application.

D.3.9.2 Offline Sorter

This item launches the Offline Sorter application.

D.3.9.3 NeuroExplorer

This item launches the NeuroExplorer application.

D.3.9.4 Explorer

This item opens Windows Explorer.

See also Run Menu, above. and “Run Menu Customization” on page E-21.

D.3.10 Help Menu

For more details on the Help menu, see “Help Menu” on page E-12.
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D.4 Toolbars

CinePlex Editor includes toolbars that provide access to features, commands, 
controls, and settings. Most features and commands are available on the toolbars. 
It is also possible to create toolbars from most of the dropdown menus on the 
menu bar. Briefly rest the mouse pointer over a button to see the button name. 
Descriptions of the toolbars follow:

D.4.1 Standard Toolbar

This toolbar includes typical Windows controls for file New, Open, Save, Cut, 
Copy, Paste, Print, Help, Undo, and Options. Except for Options, these are 
typical Windows controls. For information on Options, see “Options” on page D-
58.

D.4.2 Edit Toolbar

The Edit toolbar includes a series of buttons that manage markers and marker 
occurrences within CinePlex Editor. This toolbar has eight buttons that 
correspond to the marker and marker occurrences commands on the Edit menu; 
see “Edit Menu” on page D-38.

D.4.3 Views Toolbar

The Views toolbar includes a series of buttons that open the various windows 
within CinePlex Editor. Each window opens at its default size. This toolbar’s 
buttons are equivalent to the commands on the View menu; see “View Menu” on 
page D-43.

.

D.4.4 Animate Toolbar

The most convenient way to control the flow of time in CinePlex Editor is to use 
the time-control toolbar buttons. The associated Animate menu entries or 

HINT
Missing Buttons on the ViewsToolbar
If there are missing buttons on the toolbar, select Window | 
Customize | Toolbars, and select the line labeled View in the list box 
in the Toolbars tab. Do not uncheck the checkbox -- just select the 
line. Then press the Reset button.
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keyboard shortcuts may also be used; see “Animate Menu” on page D-43. The 
Animation Speed list box is the only Animate toolbar control that has no 
equivalent command on the Animate menu.

• Animation Speed - This list box provides a choice of time progression rates, 
where 1X is the normal speed. It has no equivalent on the Animate menu.

D.4.5 Looping Toolbar

The Looping toolbar includes a list of looping intervals over which the video file 
may be played, and two looping control buttons. The equivalent Looping menu 
entries or keyboard shortcuts may also be used; see “Looping Menu” on page D-
44.

D.4.6 Find Toolbar

The Find toolbar provides a drop down list that includes all markers. The 
equivalent Find menu entries or keyboard shortcuts may also be used; see “Find 
Menu” on page D-46.

By default, the currently selected marker appears in the list box. However, 
another marker may be selected from the drop down list. 

D.4.7 Tools Toolbar

The Tools toolbar includes two time-interval editors. One editor for a defined 
zone of the video window and one editor for level interval markers. The 
equivalent commands on the Tools menu may also be used; see “Tools Menu” on 
page D-47.
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D.5 How CinePlex Editor Creates Initial Project Files

When a new CinePlex project is created, CinePlex Editor reads both the neural 
data file and the video data file, and it generates markers and marker occurrences 
based on the contents of the files. After the initial file reading, CinePlex Editor 
stores the generated markers and marker occurrences in the project (CPJ) file. 
When the project file is re-opened, CinePlex Editor reads the markers and marker 
occurrences from the project file, not from the original neural data or video files. 
In this way, one may add, edit, shift, or delete markers without regard for what is 
actually in the original neural or video data files. However, when an existing 
project file is re-opened, CinePlex Editor still reads the neural data file in order to 
obtain the spike timestamps and continuous data, and it still reads the video file to 
obtain video frame images.

D.5.1 Reading Video (AVI) Files

When CinePlex Editor reads the video (AVI) file, it looks for timestamps 
embedded in the data stored with each frame. CinePlex Studio imbeds these 
timestamps. If the embedded timestamps are present, CinePlex Editor creates a 
special Frame marker, and it generates a marker occurrence for each video frame. 
See “Non-Typical Initial File Creation” on page D-70 if there are no embedded 
timestamps.

D.5.2 Reading Plexon (PLX) Files

When CinePlex Editor reads a Plexon (PLX) file during the initial project 
creation, depending on the contents of the PLX file, it can create and populate a 
number of different markers as follows:

• Non-strobed external events (type 4 data blocks) become Time-Only markers

• Strobed events become a single Scalar marker, with the scalar values set to 
the strobe values

• If strobed events are present, and CinePlex Editor identifies them to be in 
conformance with the Plexon VideoTracker protocol, then CinePlex Editor 
generates additional markers by interpreting the strobe codes as data 
produced by Plexon VideoTracker. Depending on the VideoTracker mode 
detected, CinePlex Editor creates the following markers:

— One, two, or three Coordinates markers with names like Position n to 
denote the tracker positions, when VideoTracker is in LED, Color 
Markers or Extended Tracking of Color Markers modes.

CAUTION
Upgrade Notice
If the system has been upgraded to CinePlex Studio 2.0, CinePlex 
Editor should also be update. The upgraded CinePlex Editor will 
read AVI files created by CinePlex Studio 1.0, 1.1, 1.2, and 1.4. 
However, earlier versions will not be able to read AVI files produced 
in version 2.0
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— A Coordinates marker named Centroid Position, when VideoTracker is 
in Object Contour tracking mode. 

— A Scalar marker named Centroid Motion, when the VideoTracker 
Motion Measure option is enabled.

Note: In Plexon VideoTracker protocol, if VideoTracker cannot locate the object being 
tracked it reports the positions for those frames as (0,0); for example, if a 
headstage cable occluded the LED for a frame VideoTracker reports that frame 
as “0,0”. When CinePlex Editor translates strobed events into Coordinates 
marker occurrences, it automatically ignores any (0,0) coordinates, which 
leaves gaps where there is no position data. The Interpolate Missing 
Occurrences tool can fill these gaps, see “Interpolate Missing Occurrences” on 
page D-55.

Note: Important: Spike waveforms and timestamps and continuous data from a PLX 
file are not converted into markers. 

D.5.3 Reading NeuroExplorer NEX Files

When CinePlex Editor reads a NEX file during the initial project file creation, it 
ignores the spike timestamps and continuous data. CinePlex Editor converts other 
NEX variables into CinePlex markers as follows:

• Event variables become Time-Only markers, unless the event variable has the 
exact name Frame Marker, in which case it becomes a Frame marker.

• NEX interval variables become interval markers.

• NEX marker variables that have one associated value become Scalar markers.

• NEX marker variables that have two associated values become Coordinates 
markers.

• CinePlex Editor ignores NEX marker variables with more than two 
associated values, and NEX population vector variables.

D.5.4 Reading Digital VideoTracker (DVT) Files

When CinePlex Editor reads a DVT file produced by CinePlex Studio during the 
initial project file creation, it always creates Frame marker occurrences. CinePlex 
Editor also produces Coordinates and Scalar markers for the coordinate and 
centroid motion data streams in the file, in a manner analogous to how it 
translates the strobed values into markers in a PLX file.

After creating the initial project, one may import additional markers from 
additional data files into the project; see Import Markers on page D-32. The 
import operation also follows the preceding rules. 

D.5.5 Non-Typical Initial File Creation

The normal operating mode for CinePlex Editor is to use an AVI file captured 
with CinePlex Studio so that frame timestamps are embedded in the AVI file; 
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then load a neural data file that contains neural firing timestamps. However, other 
modes of operation may be used:

• When using the New Project Wizard, leave either the video-file filename or 
the neural-data filename blank, but not both. In effect, this allows CinePlex 
Editor to be used to annotate video data without the presence of neural data, 
and vice versa.

• If the video data file is blank, the CinePlex Editor Activity window may still 
be used. If the neural data file contains VideoTracker coordinates that are 
based the Plexon VideoTracker protocol, CinePlex Editor still interprets them 
as Coordinates marker occurrences and displays them against a blank 
background in the video window. However, it requires an extra step in this 
case to generate Frame markers artificially. The New Project Wizard detects 
when this needs to be done, and it automatically prompts.

• If the neural data filename is blank, CinePlex Editor still functions; the video 
can be viewed in the normal way: advance frame by frame, animate, etc.

Note: In both of the previous cases, new markers can still be entered and defined. It 
is still possible to export the markers to any of the supported output-file formats.

• CinePlex Editor supports the use of AVI files recorded without the CinePlex 
Studio system, which therefore does not contain embedded timestamps. To 
use these files, Frame markers must be generated before using CinePlex 
Editor.

• CinePlex Editor can also read certain other AVI files, but those AVI files must 
use the Motion JPEG method for encoding and storing the video frames.
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D.6 Understanding Markers and Marker Occurrences

To use CinePlex Editor effectively, it is important to understand the difference 
between a marker and a marker occurrence. A marker is defined by its type and 
name. A marker occurrence is a specific insertion of a marker at a designated 
time. Each marker can have many marker occurrences associated with it. Before 
any marker occurrences for a given marker can be created, that marker must 
exist. To use concepts from object-oriented software methodologies, a marker 
corresponds to a class, and marker occurrences correspond to instances of that 
class.

Every marker has a marker type definition. Each marker occurrence stores at least 
one timestamp, along with other supplemental data, depending on the marker 
type. The following table describes each marker type and the information it stores 
for each occurrence:

Table D-1 Marker Types

Marker 
Type

Abbr
Information 

Stored
Description

Time Only T Timestamp Single happenings, where the only 
required information is the time of the 
happening. E.g. “Shock Applied”

Frame F Timestamp Special time-only marker applied 
automatically by CinePlex Studio to 
associate a time with each video frame.
Note: This marker always appears 
grayed out in the Define New Marker 
dialog box because it is system-
generated.

Interval I Start 
Timestamp, 
End 
Timestamp

Denotes a time interval over which 
something occurred. E.g. “Stimulus 
Applied” or “Valid Trial”

Scalar S Timestamp, 
Value

Denotes a value (stored in a 16-bit 
number) at a given time. E.g. the Motion 
Measure produced by the CinePlex 
Studio Tracking Option. 

Coordinates C Timestamp, 
X, Y

Denotes a pair of values (stored in 16-bit 
numbers) at a given time. E.g. Animal 
coordinates produced by the CinePlex 
Studio Tracking Option. 
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It is possible to open a quick reminder of the marker types and their 
abbreviations; see Quick Reference in “Help Menu” on page E-12. Throughout 
this manual, the marker types Interval, Level Interval, and Zone Interval are 
collectively referred to as interval-type markers or interval markers, as they share 
many common characteristics. 

CinePlex Editor uses the concepts of both a selected marker and a selected 
marker occurrence; that is, one may open a dialog box to edit the characteristics 
of a selected marker, and one may delete or edit the selected marker occurrence. 
CinePlex Editor also uses the concept of current time and a closely related 
current video frame. 

By default, whenever the current time is changed in CinePlex Editor, it 
automatically selects the most appropriate marker occurrence of the selected 
marker for the current time. However, to turn this behavior off, from the Tools 
menu select Options and on the General tab, click to clear the Select Marker 
Occurrence For Current Time checkbox.

D.6.1 Marker Occurrences and the Marker Occurrences Window

This section includes descriptions of the CinePlex Editor facilities for displaying, 
generating, and editing marker occurrences. 

The Activity window graphically shows where marker occurrences occur in time. 
The Video window and the Scalar window each show the data values associated 
with Coordinates and Scalar markers. But the Marker Occurrences window (see 
“Marker Occurrences Window” on page D-23) contains a concentration of 

Freezing 
Episode

FE Start 
Timestamp, 
End 
Timestamp

A special version of an interval marker 
where the intervals are automatically 
produced by applying a freezing 
detection operation to the values of the 
Motion Measure marker (using the 
Freezing Detector). E.g. “Rat Froze” 
instance.

Level 
Interval

L Start 
Timestamp, 
End 
Timestamp

A special version of an interval marker 
where the intervals are automatically 
produced by applying a thresholding 
operation to the values of a Scalar 
marker (using the Level Editor).

Zone Interval R Start 
Timestamp, 
End 
Timestamp

A special version of an interval marker 
where the intervals are automatically 
produced when the values of a 2D vector 
are inside a certain spatial zone (using 
the Zones Editor). E.g. “Rat In Maze Arm 
3"

Marker 
Type

Abbr
Information 

Stored
Description



D  CinePlex Editor User Interface 

D-74 CinePlex Behavioral Research System 

functionality for dealing with marker occurrences. The following Marker 
Occurrences window shows the numerical values of the marker occurrences for 
Position 1.

This image show the currently selected marker occurrence with a > in the 
leftmost column. The shortcut menu (see “Marker Occurrences Window” on 
page D-23) provides several operations that can be performed on marker 
occurrences. One may use other shortcut menu entries to select and copy text 
with marker occurrence information onto the Windows clipboard, and paste into 
other applications. In the Marker Occurrences window, the columns change 
according to the selected marker type as follows:

Table D-2 Column Displays for Various Marker Types

Note: Marker Occurrences are identified by time, so no two marker occurrences can 
have the same time. Attempting to add a new marker occurrence with the same 
timestamp as an existing marker occurrence causes CinePlex Editor to replace 
the existing marker occurrence with the new one, which deletes the old data 
values by overwriting them. Likewise, if an existing marker occurrence is edited 
by changing its timestamp to be the same as another existing marker 
occurrence, CinePlex Editor replaces the existing marker occurrence.

Also, when Scalar markers appear in the Marker Occurrences window, one can 
control the display format of the data values associated with each marker 
occurrence. One can use the shortcut menu items to display data values in 
decimal (the default), hexadecimal, or as Plexon VideoTracker bit fields, where 
the information appears as comma separated items as follows:

Marker Type Columns

Time Only, Frame Time

Interval, Level Interval, 
Zone Interval

Start time, end time

Scalar Time and value

Coordinates Time, X, and Y
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Bit15, Bit14, Bits 10 through 13, Bits 0 through 9

From the Marker Occurrences window shortcut menu, one can select Properties 
to open the Marker Occurrences View Properties dialog box:

By default, the dialog box displays the marker occurrences for the currently 
selected marker. However, one can click to clear the Use Selected Marker 
checkbox and select a different marker from the list to display the marker 
occurrences for that marker. When OK is clicked, the current Marker 
Occurrences window will switch to the one selected in the dropdown list. If 
there are more than one Marker Occurrences window open, this capability can 
be used to display marker occurrences for different markers simultaneously.

In the Display Format for Scalar Marker Values area, one can set the display 
format for Scalar marker values, which are described in Table D-2 on page 74. In 
the Marker Occurrences window, the items in the Value column change the 
display format chosen.

By default, whenever the current time is changed in CinePlex Editor, it 
automatically selects the most appropriate marker occurrence of the selected 
marker for the current time. However, this behavior can be turned off; from the 
Tools menu, click Options and then click the General tab; click to clear the 
Select Marker Occurrence For Current Time checkbox.
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D.7 Correcting for Video Latency

If CinePlex Editor is being used to display data obtained using CinePlex Studio, 
be aware that there is a latency between the times of the video frames / position 
data sent from CinePlex Studio and the Neural Data. 

Understanding Timestamps for the Integrated CinePlex/OmniPlex® 
System

The timestamp on a video frame is the time the shutter opens. The shutter remains 
open for the entire time of the exposure. Depending upon cameras, this can be 
from about 1 microsecond to the maximum time allowed for the frame rate 
selected. Light that hits the sensors during the exposure time is accumulated until 
the shutter closes. Therefore, the video data in a frame is the accumulated image 
that the sensor saw over the shutter-open period that started at the timestamp. 
This differs from neural data that is an instantaneous reading of voltage observed 
by the D/A converter at that instant in time.

Synchronized CinePlex/OmniPlex System video and neural data systems (when 
operated correctly) have video timestamps that are precisely synchronized with 
neural data timestamps for concurrent recordings. This synchronization occurs 
because both the CinePlex System and OmniPlex System are driven by the same 
clock and reset signals, and because the camera shutter openings are triggered at 
precise times. Sophisticated hardware and software in the CinePlex/OmniPlex 
System ensures synchronicity even over extended recording periods of several 
days. These systems currently require Plexon OmniPlex hardware and software 
together with CinePlex V3 hardware and software running on the same PC. Up to 
four triggered cameras (currently AVT) are also required. Timestamp granularity 
is 25 microsecond. The first frame timestamp is exactly one frame time after 
recording starts. Position and event data is computed for every frame and tagged 
with that frame’s timestamp.

Understanding Video Frame Latency

In CinePlex Studio, the camera takes some time to acquire and transmit each 
video frame to the Capture computer over the firewire cable. The CinePlex 
Studio computer will timestamp the frame as soon as it receives notification from 
the camera that the frame has been delivered, but our tests indicate that the 
camera takes approximately 21 milliseconds after the ‘shutter’ closes to deliver 
the frame. Therefore, the timestamps of the video frames and of the position data 
from CinePlex Studio are about 21 milliseconds after the actual frame. One way 
to think about this is that if something suddenly happens in the experimental 
arena, say an LED suddenly turns on, the video frame that first shows the LED 
illuminated will have a timestamp that is about 21 milliseconds later. Note also 
that there can be substantial jitter in this number, depending on when the LED 
turned on in relation to when the ‘shutter’ opened in the camera.

Also, there is a systematic offset that can add a constant amount to the latency of 
each frame, having to do with the exact time that is taken to be zero in the AVI 
file versus the PLX file recorded on a Plexon NDAQ or the Plexon Recorder 
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system. Because of this effect, the video latency for Recorder is measured to be 
closer to 33 milliseconds.

Using the CinePlex Editor Latency Correction Feature

CinePlex Editor contains a feature that will automatically subtract some amount 
of time from each video frame timestamp and each position timestamp when a 
project is first created. To activate this feature, select the Latency Correction tab 
of the Tools – Options dialog box and check the Automatically compensate for 
video latency by adjusting Frame and Position Markers box, and enter a 
amount of time to subtract from each timestamp:

The amount of time specified is always subtracted from the timestamps, so the 
entered number should always be positive. Note that this subtraction will only 
occur when the project is first created, when the Frame and Position Markers are 
initially created from the video and neural data files (see “How CinePlex Editor 
Creates Initial Project Files” on page D-69), or when a DVT file is imported. It is 
not performed when a CPJ file is read, or when data from a NEX file is imported. 
Note that the timestamp shift that is performed automatically is equivalent to the 
shift than can be performed manually using the Tools | Shift Marker 
Occurrences. 

Note that applying this correction can shift Markers to have a negative timestamp 
near the beginning of files. When this happens, the timestamps will be assigned 
the value of 0.

In addition to the correcting for the camera latency, an independent correction for 
the tracking latency can be applied, as discussed in the next section.

Note: As of CinePlex Editor version 1.2.0, these latency corrections are now enabled 
by default, with a default correction of 21 milliseconds. If data have been 
analyzed using previous versions of CinePlex Editor, the timestamp shifts after 
upgrading to version 1.2.0. To return to pre-version-1.2.0 behavior, one can 
disable the corrections by unchecking the checkboxes.

Note: When CinePlex is being used with Plexon’s Recorder system, there was an 
issue with Recorder versions prior to 2.3.2 that could artificially increase this 
latency by up to 80 milliseconds. If using CinePlex Editor with Recorder, please 
upgrade the version of Recorder to version 2.3.2 or later. Also, use a video 
latency correction of 33 milliseconds as discussed above.
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Note: When CinePlex Editor is being used with Plexon’s MAP system, leaving the 
MAP on overnight could result in excessive latency - much greater than 30 
milliseconds. If the MAP has been left on overnight, it is better to reset the MAP 
system.
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D.8 Aligning Tracker Coordinates to Frames

If neural and video data files are collected using a Plexon NDAQ and CinePlex 
Studio with tracking enabled, then the temporal relationship between Frame 
markers, the arrival of strobe codes to the MAP digital input card, and video 
tracker coordinates are depicted in the following image of the Activity window:

Note: Note: the above screenshot depicts the timing assuming that the automatic 
corrections for (see previous section) are not enabled.

When the video frame is available, CinePlex Studio immediately timestamps the 
file and stores the time in the AVI file along with the video frame image. When 
CinePlex Editor initially reads the AVI file, the time for each frame becomes a 
Frame Marker time, which appears as the blue tick marks in the previous image. 

After CinePlex Studio acquires the video frame, it feeds the video image to the 
tracking algorithm. Some time later, the tracking algorithm determines the 
tracking positions and CinePlex Studio encodes the tracking positions using the 
VideoTracker protocol and outputs a burst of strobed data words. The time 
between the frame timestamp and the sending of the strobe codes depends on 
how quickly the tracking algorithms finish, but the first strobed data word always 
occurs before the start of the next video frame. The words within a burst are 
clocked out at a constant rate every two milliseconds.

When strobed data words arrive at the MAP, the MAP timestamps them as it 
reads them in, and then stores them as events in the PLX file. When CinePlex 
Editor in turn reads these strobed events from the PLX file, they become 
occurrences of a Scalar marker named Strobed; in the preceding image, these 
occurrences appear as brown tick marks. Also, if CinePlex Editor recognizes that 
the strobed codes are in VideoTracker protocol, it decodes them into occurrences 
of one or more Coordinates markers (see Table D-1 on page 72). CinePlex Editor 
then assigns times to the Coordinate marker occurrences. The assigned times are 
derived from the time of the first strobed event in each burst of strobed events. As 
a result, CinePlex Editor assigns times to the tracked positions that are later than 
the timestamps of the corresponding video frames; in the preceding image, the 
tracked positions (Position 1) are the red tick marks and the video frames are the 
blue tick marks.

This time offset between the frame time and the tracking coordinates, although 
realistic, is not desirable in some cases. For example, one can simplify 
subsequent analysis when the coordinates corresponding to a video frame are 
equal to the time of the video frame. One can do this with CinePlex Editor, by 
using the Snap-To Marker Occurrences tool described in “Snap-To Marker 
Occurrences” on page D-54.
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To align frame times and tracking coordinates

1 To align the tracking coordinate Position n marker occurrences to video 
frames, on the Tools menu, click Snap-To Marker Occurrences.

The Snap-To Marker Occurrences dialog box opens.

2 Select the Position n marker in the Marker To Adjust box. Leave the Snap-
To Occurrences of Marker set to the default value Frame Marker. 

3 Click Snap-to Previous Occurrence.

4 Click OK. A confirmation box will appear that specifies how many marker 
occurrences were moved.

After the Snap-to operation completes, the previous image becomes:

The red tick marks are now aligned with the blue tick marks. Thus, the tracker 
coordinate Position 1 occurrences are now aligned with the Frame Marker 
occurrences. 

Note that position data imported from a DVT file is already timestamped with the 
time of the corresponding frame, so this correction is not required.

One can configure CinePlex Editor to automatically perform this snap-to 
previous operation for newly-created projects by checking the ‘Automatically 
snap Position Markers imported from PLX files to the previous Frame Marker’ 
checkbox in the Latency Correction tab of the Options dialog box. This 
correction is only automatically applied when the data is initially imported from a 
PLX file. 
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D.9 Interpreting Frame and Event Timestamps

An event timestamp indicates that the MAP detected the event within the prior 25 
microseconds. This is illustrated by the diagram below.

A frame timestamp shows when the shutter was opened. The shutter will remain 
open until the exposure time elapses.

Note: If the shutter is opened within the 25 microseconds prior to an event timestamp, 
it is possible that the visual evidence of the event will not be captured as 
illustrated by the diagram below. Referring to the diagram, if the event occurred 
prior to the shutter opening, the visual evidence will not be recorded.
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D.10 Analyzing CinePlex Studio data with NeuroExplorer

As discussed in “Export to NEX” on page D-37, data can be exported from 
CinePlex Editor as a NEX file and read into NeuroExplorer. In this case, 
CinePlex Editor can perform latency corrections as described in the previous 
sections, and the data read into NeuroExplorer will be already corrected for 
latency.

However, a PLX file containing coordinates from CinePlex Studio can also be 
read directly into NeuroExplorer. NeuroExplorer can decipher the Video Tracker 
protocol strobe codes (See Appendix D) and turn them into continuous variables. 
In this case, the timestamps for the coordinates should be corrected for latency 
within Neuroexplorer. Note that since NeuroExplorer does not have access to the 
frame times (stored in AVI and DVT files), it needs to compensate both for the 
video latency (see “Correcting for Video Latency” on page D-76) and for the 
tracking latency (see “Aligning Tracker Coordinates to Frames” on page D-79) 
by subtracting a larger number from the position timestamps. To configure the 
latency correction, from the View menu select Data Import Options. In the 
Data Import Options dialog box, click the Plexon Files tab. In the Strobed 
Events area, enter a latency value in the Position events latency (seconds) field.

The default value for this latency correction in the screenshot is 75 milliseconds 
(appropriate for the Plexon Video Tracker product, but too high for CinePlex 
Studio). A more appropriate number is 31 milliseconds (21 milliseconds video 
latency plus about 10 milliseconds of tracking latency).
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E.1 Plexon User Interface

The Plexon® User Interface embodies a standard look-and-feel for Plexon 
software products. To illustrate the underlying concepts behind the look-and-feel, 
this appendix uses screenshots from Plexon’s CinePlex® Editor and CinePlex 
Studio applications. Although there will be differences in menus and toolbars 
between different applications, how to use, handle, and operate the user interface 
components will be fundamentally the same across future generations of Plexon’s 
software products including:

• CinePlex Studio

• CinePlex Editor

• Offline Sorter™

This appendix covers common functionality of the look-and-feel between 
different Plexon software applications. The discussion includes the following 
sections:

• Screen Elements

• Standard Menu Items and Dialogs

• Customization

E.2 Screen Elements

E.2.1 Menus

The menu bar of the application contains the names of all of the menus for the 
application. Each menu name has a letter underlined which indicates the hot-key 
combination for that menu. To activate a particular menu, click the left mouse 
button on the name or press and hold the ALT key while pressing the underlined 
letter. The image below is the main menu of CinePlex Editor.
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Each menu of the Plexon User Interface contain menu commands and may also 
contain Icons, Hot Keys and a Tear-off Menu Handle as shown by the illustration 
below of the Edit menu of CinePlex Editor.

While all Plexon applications are shipped with their available menu commands 
organized into a set of menus, the contents of the menus can be customized and 
new menus can be created.

• Icons - Icons may be located immediately to the left of the menu commands. 
These icons will be displayed on the toolbar associated with the menu. In the 
example menu, there are icons associated with all but the last three of the 
menu commands. The presence of an icon next to a menu command means 
that the icon is also a label on a toolbar button and will execute the same 
command when clicked as the menu command on the menu.

• Hot Keys - Hot Keys are key combinations that will cause a menu command 
to execute without having to click the command on the menu. Typically, hot 
keys will contain two keys that must be pressed simultaneously for the 
combination to execute. The area at the far right of the menu commands may 
display the hot key combinations for the menu commands. In the example 

Icons

Tear-off Handle
Menu Commands

Hot Key
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menu, there is a hot key combination (CTRL + C) for the Copy command. 
Hot keys may be added or customized via the Tools-Customize dialog.

• Tear-off Menu Handle - The Tear-off Menu Handle is an area (the one 
containing the dots) at the top of the menu, present on many menus. The tear-
off feature allows the quick creation of a toolbar that contains all of the 
commands in the menu that have command icons. You can hover the mouse 
over the tool to highlight it, drag the mouse to the toolbar area and place the 
menu as a toolbar there. The illustrations below show highlighting the Tear-
off Menu Handle to begin dragging the toolbar, dragging the toolbar across 
the screen, and finally docking the toolbar in place.

E.2.2 Toolbars

Each toolbar has a dropdown button at the right that will allow you to add or 
remove buttons from toolbars and will also allow you to access the Customize 
dialog box. When you click the dropdown button the Add or Remove Buttons 
dropdown menu will appear as shown below.
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The dropdown menu also has a dropdown button. Clicking that button displays a 
menu list of the available toolbars and a menu command to allow access to the 
Customize dialog box.

Expanding one of the toolbar menus will display all of the available toolbar 
buttons for that particular toolbar and a checkbox beside each one that will 
indicate whether or not the button is visible on the toolbar. There is also an option 
to reset the toolbar back to its factory default setting.

Clicking the Customize menu command will open the Customize dialog box. 
This dialog box is common to Plexon software applications but may have 
different content on the tabs according to the software application.
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For details on using the Customize dialog box, see “Customization” on page E-
17

E.2.3 Windows

The image below shows a typical window title bar. It contains (from left to right) 
a Title, a Auto Hide button, a Maximize button, and a Close button.

• Auto Hide Button  - The Auto Hide button “pins” a window to the 
screen to keep it visible or “rolls up” a visible window into a tab. When the 
window is pinned, the Auto Hide button points in a vertical direction. If the 
window is rolled up, the Auto Hide button points in a horizontal direction.

• Maximize Button  - The Maximize button may not appear on all 

windows. It is the standard Windows® maximize button. Clicking the 
Maximize button on a window will maximize the original window and hide 
other windows occupying the same horizontal or vertical space. Clicking the 
Maximize button again will restore the previous layout. When clicked the 
image on the button toggles between one window and overlapping windows.

• Close Button  - The Close button closes the window.
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Plexon software applications often display several windows simultaneously. 
These windows may be resized by using standard resizing methods and may also 
be repositioned by dragging and dropping and by using Docking Stickers. The 
image below shows the repositioning of a window (denoted by the blue 
transparent rectangle) and various Docking Stickers (with red circles around 
them). These Docking Stickers allow you to dock the window being moved in 
one of several ways described below.

You can position a window by floating it, docking it at the desired docking sticker 
at a window edge or in a tab.

• Floating a Window - You can drag a window by the Caption Bar near the 
center of the screen and release it causing the window to float. Holding down 
the CTRL key while dragging will always float the window. Double-clicking 
on the Caption Bar will also float a window. Note that the size and position of 
the floating window is remembered.

— Rolled-up Windows - Floating windows may be enabled for roll up up 
by pressing the Auto Hide button. The window will roll up when the 
focus is changed to a different window. The first image below shows a 
floating window before rolling it up. The second image below shows 
the rolled-up window after the focus has changed.
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• Docking a Window at the Application Frame - When you begin to drag 
a window, a transparent blue rectangle appears to indicate the position of the 
window and the four Docking Stickers appear individually at each edge of 
the application frame to allow you to dock the window to the respective edge. 
To dock just move the mouse to the desired Docking Sticker and release the 
mouse button. The docked window will extend along the entire length of the 
edge to which it is docked. The image below shows all four screen Docking 
Stickers.

• Docking a Window at a Window Edge - When you move the window 
inside another window, the window Docking Stickers appear inside the 
window grouped together near the center of the window. Releasing the mouse 
button while it is over one of these stickers (except the center one) will dock 
the moving window to the respective edge of the window associated with the 
window Docking Stickers. The image below shows the window Docking 
Stickers. Note that the shading of these Docking Stickers is different that the 
shading of the Docking Stickers in the previous image.

• Placing Windows into Tabs - Releasing the mouse button over the center 
Docking Sticker will allow the moving window to occupy the same space as 
the window beneath and will create tabs along the bottom for switching the 
view between the two windows. The image below shows the Marker 
Occurrences window without sidebar tabs on the left. On the right, a 
Channels window has been placed into the same space by using the center 
docking sticker. Note that there are two sidebar tabs at the bottom of the 
window.
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— Hidden Windows - Docked windows whose access is not needed often 
can be hidden or “rolled up” by pressing the Auto Hide button. When 
hidden, the window is represented by a sidebar tab. Sidebar tabs may 
be located at the left, right, or bottom of the screen and indicate hidden 
windows. To show one of these windows, just hover the mouse over 
one of the tabs and the window will appear. The File Info window of 
CinePlex Editor opened by the sidebar tab is shown below on the left. 
If you click the Auto Hide control, the window will be pinned and 
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remain open after you move the mouse away from the sidebar tab as 
shown on the right. The Auto Hide button will also have changed 
direction and be pointed downward. Note also that the File Info sidebar 
tab is gone on the right image.

E.3 Standard Menu Items and Dialogs

In Plexon software applications, some menu items may have the same 
functionality across several applications. These items are standard menu items 
and consist of the Window menu, the Run menu, and the Help menu.

E.3.1 Window Menu

The Window menu contains three items: Theme, Layout, and Customize.
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• Theme - Clicking on Theme displays a menu as shown below. A theme is a 
color scheme that is part of the look-and-feel of the user interface.

— Theme Group - The top group of items are theme toggle items that 
may be selected to apply to the user interface look-and-feel. Only one 
of the themes may be selected at a time. 

— Text Below Toolbar Icons - This item is a toggle item to show or not 
show text below the toolbar icons.

— Hide Window Title Bars - This item is a toggle item to hide or show 
window title bars.

• Layout - Clicking on Layout displays a menu as shown below. A layout is 
the size and placement of the windows on the screen. It also remembers the 
number and placement of toolbars.

— Reset to Default Layout - Clicking on this item resets the layout to the 
factory default.

— Load Layout Group - Clicking on Apply Layout 1 or Apply Layout 
2 applies one of the standard layouts to the user interface. Clicking on 
Load Layout From File will allow you to select a layout file to apply 
to the user interface.

— Save Layout Group - Clicking on Save As Layout 1 or Save As 
Layout 2 saves the current screen layout as one of the two standard 
layouts. You can also click Save Layout to File to save the current 
screen layout to a file that can be loaded by the Load Layout From 
File item.
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• Customize - Clicking Customize displays the Customize dialog box as 
shown below

For details on using the Customize dialog box, see “Customization” on page E-
17.

E.3.2 Run Menu

The purpose of the Run menu is to launch other applications quickly. The Run 
menu will be populated by default with some common Plexon applications. To 
launch other applications from within the current application, you can add new 
entries to the Run menu. A sample Run menu is shown below. For additional 
information about customizing the Run menu, see “Run Menu Customization” 
on page E-21.

E.3.3 Help Menu

The Help menu contains four items: Help, Quick Reference, Web Update, and 
About XXXXX where XXXXX is the name of the application.



CinePlex Behavioral Research System  

Version 3 E-13

• Help - Clicking Help displays the User’s Guide for the application.

• Quick Reference - Quick Reference may be missing in some applications. 
When present, clicking Quick Reference displays a dialog box similar to the 
one shown below. The purpose of the Quick Reference dialog box is to show 
keys and mouse buttons that control some of the commonly used functions in 
various views. You can print it by clicking Print or close it by clicking OK.

— Print – Click Print to print a copy of the Quick Reference. 

• Web Update - This item allows you to update software via the internet. 
Clicking Web Update will first check to see if an update is available. If an 
update is available, it will be downloaded and installed.

• About - Clicking the About item displays the About dialog box. The text of 
the About item varies according to the application. The About dialog 
contains the version number and build data of the application, links to the 
Plexon website and support e-mail, and buttons for Licensing, System 
Report, and Manage File Extensions.
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— Licensing - Clicking the Licensing button displays the Plexon License 
Management dialog box. The Plexon License Management window 
includes the complete licensing information for Plexon products. The 
window includes the following three areas: information, key testing, 
and code entry.
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– The information area includes information on license keys and a list 
of all the Plexon products and their licensed status on this computer. 

– If you have moved or added a key, the Test the Key Again button 
provides a convenient tool to test license keys to ensure they func-
tion correctly.

– If you have more than one key installed, the Next Key>> and 
<<Prev Key buttons appear. You may use these buttons to cycle 
through and test all keys.

– The code entry area is used to enter the unlock codes for optional 
programs and features. If you have licensed optional items, instruc-
tions for entering codes and testing keys are included with Plexon 
installation programs.

— System Report - The purpose of the System Report button is to help 
Plexon Support diagnose problems by listing system information. 
Clicking the System Report button will first display a dialog box to 
allow you to display the system report on the monitor or save the report 
to a file that can be sent via E-mail to Plexon Support. 

– After selecting a choice, clicking OK will launch the standard 

Microsoft® System Information tool. The image below shows the 
System Information report displayed on the monitor.
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— Manage File Extensions - Clicking the Manage File Extensions 
button opens the Manage File Associations dialog box. The Manage 
File Associations dialog box allows you to review and select which file 
types are associated with Plexon software applications. For example, 
when the PLX file type is associated with Offline Sorter, double-
clicking on a PLX file will open Offline Sorter and load that PLX file. 
If you have not installed some of the applications, their file extension 
radio buttons will be disabled.

E.3.4 Messages Window

The Messages window displays a log of timestamps and associated application 
events that Plexon Support can use for troubleshooting purposes.

Note: The Messages window is not available for all applications.
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Right-clicking the mouse in the Messages window will display a right-click menu 
with the following items:

• Erase - This item clears the window of all messages

• Pause - This item stops the logging of messages

• Show Debug Messages - This item is a toggle to show or hide debug 
messages

• Select and Copy All - This item allows you to copy all of the messages to 
another application - such as a word processor

• Save Log to File - This item allows you to save the messages to a log file.

• Mail Log to Plexon - This item allows you to send the message log to 
Plexon for troubleshooting purposes

E.3.5 Right-click Menus

Most windows have right-click menus that control their behavior and options. To 
open a right-click menu, place the cursor inside a window and click and release 
the right mouse button. The right-click menu appears where the mouse is clicked. 
To select a menu item, move the cursor over it and click the left mouse button.

E.3.6 Current Selections

In grid-based windows, the currently selected item always appears with a >> or 
> in the left column of the appropriate grid-based window.

E.3.7 Undo

Plexon applications provide multiple undo levels. To undo an operation, on the 
Edit menu, click Undo or click the Undo button on the toolbar. You can undo 
operations that change the contents of the project file but may not undo 
operations that change the user interface options or colors.

E.4 Customization

Although the menus and toolbars offer a rich set of commands and functions that 
should meet the needs of most Plexon customers, the Customize dialog box also 
allows you to customize several areas of the interface should the need ever arise. 
This section describes the uses of the Customize dialog box.
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To open the Customize dialog box, from the Tools menu, select Customize. The 
Customize dialog box contains several tabs. The images below show the 
Customize dialog box from CinePlex Editor and displays five tabs - Toolbars, 
Commands, Keyboard, Run Menu, and Options. Although the content of the 
tabs will vary according to the application, the functional operation of each tab is 
respectively the same across all Plexon software applications.

E.4.1 Toolbars Customization

An image of the Toolbars tab follows:

• Toolbars - This box contains a list of the toolbars for the application. Click a 
toolbar checkbox to have it appear in the main application window. 

• New - This button opens the New Toolbar dialog box. You can use this 
feature to create a custom toolbar for commands frequently used. Enter a 
toolbar name in the Toolbar name box.

• Rename - If you have selected a toolbar that was previously defined, click 
Rename to change the name of the toolbar. The Rename Toolbar dialog box 
displays.

• Delete - If you have defined a new toolbar and selected it, click Delete to 
remove that toolbar. There are no default values for newly defined toolbars. 
Standard toolbars may not be deleted. A confirmation dialog box displays.

• Reset - If you have selected a standard toolbar, click Reset to restore the 
toolbar to its default contents. If new buttons have been dragged to a toolbar, 
click Reset to restore the default version of the toolbar. A confirmation dialog 
box displays.
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E.4.2 Commands Customization

The Commands tab is used to customize which commands are available in 
toolbars. An image of the Commands tab follows:

• Categories - This is a list of all the toolbar categories. Select a toolbar 
category to see the buttons in the Commands area.

• Commands - This area shows all the buttons and the associated menu 
commands that belong to the selected category. You can select the desired 
command and drag it to the toolbar.

E.4.3 Keyboard Customization

The Keyboard tab allows you to bind keystrokes to commands. An image of the 
Keyboard tab follows:
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• Category - This is a list of all the main menu headings. Select a menu 
heading to category to see the associated commands in the Commands area.

• Commands - This is a list of all the commands associated with the selected 
main menu heading in the Category area.

• Key assignments - This displays the current key assignment for the 
command selected in the Commands area.

• Press new shortcut key - This allows you to enter a shortcut key 
combination for the command selected in the Commands area.

• Description - This area displays a description of the currently selected 
command in the Commands area.

• Assign - This button assigns the shortcut in the Press New Shortcut Key 
area to the selected command in the Commands area. If the shortcut key is 
already assigned to another command, a confirmation dialog box displays to 
allow or cancel the reassignment.

• Remove - This button removes the selected shortcut key in the Key 
Assignments area from the selected command in the Commands area.

• Reset All - This button removes all custom key assignments. A confirmation 
dialog box displays to allow or cancel the operation.
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Procedure for Customizing Keystroke Shortcuts

1 From the Window menu, select Customize, and then click the Keyboard tab 
of the Customize dialog box.

2 Choose a category from the Category dropdown and from the Commands 
list, select the desired command to bind to a keystroke shortcut.

3 If there is already a key assignment listed in the Key assignments area, 
remove it by clicking the Remove button if so desired. You can also just 
reassign a new key combination to the selected command. (See Step 5)

4 Click the mouse in the Press new shortcut key area.

5 Click the CTRL or ALT key and hold it down while clicking another key. The 
dual key combination will be displayed in the Press new shortcut key area. 
This combination will be the key assignment for the selected command.

6 Click the Assign button to assign the key combination to the selected 
command. If there already is a key assignment for the command, a 
confirmation box will display to confirm or cancel the reassignment.

Note: In CinePlex Editor do not bind menu operations to keystrokes that are 
associated with markers. Use only CTRL- or ALT- key combinations 
to bind to menu items, as these key combinations cannot be 
associated with markers.

E.4.4 Run Menu Customization

The Run Menu tab allows you to manage menu items on the Run Menu. An 
image of the Run Menu tab follows:

• Menu contents - This is a list of all the menu items in the Run Menu. 
Select an item to see its characteristics in the Command, Arguments, and 
Initial Directory areas.
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• Buttons - The toolbar buttons allow you to add a new menu item, delete a 
selected menu item, move the selected menu item upward in the list, and 
move the selected menu item downward in the list.

• Command - This area contains the name of the file that runs when the menu 
item is selected from the Run Menu. The browse button opens the standard 
Open dialog box filtered for executable files.

• Arguments - This is a list of all the arguments to be passed to the file in the 
Command area, if any. The browse button opens the standard Open dialog 
box filtered for all files. When applicable, the symbol “%1” can be used to 
denote the current document.

• Initial Directory - This contains the path of the file in the Command area. 
The path allows the system to find the file and execute it. The Browse button 
opens the standard Browse For Folder dialog box.

Procedure for Customizing the Run Menu

1 From the Window menu, select Customize, and click the Run Menu tab.

2 To add a menu item, click the New icon, enter the command in the Command 
text box, enter any arguments in the Arguments text box, and set the 
applications directory in the Initial Directory text box. In each case use the 
appropriate Browse button at the right of the text box. The Browse button for 
the command opens the standard File Open dialog box filtered for executable 
files. The Browse button for the arguments opens the standard File Open 
dialog box filtered for all files. Then Browse button for the initial directory 
opens the Browse for Folder dialog box.

3 To delete a menu item, select it and click the Delete button.

4 To reorder the menu items, select a menu item and use the Up and/or Down 
arrow buttons to reorder.

E.4.5 Options Customization

An image of the Options tab follows:
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• Personalized Menus and Toolbars - This area contains two check boxes 
and a button. The application will hide infrequently used menu items, but you 
may customize the display of menu items using these two checkboxes. If you 
check the Always show full menus checkbox, the application will always 
show full menus and the Show full menus after a short delay checkbox will 
be disabled. If you do not check the Always show full menus checkbox, 
there will be the option of checking or clearing the Show full menus after a 
short delay checkbox. The Reset menu and toolbar usage data button will 
allow you to delete the record of commands used in the application and 
restore the default set of visible commands to the menus and toolbars. A 
confirmation dialog displays.

• Other - This area contains three checkboxes and a dropdown list. If you 
check the Large icons checkbox, the application will use large icons on the 
toolbar. If you check the Show Screentips on toolbars checkbox there will 
be the option of checking the Show shortcut keys in Screen Tips checkbox. 
The Menu animations dropdown list allows you to select the type of 
animation to be used on menus that have animation.



E  Navigating the Plexon User Interface 

E-24 CinePlex Behavioral Research System 



Plexon Inc

CinePlex Behavioral Research System Version 3 F-1

Appendix F
Troubleshooting

F.1 Physical Installation Issues..................................................... F-2

F.2 Other Issues ........................................................................... F-3

 



F  Troubleshooting 

F-2 CinePlex Behavioral Research System 

CinePlex® Version 3 is a powerful, complex product that gives its users extensive 
control over the video portions of their neural data collection process. This 
complexity gives rise to possible interactions and issues that were not present in 
earlier versions. For that reason Plexon® has compiled this list of common 
problems reported from the field, together with their normal solutions. If the steps 
here do not solve the problem, or if the problem is not listed, please contact 
Plexon Support at support@plexon.com or +1-214-369-4957.

F.1 Physical Installation Issues

In general, all of the following should be checked when unexplained problems 
are occurring. For more detailed installation instructions of CinePlex V3 
hardware, please refer to the relevant documents.

Missing/Improper Wire and Cable Connections - Single Systems

Be sure that all required cable connections are in place and tight. 
Unpredictable results may occur if they are not. See Appendix A‚ Cabling 
Guide for complete detailed instructions for cabling CinePlex. The most likely 
items to check are:

1 Short purple wire from TIM card nose board to the XS2 BNC connector on the 
TIM card.

2 Trigger cable(s) from the AccesIO tail board to the camera(s).

3 FireWire cable(s) from the FireWire card in the computer to the camera(s). If 
there are two cameras, there must be an empty FireWire socket between the 
two connections to the FireWire board or maximum frame rates will not be 
achievable.

4 Control cable from the TIM card nose board to the AccesIO tail board. If this 
cable is not in place, video frames may not be clocked and/or Studio may not 
start recording correctly.

Missing/Improper Wire and Cable Connections - Synchronized Systems

Cabling is slightly different when CinePlex and MAPs are deployed as 
multiple synchronized systems using a Quad MAP Controller (QMC). Again, 
be sure that all required cable connections are in place and tight. This 
includes:

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.

mailto:support@plexon.com
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1 BNC cable and start button to the “BUTTON” input on the QMC OR BNC 
cable from the “PULSE” input on the QMC to an external experiment control 
system.

2 Control cable from the Master MAP TIM nose board to the QMC “CPX CTRL 
IN” socket.

3 Control cables from the QMC “CPX CONTROL OUT” for each system to their 
respective AccesIO tail boards. If this cable is not in place, video frames may 
not be clocked and/or Studio may not start recording correctly.

4 BNC Start cable from the QMC “START” socket to the “XS2” BNC connector 
on the TIM card on each synchronized MAP system.

5 BNC clock cable from the Quad MAP controller “CLK OUT” connector to the 
“Remote CLK” on each of the respective TIM boards. Also make sure that the 
toggle switch above these connectors is in the down position to select the 
remote clock.

6 Optionally, digital input signals from an external system can be input to the 
“DIGITAL INPUT” socket on the QMC where they are made available on the 
“DIGITAL OUTPUT” sockets to all MAP boxes.

7 Trigger cable(s) from the AccesIO tail board to the camera(s).

8 FireWire cable(s) from the FireWire card in the computer to the camera(s). If 
there are two cameras, there must be an empty FireWire socket between the 
two connections to the FireWire board or maximum frame rates will not be 
achievable.

Cables Too Short between Camera(s) and MAP/CinePlex Computer

Plexon supplies several lengths of these cables from 7 feet (2 meters) to 26 
feet (8 meters). Please contact Plexon if one of these standard lengths will 
work in the installation. Note that cable lengths over 26 feet result in 
intermittent video signals at higher frame rates and are NOT 
RECOMMENDED.

Unstable Camera Mounting

Camera mounts must be stable or the resulting video data will shake and not 
be repeatable. This can be the case, for example, when a tripod is used to 
mount a camera, instead of the preferred wall or ceiling mount. Please refer to 
Appendix B‚ Optimizing Camera and Lens Usage for the Experiment.

F.2 Other Issues

General Problem Solution - No Video from Camera and Other Problems

The correct starting sequence must be applied to the MAP box, Sort Client, 
and CinePlex Studio. Not following the sequence completely is the cause of 
many types of errors, including no video being shown from the cameras. The 
startup sequence is as follows:
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1 Power up the MAP.

2 Power up the computer, log in as Administrator, bring up the Server program, 
and then bring up the Sort Client program. Select the desired Parameters file.

3 In Sort Client, press START button and then the start recording triangular 
icon. Then press the stop recording rectangular icon.

4 Bring up CinePlex Studio. Verify that video is showing and select a tracking 
mode. Adjust parameters so that objects are being tracked successfully.

5 Contact Plexon support if problem is not resolved.

Error Messages While Running the Software Installation Package

The installation package adds programs and DLLs to the system. Therefore, 
the installation software:

1 Must be run from a computer account with administrator privileges.

2 Cannot be installed on a Vista computer.

3 Cannot be installed on a 64 bit computer.

4 Must be downloaded to and run from a local hard drive. Removable drives, 
including USB flash drives and USB hard drives, are not acceptable. Neither 
are networked drives.

5 Contact Plexon support if problem is not resolved.

Antivirus Software

Some MAP/CinePlex Systems come from Plexon with antivirus software pre-
installed. The system has been tested with this antivirus software in place and 
should operated without problem as long as software and update settings are 
not changed. If problems occur that can be traced to the pre-installed antivirus 
software, please contact Plexon Support. It could be that a new set of virus 
signature files has caused some CinePlex components to be flagged as 
untrustworthy.

Please do not install any other antivirus software on the MAP/CinePlex 
System computer without consulting Plexon Support first. There are two 
reasons for this:

1 First, some antivirus tools have been know to quarantine or remove key 
components of the CinePlex System, rendering it unusable. A reinstallation of 
the CinePlex software will be required after the antivirus tool is removed from 
the computer.

2 Second, periodic downloads of updates or periodic scans for infections can 
disrupt video streams and processing, causing lost frames and delayed 
events.

3 Contact Plexon support if problem is not resolved.

Studio Will Not Start At All

There can be many causes for Studio failing to start when its icon is clicked or 
displaying an error and failing to start when OK is clicked. The most common 
causes and their solutions are shown below.
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1 Missing CinePlex license key. Obtain or find the correct license key and 
restart CinePlex.

2 If CinePlex still will not start and reports a missing license key, install the 
Sentinel drivers (this is done by the CinePlex installation software or by 
running the file C:\Program Files\Plexon Inc\CinePlex\Common Files\Sentinel 
System Driver Installer 7.4.0.exe).

3 If CinePlex reports missing DLLs, reinstall CinePlex. All the required DLLs are 
in the installation package.

4 Contact Plexon support if problem is not resolved.

Studio Will Not Start In or Switch to Camera Mode

There can be many causes for Studio failing to go into camera mode. The 
most common causes and their solutions are shown below.

1 Missing MAP and/or CinePlex license key. Obtain or find the correct license 
key, install the Sentinel drivers (this is done by the CinePlex installation 
software), and restart CinePlex.

2 Missing or inoperative IO card or drivers.

3 Camera cables are loose or unplugged. Power all components of the system 
down, then check and reseat both ends of the two cables to the camera. 
Power the system back up, and follow the normal startup steps.

4 Contact Plexon support if problem is not resolved.

Studio Cannot Find AccesIO Drivers

1 Check for and disable any antivirus software. If the AccessIO drivers are in 
quarantine, restore them.

2 Try running Studio again. If the system still cannot find the AccesIO drivers go 
o the next step.

3 Reinstall CinePlex.

4 Contact Plexon support if problem is not resolved.

No Video in Studio

1 Sort Client must have a valid configuration file and the button labeled 
“START” must have been pushed. Until this has been done, no CinePlex 
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clock (or MAP clock from which it is derived) is being generated, so there is 
not video frame trigger.

2 After powering the system down, check the camera cables, especially the 
CinePlex System control cables.

3 Power the system back up and follow the normal startup steps.

4 If there is still a problem ensure that the manual iris control on the lens is fully 
open.

5 If the problem is still not resolved, there is a standalone un-triggered tool that 
will display video from the camera(s) if it is connected correctly and 
operational. Open the file below:

C:\Program Files\Plexon Inc\CinePlex\Common 
Files\AVT_SmartView_1_8.exe

6 If there is video for a particular camera using this tool, the camera and its 
FireWire cables are OK, and something is wrong with MAP cabling or 
operation. If no video, contact Plexon Support.

Cannot Focus the Video Image

The video is present, but blurry and cannot be focused at any zoom or focus 
setting. Note that the nearest focus for Plexon supplied lenses is from 0.2 to 
1.6 meters depending on the lens.

1 Check for the presence of an annular spacer between the lens and the 
camera. The spacer should be present if the lens is a C-mount lens like 
Plexon’s H6Z0812. The spacer should be absent for CS-mount lenses like the 
H32Z4512.

2 Adjust the zoom and focus rings on the lens until a clear picture is obtained. 
See figure above.

3 Contact Plexon support if problem is not resolved.

Slow Video in Studio

The video is present, but is updating very, very slowly - perhaps once every 
several minutes.
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1 Remove the TIM card and check that the DIVCLK jumper is on the 1 MHz 
position instead of the 1 kHz setting. If not, move it to the 1 MHz setting.

2 Contact Plexon support if problem not resolved.

Filtering Video

Video is present, but the image is flickering.

1 Turn off any fluorescent lights illuminating the arena and use incandescent 
lights instead. If the flickering goes away, there may be problems with the 
fluorescent bulbs themselves, the starters, or the ballast. If fluorescent 
fixtures must be used, these problems must be fixed. Otherwise, look for 
alternative lighting sources

2 Contact Plexon support if problem is not resolved.

Arena is Too Small or Too Large within the Video Image

Once video has been obtained, the camera and lens must be adjusted so that 
the maximum dimension of the arena nearly fills the long dimension of the 
video image while ensuring that all other parts of the arena are within the 
video image as well.

1 If the arena image is too small, move the camera closer to the arena (outside 
of the near limit) or adjust the zoom ring towards the T (telephoto). Then 
adjust the lens focus ring until the video image is clear, if possible.

2 If the arena image is too large, move the camera away from the arena (within 
the physical limits of the environment) or adjust zoom ring towards the W 
(Wide Angle). Then adjust the lens focus ring until the image is clear, if 
possible.

3 Contact Plexon support if the arena cannot be adjusted to fill the video 
window.

Studio Will Not Start Recording When the Sort Client Start Icon is 
Pushed

1 Check that the Rasputin Datafile Options are set up for CinePlex System 
operation If Sort Client does not have these options available, contact Plexon 
Support to obtain the latest version.

2 Check that Studio is in the armed mode, waiting for Sort Client to start 
recording.

3 Check cables, especially the control cables - see the Physical Installation 
section of this document.

4 Check that the disk selected for recording video files is not full.

5 Contact Plexon support if problem is not resolved.

No Strobed Data Showing in Sort Client after Initial Startup

Usually, this occurs because the correct starting sequence has not been 
applied to the MAP box, Sort Client, and CinePlex Studio. The startup 
sequence is detailed in the section above General Problem Solution - Startup 
Sequence Not Followed.
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1 Follow the start sequence. Go to LED or Markers mode. Press the PLX button 
next to up to three colors.

2 In Sort Client, ensure that the Strobed Data box is checked on the Settings/
Events tab. Press the Activity tab icon so that tab appears.

3 Scroll down to the bottom of the Activity tab window and verify that strobed 
data hash marks are being displayed.

4 Earlier version of Sort Client may not always display strobed data even 
though it is being received and written to the PLX data file successfully. Use 
the section below to verify strobed data in earlier versions of Sort Client.

5 Contact Plexon support if problem is not resolved.

No Strobed Data Showing in Earlier Versions of Sort Client - Use 
VTViewer

Sometimes, strobed data may not appear on the Activity tab after recording 
has been started. This is due to a display fault in earlier versions of Sort 
Client. The simple VTViewer client may be used to verify the generation of 
strobed data in this case.

1 Use the VTViewer icon or open the file below (on the MAP/CinePlex System 
computer) to bring up the VTViewer program

C:\Program Files\Plexon Inc\CinePlex\Common Files\VTViewer.exe

2 Drop down the File menu and select the Connect option.

3 If the connection to Sort Client has been successful, colored spots 
representing current reported positions of the tracked objects will appear on 
the VTViewer grid.

4 If no colored spots are shown, please contact Plexon support.

Live Video Being Corrupted or Neural Data Being Dropped

Sometimes the live data will be corrupted or neural data will be dropped.

1 Try reducing monitor count, monitor resolution, or both.

2 If cards have recently been added to the PC bus, remove them to see if the 
problem is solved.

3 Contact Plexon Support for help in rearranging the order that existing cards 
are plugged into the PC bus.

Dropped Frame Count Non-zero While Recording

When the MAP/CinePlex System computer is heavily loaded causing 
available video buffering to fill, video frames may be dropped. The count of 
dropped frames is incremented each time this happens. This is not a normal 
condition and probably indicates that the computer is being asked to perform 
more than MAP/CinePlex System processing.
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1 Stop running all unnecessary applications on the computer while recording. 
This includes CinePlex Editor, which can initiate intensive hard drive activity. 
Use the Task Manager to display and end unneeded tasks.

2 Disable scheduled tasks such as backup and Windows® Update. These can 
cause dropped frames when they run. Use the Task Scheduler to view all 
tasks. Contact the system administrator to disable unwanted tasks.

3 Internet activity, especially that involving heavy downloads such as from 
YouTube or similar sites should be prohibited on the MAP/CinePlex System 
computer. To avoid this possibility Plexon recommends placing the computer 
on a subnet isolated from intensive internet traffic.

4 If dropped frames still persist after these steps, please contact Plexon 
Support.

F.3.16 Other Typical Problems and Solutions

This section includes a list of some of the other typical problems with remedies 
for each one. 

Note: The following problem refers to CinePlex Capture (earlier version of CinePlex 
Studio).

The following dialog appears when trying to run CinePlex Capture: 

1 If the following CinePlex Capture dialog box appears after starting CinePlex 
Capture, read the instructions in the box. Verify the camera connections as 
detailed in the steps that follow.

2 Check the 1394 cable between the camera and the CinePlex Capture 
computer. Make sure the cable is undamaged. Make sure to connect the 
cable to the “In” port on the camera. Do not connect the cable to the 
“DaisyChain” port on the camera.

3 Make sure the camera is the same camera that Plexon shipped with the 
CinePlex Capture computer. CinePlex cameras and computers are uniquely 
calibrated to each another and they are not interchangeable.



F  Troubleshooting 

F-10 CinePlex Behavioral Research System 

The video preview display is black

1 Set the manual iris control on the camera by twisting middle ring (iris) on the 
camera lens from closed to open.

2 From the File menu, click Set Defaults.

The video preview display is out of focus

1 Set the zoom and the focus controls on the camera by twisting the outer and 
inner rings on the camera lens until a clear picture displays in the Video 
window.

2 On CS mount cameras, ensure that the C to CS adaptor ring is not installed 
between the lens and the camera.

Dropped Frame Counts

1 Stop running all unnecessary applications on the computer while recording. 
This includes CinePlex Editor, which has file intensive activity. Use the Task 
Manager to display and end unneeded tasks.

2 Disable tasks such as backup and Windows Update. These can cause DFC 
increments when they run. Use the Task Scheduler to vie all scheduled tasks.

3 Place the CinePlex System computer on a subnet isolated from intensive 
internet traffic.

4 If the problem persists, please contact Plexon Support.

For details on DFC counts, see “Monitoring the Video During a Recording 
Session” on page 51.
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time pointer
in Activity window 97
in relation to video frame 97

timestamps
in .avi files 80

tools
Interpolate Missing Occurrences

use of 140
tracking

coordinates, entering of 140
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missing data points, repair of 141
triangle

white triangle in Activity window 97

U
undo 98
user interface E- 2

V
video files, See AVI files
video frame

in relation to time pointer 97

W
waveforms

artifacts, headshaking 138
artifacts, invalidating 138

window
Activity, how to use 97

windows
Activity

marker occurrences in 114
moving and docking in display 98
shortcut menus for 98
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